Patents

This product incorporates the proprietary EXFO Link-Aware™ technology, employing spectrally-selective high-reflectance demarcation (HRD) filters to enable the attenuation of a specific branch of a P2MP (point-to-multipoint) network to be measured/monitored.

Feature(s) of this product is/are protected by one or more of: US patent 8,687,957 and equivalent patents pending and/or granted in other countries; US patent 8,576,389 and equivalent patents pending and/or granted in other countries; US patents 9,170,173; 9,571,186; 10,014,935; and 9,423,316.

Version number: 8.0.0.1
Microsoft End-User License Agreement

You have acquired a device ("DEVICE") that includes software licensed by EXFO Inc. (EXFO) from an affiliate of Microsoft Corporation ("MS"). Those installed software products of MS origin, as well as associated media, printed materials, and "online" or electronic documentation ("SOFTWARE") are protected by international intellectual property laws and treaties. Manufacturer, MS and its suppliers (including Microsoft Corporation) own the title, copyright, and other intellectual property rights in the SOFTWARE. The SOFTWARE is licensed, not sold. All rights reserved. The Microsoft EULA for the SOFTWARE can be found at: https://www.microsoft.com/en-us/useterms, by entering "Windows" as the Product Name, and "8" as the Version Number.

This EULA is valid and grants the end-user rights ONLY if the SOFTWARE is genuine and a genuine Certificate of Authenticity for the SOFTWARE is included. For more information on identifying whether your software is genuine, please see https://www.microsoft.com/en-us/howtotell/default.aspx.

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT ("EULA"), DO NOT USE THE DEVICE OR COPY THE SOFTWARE. INSTEAD, PROMPTLY CONTACT EXFO FOR INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT).

Software License Agreement (V.2016-02)

This Software License Agreement ("Agreement") shall apply to any Customer and its Users, for all its request for quotations and purchase orders, EXFO order acknowledgements and invoices and any delivery of Software by EXFO, for which there is no separate license agreement between you and the manufacturer or owner of the software, together with EXFO's Sales Terms and Conditions, available at https://www.exfo.com/umbraco/surface/file/download/?ni=12228&cn=en-US or on request, which are an integral part of this Agreement.

IMPORTANT: BY ORDERING, INSTALLING, DOWNLOADING, OR USING THE SOFTWARE OR OTHERWISE PROCEEDING WITH ANY TRANSACTION AFTER RECEIPT OF THE AGREEMENT, OR BY CLICKING ON THE ACCEPT BUTTON OR SIMILAR BUTTON, YOU, AS THE INDIVIDUAL OR SINGLE ENTITY ACQUIRING THE SOFTWARE (THE "CUSTOMER"), OR AS THE USER (AS HEREINAFTER DEFINED) SIGNIFY THAT YOU HAVE READ AND ACCEPTED THE TERMS AND CONDITIONS OF THIS AGREEMENT AS OF THE DATE ON WHICH YOU FIRST ORDER THE SOFTWARE, INSTALL, DOWNLOAD, USE OR CLICK THE ACCEPT BUTTON (THE "EFFECTIVE DATE"). IF YOU DO NOT ACCEPT THIS AGREEMENT, YOU SHOULD NOT ORDER, INSTALL, DOWNLOAD, NOR USE THE SOFTWARE AND CONTACT EXFO FOR A REFUND, IF APPLICABLE.

Terms and Conditions

1. DEFINITIONS

1.1 "Documentation" means EXFO's online or electronic information manual or other printed materials that (i) contain operating instructions and performance specifications for the Software and; (ii) EXFO delivers with the Software; and (iii) EXFO generally makes available to all users of its Software.

1.2 "Open Source Software" means individual software components that are provided with the Software, for which the source code is made generally available, and that are licensed under the terms of various published open source software license agreements or copyright notices accompanying such software components which include without limitation any software licenses approved as open source licenses by the Open Source Initiative or any substantially similar licenses.

1.3 "Product" means any hardware product developed by or on behalf of EXFO designed for use with the Software, as the case may be.

1.4 "Software" means the software programs and software components in object code, source code or other format and all modifications, updates, and enhancements that EXFO agrees to deliver or make available to Customer from time to time.

1.5 "Third Party" means any individual, corporation, partnership, association or other entity, other than the parties to this Agreement.

1.6 "Third Party Software" means the software programs distributed by EXFO as part of the Software which have been developed by Third Parties or their licensors and may include Open Source Software.

1.7 "Users" means Customer's officers, employees, and independent agents and contractors, who are bound by enforceable obligations to use the Software only on behalf of the Customer and only in accordance with this Agreement.

2. PROPRIETARY RIGHTS

2.1 The Customer acquiring a license to the Software is granted only those rights expressly conferred by the license grant set forth in Section 3 of this Agreement. The Software is licensed, not sold. Title to the Software and the Documentation shall not be passed to Customer, Users or to any other party. EXFO shall retain ownership of all rights, titles and interests, in and to the intellectual property rights related to the Software and the Documentation, including but not limited to, patent, trademark, copyrights, trade names, trade secrets, other similar rights, and intellectual property rights that could result from any alterations, attachments and improvements made by either party. Title in the Third Party Software or the Open Source Software remains with the Third Party licensors, as applicable. Customer and Users shall not, remove or modify any Software and Documentation markings or any notices of EXFO's or its Third Party licensors' proprietary rights.
3. LICENSE GRANT

3.1 License Grant. Subject to the terms and conditions of this Agreement, EXFO grants to Customer a personal, non-sublicensable, non-transferable and non-exclusive license to have Users install and use the Software in accordance with the Documentation and solely within Customer's own personal or business operations, as the case may be. EXFO's license grant is conditioned on Customer continuous compliance with all limitations and license restrictions described herein and in the Documentation and if Customer violates any of these limitations and restrictions or any other terms of this Agreement, the license grant will automatically and immediately terminate without notice from EXFO. Any usage of the Software outside one of the following scopes constitutes an infringement of EXFO's and/or its Third Party licensor's intellectual property and/or proprietary rights as well as a material breach of this Agreement.

3.1.1 Standard. The license grant of section 3.1 is granted solely to install the Software on either (i) one (1) EXFO designated Product; (ii) one (1) stand-alone computer; or (iii) one (1) mobile device, neither of which may be connected to a network in a manner that allows more than one (1) User to upload, access, run or generally use the Software concurrently.

3.1.2 Simulator Multi-User. In the case of Simulator Products, the license grant of section 3.1 is granted solely to use the Software in connection with one (1) EXFO designated Simulator Product and multiple Users may upload, access, run or generally use the Software concurrently subject to the hardware capabilities of the Simulator Product purchased by the Customer. Notwithstanding anything to the contrary herein, Users may customize or modify the Software standard package to meet Customer's specific needs as allowed by the script environment.

3.1.3 Server Access. For any Software that allows or grants access to a server, the license grant of section 3.1 is granted solely for the purpose of accessing the server that enables administration of User accounts and performs services as specified in the Documentation, such as data storage. Customer shall use the Software only with one (1) stand-alone Product or supported device within a server-configured time period or server access enablement, and shall be responsible for the administration of the User accounts and the Users' use of the Software. The Users may use the Software on behalf of the Customer for Customer's business activities as described in section 3.1 above, subject to the terms of this Agreement. The Customer shall purchase a license or subscription, as the case may be, for each User accessing the server. EXFO reserves the right to discontinue Server Access to Customer and its Users upon non-payment of appropriate and associated maintenance or subscription fees. Unless otherwise agreed in writing, the license grant for Server Access is limited to a period of 1 year from the date of purchase.

3.1.4 Service Assurance Licensed Hardware. In the case of Service Assurance Products, the license grant of section 3.1 is granted solely to use the EXFOWorx system (including where applicable other Service Assurance applications) in connection with the maximum number of verifier agents purchased by the Customer and identified by a verifier key provided by EXFO.

3.2 Copies. Unless otherwise agreed in writing, Customer may, when applicable with the type of Software, only make one (1) copy of the Software for backup and disaster recovery purposes provided that any copy or portion thereof must bear the same proprietary and/or copyright notices contained in or on the original copy.

4. LICENSE RESTRICTIONS

4.1 No right is granted (i) for the use of the Software for or in the interest of any Third Party, including, but not limited to, use for timesharing, service bureau, subscription service, hosting, outsourcing or other similar services; or (ii) to sell, transfer, export, license or sublicense any of the Software.

4.2 Customer shall not translate or create any derivative works based on the Software or Documentation or reverse engineer, decompile, disassemble or decode in whole or in part the Software or the Product or derive any source code or algorithms from the Software nor modify or alter the Software, the Product or the Documentation in any other manner whatsoever.

4.3 Customer shall not copy or use the Software or Documentation for any purpose or in any manner not expressly permitted in this Agreement.

4.4 Customer shall not remove or modify any program markings or any notice of EXFO's or its Third Party licensor's proprietary rights.

4.5 The validity of this Agreement is subject to the payment of all applicable license or maintenance fees by Customer to EXFO as the case may be and as indicated in the applicable EXFO invoice, if any.

4.6 The Third Party Software provided to Customer is distributed under the terms of the license agreements associated with that Third Party Software. Copies of these terms are included in the Documentation otherwise this Agreement shall govern the use of any Third Party Software by Customer. EXFO may designate any Third Party licensors as a third party beneficiary of this Agreement (the "Third Party Beneficiary") solely with regards to the distribution of such Third Party Software but this Agreement shall not be enforceable by the Third Party Beneficiary without a prior written agreement duly executed with EXFO. NOTWITHSTANDING ANYTHING ELSE TO THE CONTRARY IN THIS AGREEMENT, EXFO EXPRESSLY DISCLAIMS ANY WARRANTY, RESPONSIBILITY OR LIABILITY WITH REGARD TO THE THIRD PARTY SOFTWARE, INCLUDING THE DOWNLOADING AND INSTALLATION, IF APPLICABLE.

4.7 Software may contain Open Source Software. Open Source Software is composed of a variety of individual software components, each of which has its own copyright and its own applicable license conditions. Customer must review the licenses within the individual packages to understand its rights under them. The licenses can be found in each Software and/or the Documentation. NOTWITHSTANDING ANYTHING ELSE TO THE CONTRARY IN THIS AGREEMENT, EXFO EXPRESSLY DISCLAIMS ANY WARRANTY, RESPONSIBILITY OR LIABILITY WITH REGARD TO OPEN SOURCE SOFTWARE.
4.8 The Software may use Google Analytics, an analytics service provided by Google, Inc. ("Google") or any other similar analytics services. Anonymous information may be collected about Customer's use of the Software and such information will be transmitted to and stored on Google or third party servers. This information will be used for the purpose of compiling reports on the Software's activity. This information may also be transferred to other parties where required to do so by law, or where such parties process the information collected by the analytics services.

5. RESERVED RIGHTS

5.1 Title in the Software remains with EXFO. Title in the Third Party Software and Open Source Software remains with the Third Party providers.

5.2 EXFO reserves any rights not expressly granted in Section 3 and nothing in this Agreement constitutes a waiver of EXFO's rights under copyright laws or any other federal or state law or treaty. Without limiting the foregoing, EXFO reserves the right to license the Software to others on such terms as EXFO may establish in its sole discretion.

5.3 EXFO reserves the right, in any way and without notice, to revise, not to revise, update or modify the Software, or the information upon which the Software was based. Except as otherwise expressly set forth in this Agreement, EXFO assumes no responsibility, for (i) protecting the Software against obsolescence; (ii) providing any improvements to the Software; (iii) maintaining the Software; or (iv) providing other services with respect to the Software.
6. COOKIE AND PRIVACY POLICY

If the use of the Software allows connection to an EXFO Server, Customer and Users consent to EXFO's collection, use and disclosure of information associated with the Software solely in accordance with EXFO's Cookie and Privacy Policy, currently available at https://www.exfo.com/en/user-privacy-notice/, as it may be updated by EXFO from time to time.

7. AUDIT

When applicable, EXFO reserves its right to verify, upon reasonable notice, Customer's use of the Software in compliance with the terms of this Agreement and audit all books and financial records related to such use. Customer agrees to pay within 30 days of written notification any underpaid fees. If the Customer does not pay, EXFO can end Customer's support, licenses and this Agreement. EXFO shall have the right to disclose the result of such audit to its Third Party Software licensors to the extent that such audit results in findings concerning such Third Party Software licensor.

8. SUPPORT

EXFO shall only provide support for the Software to the extent set forth in a separate maintenance agreement or support program, if any, between EXFO and Customer.

9. CONFIDENTIAL INFORMATION

9.1 Customer shall hold the Software and the Documentation in strict confidence for the benefit of EXFO as confidential information.

9.2 Customer shall not make any disclosure of the Software (including methods or concepts utilized in the Software) to anyone other than its Users who have a need to know provided that Customer shall be responsible for the use of the Software by its Users. Customer shall notify its Users of their confidentiality obligations with respect to the Software and the Documentation and shall require its Users to comply with these obligations. The confidentiality obligations of Customer and its Users shall survive the termination of Customer's licenses and rights granted under this Agreement.

9.3 Customer shall not disclose results of any Software or Product benchmark tests without EXFO’s prior written consent.

9.4 EXFO shall have the right to disclose, without Customer's consent, the terms of this Agreement to EXFO's Third Party Software licensors.

10. LIMITED WARRANTY AND EXCLUSIVE REMEDY

EXFO warrants that for a period of sixty (60) days from the date of delivery ("Warranty Period"), that the Software will operate and perform materially in conformance with the Documentation. If a breach of the warranty set forth in this Section 10 occurs, Customer's sole and exclusive remedy is that EXFO will provide reasonable efforts to correct non-conformances which are reproducible by EXFO during the Warranty Period. If the use of the Software allows connection to an EXFO Server, during any subscription term, EXFO will use commercially reasonable efforts to make the EXFO server generally available except for planned downtime or downtime caused by circumstances beyond EXFO's reasonable control.

11. DISCLAIMER

EXFO makes no representations and extends no warranties of any kind (other than those set forth in Section 10) with respect to (i) the use, sufficiency or accuracy of the Software; (ii) the sufficiency or accuracy of the reports or tests performed utilizing the Software; (iii) any Third Party Software and Open Source Software; (iv) any Third Party websites or links (including hyperlinks) thereto; or (v) the availability of the Software, the EXFO server or that the Software or the EXFO server performance will perform error-free and uninterrupted. TO THE EXTENT PERMITTED BY APPLICABLE LAW, THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE (EVEN IF EXFO KNOWS OR HAS BEEN MADE AWARE OF SUCH PURPOSE), AND THE WARRANTY AGAINST INFRINGEMENT OF PATENTS OR OTHER INTELLECTUAL PROPERTY RIGHTS. THE SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED, OR INTENDED FOR USE IN HAZARDOUS ENVIRONMENTS THAT REQUIRE FAILS-SAFE PERFORMANCE SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATIONS SYSTEMS, AIR TRAFFIC CONTROL, EMERGENCY RESPONSE, TERRORISM PREVENTION OR RESPONSE, LIFE SUPPORT OR WEAPONS SYSTEMS ("HIGH RISK ACTIVITIES") THE FAILURE OF WHICH COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE. EXFO EXPRESSLY DISCLAIMS ANY WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.
12. LIMITATION OF LIABILITY
EXFO IS NOT LIABLE FOR ANY INDIRECT DAMAGES, LOST PROFITS, INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THIS AGREEMENT OR THE FURNISHING OF THE SOFTWARE OR THIRD PARTY SOFTWARE, WEBSITES OR LINKS (INCLUDING HYPERLINKS) THERETO, INCLUDING THE USE OR INABILITY TO USE THE SOFTWARE OR THE THIRD PARTY SOFTWARE, WEBSITES OR LINKS (INCLUDING HYPERLINKS) THERETO, EVEN IF EXFO KNOWS OR HAS BEEN MADE AWARE OF THE POSSIBILITY OR LIKELIHOOD OF SUCH DAMAGES. EXFO IS NOT RESPONSIBLE FOR ANY COMPENSATION, REIMBURSEMENT, OR DAMAGES ARISING IN CONNECTION WITH: USERS INABILITY TO USE THE SOFTWARE AS A RESULT OF ANY UNANTICIPATED OR UNSCHEDULED DOWNTIME OF ALL OR A PORTION OF THE EXFO SERVER FOR ANY REASON, INCLUDING AS A RESULT OF POWER OUTAGES, SYSTEM FAILURES OR OTHER INTERRUPTIONS. EXFO'S LIABILITY UNDER THIS AGREEMENT, IF ANY, IS LIMITED TO (I) THE ANNUAL LICENSE FEES FOR SUBSCRIPTION LICENSE OR (II) THE TOTAL LICENSE FEES ACTUALLY RECEIVED BY EXFO FOR THE SOFTWARE. IF ANY REMEDY HEREUNDER IS DETERMINED TO HAVE FAILED OF ITS ESSENTIAL PURPOSE, ALL LIMITATIONS OF LIABILITY, DISCLAIMERS AND EXCLUSIONS OF WARRANTY AND DAMAGES SET FORTH IN THIS AGREEMENT SHALL REMAIN IN EFFECT.

13. TERM AND TERMINATION
13.1 The term of this Agreement will commence on the Effective Date and will remain in effect until expiration of Customer's subscription licenses, if applicable, or until termination in accordance with Section 13.2.

13.2 This Agreement and the license and rights granted to Customer under this Agreement will automatically terminate without notice to Customer if (i) Customer assigns the license for the benefit of creditors; (ii) Customer admits in writing its inability to pay debts as they mature; (iii) a trustee or receiver is appointed for a substantial part of Customer's assets; (iv) a bankruptcy proceeding is instituted against Customer which is acquiesced in and is not dismissed within sixty (60) days, or results in an adjudication of bankruptcy; or (v) Customer breaches the license granted in Section 3 or breaches any of the restrictions of Section 4.

13.3 Without prejudice to any other rights, EXFO may terminate this Agreement if Customer fails to comply with any term or condition of this Agreement.

13.4 Upon termination of this Agreement, Customer shall return the Software and the Documentation, including all copies and, if requested, certify in writing to EXFO the return. Customer is bound by all obligations incurred prior to the termination; however, all of EXFO's obligations will automatically terminate upon termination. EXFO is under no obligation to refund any monies because of termination. These termination rights are in addition to all other rights and remedies available to EXFO.

14. GENERAL
14.1 Neither the execution of this Agreement or anything in it, or the Software, shall be construed as providing nor implying any arrangement or understanding that EXFO will make any purchase, lease, examination or test of, or give any approval with respect to, any product or service.

14.2 Customer may not assign, in whole or in part, this Agreement, or any license, rights or obligations granted, to any Third Party, including without limitation, any subsidiary, affiliate or entity owned or controlled by Customer, or pursuant to any merger, consolidation or other Customer reorganization, without the prior written consent of EXFO.

14.3 The failure of either party at any time to enforce any of the provisions of this Agreement or any right under this Agreement, or to exercise any option provided, will in no way be construed to be a waiver of the provisions, rights, or options, or in any way to affect the validity of this Agreement. The failure of either party to exercise any rights or options under the terms or conditions of this Agreement shall not preclude or prejudice the exercising of the same or any other right or option under this Agreement.

14.4 This Agreement must be construed and enforced according to the laws applicable in the province of Quebec, Canada, without regards to its conflict of laws provisions. The parties specifically exclude the application of the United Nations Convention on Contracts for the International Sale of Goods and the Uniform Computer Information Transactions Act.

14.5 If any provision or portion of a provision of this Agreement is held invalid or unenforceable, the remainder of the Agreement shall not be affected, and the remaining terms will continue in effect and be binding on the parties, provided that such holding of invalidity or unenforceability does not materially affect the essence of the Agreement.

14.6 EXFO and Customer agree to comply with all applicable laws. Specifically, Customer will comply with all applicable export and import control laws and regulations of the United States and any foreign jurisdiction in which the Software is used and, in particular, Customer will not export or re-export the Software without all required United States and foreign government licenses. Customer acknowledges and understands that the Software contains encryption technology that may require an export license from the U.S. State Department when exported or re-exported to government end-users, Internet or telecommunications service providers providing services specific to government end-users. Export of the Software to certain countries is prohibited. Customer will defend, indemnify, and hold harmless EXFO from and against any violation of such laws or regulations by Customer or any of its agents, officers, directors, or employees.

14.7 The provisions of this Agreement constitute the entire agreement between the parties with respect to the licensing of the Software and supersede (i) all prior agreements, oral or written; (ii) any conflicting terms in Customer's purchase order or EXFO's invoice; and (iii) all other communications relating thereto. All Sections that by their sense and context are intended to survive the execution, delivery, performance and termination of this Agreement, will survive and continue in effect.
14.8 Any references to information contained in an URL form an integral part of this Agreement and the Customer hereby confirms that it has access to the Internet and confirms that prior to entering into this Agreement has read and agrees with the terms and conditions set out in those documents.

14.9 U.S. GOVERNMENT END USERS. The Software and any other software covered under this Agreement is a "commercial item" as that term is defined at 48 C.F.R. 2.101, consisting of "commercial computer software" and "commercial computer software documentation" as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government End User Customers acquire the Software with only those rights set forth therein.

END OF TERMS AND CONDITIONS

CONTACT INFORMATION: If you have any questions about this Agreement, please direct all correspondence to: EXFO Inc., 400 Godin Avenue, Quebec City, Quebec, G1M 2K2, Canada. Legal notice shall be sent to the attention of the EXFO Legal Department.

---

Third Party and Open Source License Notice

This product may include software developed by the following people and organizations with the following copyright notices:

- SLF4J (http://www.slf4j.org). Copyright © 2004-2017 QOS.ch. All rights reserved.
- Spring Framework Project (http://www.spring.io). Copyright © 2017 Pivotal Software Inc. All rights reserved.
- Node.js (http://www.nodejs.org). Copyright Node.js contributors. Copyright Joyent, Inc. All rights reserved.
- Express (http://www.expressjs.com). Copyright © 2009-2014 TJ Holowaychuk <tj@vision-media.ca>, Copyright © 2013-2014 Roman Shylman <shy@expressjs.com>, Copyright © 2014-2015 Douglas Christopher Wilson <doug@somethingdoug.com>. All rights reserved.
- Express Session (http://www.expressjs.com). Copyright © 2010 Sencha Inc. Copyright © 2011 TJ Holowaychuk <tj@vision-media.ca>, Copyright © 2014-2015 Douglas Christopher Wilson <doug@somethingdoug.com>
- KeyCloak (http://www.keycloak.org).
- Prometheus (https://prometheus.io/) Copyright © 2014-2019 Prometheus Authors.
- Net-SNMP (http://www.net-snmp.org/about/license.html) © 2019, Net-SNMP
- All other trademarks or service marks are the property of their respective owners.

Any third party software provided to you is distributed under the terms of the license agreements associated with that third party software. Where applicable, copies of the terms are included elsewhere in the documentation for this product. The source code for some of these components is available upon request for three years from the date of your receipt of the product. Please submit requests to EXFO; some fees could be required to cover the cost of distribution.

---

Oracle Java Commercial Features Notice

Use of the Commercial Features for any commercial or production purpose requires a separate license from Oracle. "Commercial Features" means those features identified Table 1-1 (Commercial Features In Java SE Product Editions) of the Java SE documentation accessible at http://www.oracle.com/technetwork/java/javase/documentation/index.html
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regulatory Information</td>
<td>xiv</td>
</tr>
<tr>
<td>1 Introducing the FG-750 Fiber Guardian</td>
<td>1</td>
</tr>
<tr>
<td>Main Features</td>
<td>3</td>
</tr>
<tr>
<td>Available Models</td>
<td>4</td>
</tr>
<tr>
<td>Available Optical Switch Cassette Configurations</td>
<td>9</td>
</tr>
<tr>
<td>Power Sources</td>
<td>12</td>
</tr>
<tr>
<td>Supported Web Browsers</td>
<td>12</td>
</tr>
<tr>
<td>Developing Your Own Test Applications</td>
<td>13</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>13</td>
</tr>
<tr>
<td>Conventions</td>
<td>14</td>
</tr>
<tr>
<td>2 Safety Information</td>
<td>15</td>
</tr>
<tr>
<td>General Safety Information</td>
<td>15</td>
</tr>
<tr>
<td>Other Safety Symbols on Your Unit</td>
<td>17</td>
</tr>
<tr>
<td>Laser Safety Information (Units with an OTDR)</td>
<td>18</td>
</tr>
<tr>
<td>Electrical Safety Information</td>
<td>20</td>
</tr>
<tr>
<td>3 Getting Started with Your Fiber Guardian</td>
<td>25</td>
</tr>
<tr>
<td>Preventing Electrostatic Discharge Damage</td>
<td>25</td>
</tr>
<tr>
<td>Preparing for Installation</td>
<td>26</td>
</tr>
<tr>
<td>Installing Your Unit in a Rack</td>
<td>27</td>
</tr>
<tr>
<td>Grounding Your Unit</td>
<td>30</td>
</tr>
<tr>
<td>Inserting or Removing Optical Switch Cassettes (FG-750EX Models Only)</td>
<td>32</td>
</tr>
<tr>
<td>Working with the Fiber (Patchcord) Management Tray</td>
<td>37</td>
</tr>
<tr>
<td>Connecting the Power and the Network Cables</td>
<td>45</td>
</tr>
<tr>
<td>Turning On or Off the Unit</td>
<td>48</td>
</tr>
<tr>
<td>Connecting a Monitoring Device to the Dry Contact Relays</td>
<td>50</td>
</tr>
<tr>
<td>Connecting an External Switch</td>
<td>52</td>
</tr>
<tr>
<td>Retrieving the IP Address of the Rear Ethernet Port (Host and Companion)</td>
<td>55</td>
</tr>
<tr>
<td>Preparing Your Unit for 3G/4G Access</td>
<td>59</td>
</tr>
<tr>
<td>Operating the RTU through SMS</td>
<td>67</td>
</tr>
<tr>
<td>Preparing to Access Your Unit via a WAN or the Internet</td>
<td>69</td>
</tr>
<tr>
<td>Connecting to the VPN</td>
<td>79</td>
</tr>
<tr>
<td>Connecting Your Unit to the Nova Fiber Solution</td>
<td>82</td>
</tr>
<tr>
<td>Cleaning and Connecting Optical Fibers</td>
<td>91</td>
</tr>
<tr>
<td>Working with the REST Commands (Certain Models Only)</td>
<td>93</td>
</tr>
<tr>
<td>Installing the Notification Agent on Your Computer</td>
<td>94</td>
</tr>
<tr>
<td>Understanding Applications, User Accounts and Passwords</td>
<td>96</td>
</tr>
</tbody>
</table>
Contents

4 Managing Users .................................................................................................................. 101
   Managing Credentials ........................................................................................................ 108
   Assigning a Role Mapping to a User .................................................................................. 110
   Associating a User to a Group ......................................................................................... 112
   Viewing Sessions ............................................................................................................. 113
   Managing Groups ............................................................................................................ 114
   Federating External User Databases .................................................................................. 115

5 Using the Host Web User Interface ...................................................................................... 121
   Accessing and Exiting the Host Web UI ............................................................................ 121
   Viewing Host and Companion Information ...................................................................... 123
   Configuring Network Settings .......................................................................................... 124
   Configuring the 3G/4G Settings ....................................................................................... 127
   Connecting as an NQMSfiber EMS Client (OTDR Mode Only) ....................................... 129
   Configuring the E-Mail Server Settings ........................................................................... 131
   Configuring SNMP .......................................................................................................... 132
   Configuring the Time Server Settings ............................................................................. 135
   Forcing an RTU to Detach From the Link ......................................................................... 136

6 Setting Up Your RTU .................................................................................................... 139
   Detecting the Fibers Connected to the Optical Ports ....................................................... 139
   Changing a Cassette ......................................................................................................... 144
   Configuring a Remote Switch (ROTAU) ............................................................................ 146
   Understanding ROTAU Statuses ....................................................................................... 151
   Configuring Alert Notifications ....................................................................................... 154
   Managing Alert Types ..................................................................................................... 155
   Managing System Setting Values ..................................................................................... 161
   Editing Test On Demand Default Parameters ................................................................... 170

7 Operating Your RTU in OTDR Measuring Mode ................................................................. 171
   Managing Optical Routes ................................................................................................. 171
   Managing Test Setups .................................................................................................... 178
   Managing Test Programs ............................................................................................... 188
   Managing Threshold Sets ............................................................................................... 192
   Performing an Ad Hoc Test ............................................................................................. 196
   Performing a Test ............................................................................................................ 203
   Managing Degraded Fibers ............................................................................................. 205
   Viewing Current and Scheduled Jobs .............................................................................. 210
   Configuring the Notification Agent .................................................................................. 211
   Managing Cable Templates ............................................................................................. 216
Contents

8 Analyzing Results .................................................................227
   Viewing the Current Fault List ..............................................227
   Searching and Displaying OTDR Results ............................234
   Search Results for Test On Demand .................................238

9 Using the Line Configuration Web User Interface ..................243
   Accessing the Line Configuration Web UI .........................243
   Managing Remote OTAUs .................................................247
   Managing Ports and Lines ..................................................252
   Performing an Injection Loss Test .....................................256
   Managing Configurations ..................................................258

10 Working With the Event Log ...............................................261
   Viewing the Event Log ......................................................261
   Customizing the Log View ................................................262
   Applying and Clearing Filters ..........................................263
   Exporting Log Reports .....................................................265

11 Maintenance .................................................................267
   Cleaning Switchable Connectors ......................................268
   Cleaning EUI Connectors ................................................272
   Cleaning Other Types of Connectors .................................274
   Replacing the Air Filter ....................................................275
   Replacing the Fan ............................................................279
   Replacing the Power Supply Modules ...............................287
   Replacing the OTDR .........................................................291
   Replacing an RTU or Changing the SSD (managed by EMS) ....295
   Backing Up the Database ................................................299
   Viewing the Installed Applications ....................................301
   Viewing the Firmware Version of the Companion ..............302
   Managing Applications (Software Packages) .....................303
   Recalibrating the Unit .....................................................307
   Recycling and Disposal ...................................................308
Contents

12 Troubleshooting .............................................................................................................................. 309
   Solving Common Problems ........................................................................................................... 309
   LED Indicators Description ........................................................................................................ 312
   Viewing System Status ............................................................................................................... 316
   Testing the Status of the Relays ................................................................................................. 316
   Refreshing the Status of the LEDs ............................................................................................ 318
   Connecting to Your Unit Using the KMV Remote Console .................................................... 320
   Resetting Configuration (Parameters) ....................................................................................... 324
   Restoring Your Unit to Normal Operation (Windows 8) .......................................................... 325
   Restoring Your Unit to Normal Operation (Windows 10) ....................................................... 329
   Viewing Online Documentation ............................................................................................... 346
   Contacting the Technical Support Group ................................................................................ 347
   Viewing Product Information ..................................................................................................... 348
   Transportation ............................................................................................................................ 348

13 Warranty ........................................................................................................................................ 349
   General Information .................................................................................................................... 349
   Liability ........................................................................................................................................ 349
   Exclusions ................................................................................................................................. 350
   Certification .............................................................................................................................. 350
   Service and Repairs .................................................................................................................... 351
   EXFO Service Centers Worldwide .............................................................................................. 352

A Fault Geolocalization Using a KML File ......................................................................................... 353

Index ................................................................................................................................................... 357
**Regulatory Information**

**IMPORTANT**

Because of the nature of wireless communications, transmission and reception of data can never be guaranteed. Data may be delayed, corrupted (that is, have errors) or be totally lost. Although significant delays or losses of data are rare when wireless devices such as your FG-750 are used in a normal manner with a well-constructed network, the unit should not be used in situations where failure to transmit or receive data could result in damage of any kind to the user or any other party, including but not limited to personal injury, death, or loss of property. EXFO accepts no responsibility for damaged of any kind resulting from delays or errors in data transmitted or received using the module, or for failure of the unit to transmit or receive such data.

**Canada and USA Electromagnetic Interference Regulatory Statement**

Electronic test and measurement equipment is exempt from FCC part 15, subpart B compliance in the United States of America and from ICES-003 compliance in Canada. However, EXFO Inc. makes reasonable efforts to ensure compliance to the applicable standards.

The limits set by these standards are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the user documentation, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.
European Electromagnetic Compatibility Regulatory Statement

Warning: This is a class A product. In a domestic environment, this product may cause radio interference in which case the user may be required to take adequate measures. Your product is certified for (or is suitable for) use in industrial electromagnetic environments.

General Wireless Compliance Related Information

If you purchased the 3G/4G option, your unit comes with an internal wireless module (adapter) and an antenna for which the information hereafter applies:

This product does not contain any wireless user-serviceable components. Any unauthorized product changes or modifications will invalidate warranty and all applicable regulatory certifications and approvals.
Canada and USA Wireless Compliance Related Information

If you purchased the 3G/4G option, your unit comes with an internal wireless module (adapter) and an antenna for which the information hereafter applies:

- This device complies with Part 15 of the FCC Rules.
- This device complies with Innovation, Sciences and Economic Development Canada license-exempt RSS standards.
- Operation is subject to the following two conditions:
  1. This device may not cause harmful interference and
  2. This device must accept any interference received, including interference that may cause undesired operation.

Use in Specific Environments:

- The use of wireless products in hazardous locations is limited by the constraints posed by the safety directors of such environments.
- The use of wireless products in hospitals is restricted to the limits set forth by each hospital.
- Do not operate your unit in areas where blasting is in progress.
- Do not operate your unit where explosive atmospheres may be present including refuelling points, fuel depots, and chemical plants.
- Do not operate your unit near medical equipment, life support equipment, or any equipment which may be susceptible to any form of radio interference. In such areas, the unit must be powered off. Otherwise, the unit can transmit signals that could interfere with this equipment.
Radiation Exposure Statement:

- For compliance to RF exposure requirements, a minimum separation distance of 20 centimeters (8 inches) must be maintained between the FG-750 antenna and the user or bystanders when the unit is working.

- To comply with regulations limiting both maximum RF output power and human exposure to RF radiation, the maximum antenna gain including cable loss in a mobile-only exposure condition must not exceed the limits speculated in the table below:

<table>
<thead>
<tr>
<th>Technology</th>
<th>Band</th>
<th>Frequency (MHz)</th>
<th>Maximum Antenna Gain (dBi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LTE</td>
<td>2</td>
<td>1850–1910</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1710–1755</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>824–849</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>2500–2570</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>699–716</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>777–787</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>1750–1915</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>814–849</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>2305–2315</td>
<td>(Disabled)</td>
</tr>
<tr>
<td></td>
<td>41</td>
<td>2496–2690</td>
<td>9</td>
</tr>
<tr>
<td>UMTS</td>
<td>2</td>
<td>1850–1910</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1710–1755</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>824–849</td>
<td>6</td>
</tr>
</tbody>
</table>

European Declaration of Conformity

The full text of the EU declaration of conformity is available at the following Internet address: [www.exfo.com/en/resources/legal-documentation](http://www.exfo.com/en/resources/legal-documentation).
1 Introducing the FG-750 Fiber Guardian

The FG-750 Fiber Guardian is a multiple-port OTDR aimed at remote testing and continuous monitoring of lit/unlit optical fibers. The equipment can be used as a standalone unit or as a remote test unit (RTU), part of a centralized management system such as EXFO NQMSfiber. An RTU contains an optical time domain reflectometer (OTDR) and an optical switch that allows the instrument to test and monitor multiple fibers from the same instrument.

➤ If you intend to operate the unit as an autonomous RFTS (OTDR-based) unit, then all of this user guide is relevant in you becoming familiar with the how-to-use Fiber Guardian in a stand-alone installation, including how to setup e-mail and/or SMS alerts, and optional 3G/4G wireless interface.

➤ If you intend to operate your FG-750 as part of an NQMSfiber system (centrally managed), chapters 6 and 7 of this guide present functions centrally available from the Element Management System (EMS) web user interface, such as result viewing and creation/edition of test setups.

The user guide also addresses a specialized usage of Fiber Guardian that is a fixed, remotely controlled, multi-port iOLM test equipment. This operation mode is available for example with a Node OTDR (OTM-700-Node) module.

**Note:** If you purchased an FG-750ST/EX-Node iOLM and want to operate it as an iOLM product, you will first need to switch modes by choosing an application, before operating the equipment. By default, factory sets the operation mode to OTDR.

➤ In OTDR mode, you can run basic functions such as triggering a manual OTDR test (ad-hoc), enabling standard fiber monitoring, and creating a cable template test campaign that allows for scheduled testing of one or multiple fibers that are part of the same cable span for short or long periods of time.
Introducing the FG-750 Fiber Guardian

- In iOLM mode with a Node OTDR (OTM-700-Node), you can use the equipment as an intelligent Link-Aware™ probe and run your own tests through an API (REST services), fully documented and available standard with the product. With a Node iOLM Fiber Guardian, you can test through PON splitters with the help of high-reflectance demarcation (HRD) filters that provide the discrimination required to measure and monitor attenuation of a specific branch of a point-to-multipoint (P2MP) line.

Various applications are possible using Node iOLM (OTM-700-Node in iOLM mode):

- 24/7 surveillance of dark (no traffic) or live (with traffic) optical fibers
- On-demand troubleshooting of P2P (point-to-point) and P2MP fiber lines
- Attenuation testing with HRD (termination filters) mainly in PON (passive optical network)
- Pass-fail testing on the transport fiber at time of installation
- Certification testing up to the customer port or drop terminal port
- Preventive maintenance testing and detection/localization of water intrusion or other slow varying phenomena.
Main Features

Your unit includes the following:

- Standalone capabilities scalable to a centralized server application if required
- A main CPU (host), and a baseboard management controller (BMC) as a secondary controller unit (companion)
- OTDR measurement, fault finding, test scheduling, local storage, and event forwarding to an external system or synchronization with a centralized server application such as EXFO NQMSfibera
- Optional built-in (first stage) or cassette switches (second stage)
- Possibility to connect external switches (remote OTAUs) for second and third stage switching capability
- Two USB 2.0 ports (host)
- Two Ethernet ports for local access and LAN/WAN connection
- Optional integrated communication module and external antenna for 3G/4G access (to take over automatically when the wired network is down, or to be used as primary network)
- Installation in a rack (rack-mounting brackets, front drawer for access to key parts and modules, and optional fiber management tray)
- Optional test access module (TAM) kits to couple transmit/receive optical line termination (OLT) and test ports to the line under test
- Optional patch panels to switch from multifiber cabling to single-fiber cabling without wavelength division multiplexers (WDM)
- Access to configure settings via the Fiber Guardian Host web UI
- Ability to create a logical line based on the port numbers used by giving them a unique name or ID through the line configuration web UI
- Open and fully documented API (REST interface) that enables you to develop your own system-level network test and management solution
Introducing the FG-750 Fiber Guardian

Available Models

- Management through EMS
- Fiber management tray (optional) that can be mounted on the front of the FG-750 to better manage large quantities and/or extra lengths of jumper cables.

Available Models

To better suit your testing needs, the following models are available:

- Multiple-port Fiber Guardian with a built-in optical switch inside the unit. Model: FG-750ST-XXXX-N (N=4, 8, 12, 24, 32).
- Expandable multiple-port Fiber Guardian with optical switch cassettes that can be added/removed from an eight-port basic configuration. Model: FG-750EX.
Fiber Guardian without Switch Ports

FG-750ST single port model: FG-750ST-XXXX-01

Front

- Retaining screws/handles to slide the unit in or out of its case (OTDR replacement)
- Banana plug connector for antistatic strap
- OTDR port
- LEDs
- On/Off button
- Retaining screws/handles to access the fan and air filter
- Ethernet local access port (to connect a portable computer to the unit)
- USB host ports
- To install the optional fiber management tray
- Mounting brackets for installation in a rack (not assembled on the unit at time of shipment)
Introducing the FG-750 Fiber Guardian

Available Models

- Replaceable power supply modules
  (AC model shown)
- Port for 3G/4G antenna
- Ethernet port
  (for LAN/WAN connection)
- Grounding lug
- Dry contact relays
Introducing the FG-750 Fiber Guardian

Available Models

Fiber Guardian with Switch Ports

Expandable Fiber Guardian with optical switch cassettes (shown below, fully loaded SC 32-port configuration)

Front

- Retaining screws/handles to slide the unit in or out of its case (OTDR replacement, switch cassettes insertion and removal)
- Banana plug connector for antistatic strap
- Switch ports
- LEDs
- On/Off button
- Retaining screws/handles to access the fan and air filter
- Ethernet local access port (to connect a portable computer to the unit)
- USB host ports
- To install the optional fiber management tray
- Mounting brackets for installation in a rack (not assembled on the unit at time of shipment)
Introducing the FG-750 Fiber Guardian

Available Models

Replaceable power supply modules
(AC model shown)

Port for 3G/4G antenna

Ethernet port
(for LAN/WAN connection)

Grounding lug

Dry contact relays
Available Optical Switch Cassette Configurations

When delivered with an optical switch, the minimum configuration for the FG-750 is 1x4 which is the size of optical switch cassette (OSC). The maximum is 1x96 with L1 (integrated first stage called L1) being a 1x8 connected to MTP 12-port cassettes at the second stage. Several possible configurations are available according to your needs.

Cassettes have various connector configurations to provide desirable port density or preferred connection standards. When the cassettes do not fill all the slots, you can use empty (short jumper) cassettes to avoid dust or other elements that could interfere with your testing.

**Note:** Optical switch cassettes are all mounted with angled (APC) polished connectors.

SC-Type Cassette (small jumper, no optical switch)
Introducing the FG-750 Fiber Guardian

Available Optical Switch Cassette Configurations

The one-port OSC is connected to the L1 stage and OTDR, and can be used for testing.

SC-type cassette (4-port optical switch)
Introducing the FG-750 Fiber Guardian

Available Optical Switch Cassette Configurations

- LC-type cassette (8-port optical switch)
- MTP-type cassette (12-port MTP optical switch)
Introducing the FG-750 Fiber Guardian

Power Sources

Your unit operates with the following power sources:

► Replaceable power supply module (either AC or DC). Your unit needs only one power supply module to work, but it can house two of them. The second power supply provides redundancy. Your unit has been certified with two power supplies of the same type (two AC or two DC).

The power supply modules are hot-swappable, which means that you do not have to turn off your system to replace one of them. There is no need to disassemble the unit to replace such a power supply. For more information, see Replacing the Power Supply Modules on page 287.

► Rechargeable battery (for clock). This battery can keep the date and time for a very long time even if power is not connected to the unit.

Supported Web Browsers

The host web UI, line configuration web UI, KVM remote console, and NQMS Web App support the following web browsers:

► Internet Explorer 11 (IE11 mode only, compatibility mode not supported) or later.

► Google Chrome, version 49.0 or later. Older versions are usually subject to vulnerabilities.

► Mozilla Firefox, version 52.0 or later.

Note: If you want to work with the KVM remote console, you should ensure that Java 6 or later is installed on the computer that you will use to connect to this application.
Developing Your Own Test Applications

In Link-Aware mode, you can build your own network test and management solution with the provided REST commands. For more information, see Working with the REST Commands (Certain Models Only) on page 93.

In OTDR mode, the measurement API is based on REST, using the following commands:

- GET reads a known resource or a list of resources.
- PUT replaces the state and content of a known resource.
- POST changes the state of a resource that either does not yet exist (in creation) or whose ID is unknown in advance.
- PATCH issues partial changes to a resource requiring existence of the changed resource.
- DELETE removes the known resource from storage.
- HEAD gets an HTTP response code when obtaining resources without any data.

Technical Specifications

To obtain this product’s technical specifications, visit the EXFO Web site at www.exfo.com.
Introducing the FG-750 Fiber Guardian

Conventions

Conventions

Before using the product described in this guide, you should understand the following conventions:

**WARNING**
Indicates a potentially hazardous situation which, if not avoided, could result in *death or serious injury*. Do not proceed unless you understand and meet the required conditions.

**CAUTION**
Indicates a potentially hazardous situation which, if not avoided, may result in *minor or moderate injury*. Do not proceed unless you understand and meet the required conditions.

**CAUTION**
Indicates a potentially hazardous situation which, if not avoided, may result in *component damage*. Do not proceed unless you understand and meet the required conditions.

**IMPORTANT**
Refers to information about this product you should not overlook.
2 Safety Information

General Safety Information

**WARNING**
Do not install or terminate fibers while a light source is active. Never look directly into a live fiber and ensure that your eyes are protected at all times.

**WARNING**
The use of controls, adjustments and procedures, namely for operation and maintenance, other than those specified herein may result in hazardous radiation exposure or impair the protection provided by this unit.

**WARNING**
If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

**WARNING**
Use only accessories designed for your unit and approved by EXFO. For a complete list of accessories available for your unit, refer to its technical specifications or contact EXFO.
**IMPORTANT**

Refer to the documentation provided by the manufacturers of any accessories used with your EXFO product. It may contain environmental and/or operating conditions limiting their use.

**IMPORTANT**

When you see the following symbol on your unit, make sure that you refer to the instructions provided in your user documentation. Ensure that you understand and meet the required conditions before using your product.

**IMPORTANT**

When you see the following symbol on your unit, it indicates that the unit is equipped with a laser source, or that it can be used with instruments equipped with a laser source. These instruments include, but are not limited to, modules and external optical units.

**IMPORTANT**

Other safety instructions relevant for your product are located throughout this documentation, depending on the action to perform. Make sure to read them carefully when they apply to your situation.
Other Safety Symbols on Your Unit

One or more of the following symbols may also appear on your unit.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>≈</td>
<td>Direct current</td>
</tr>
<tr>
<td>~</td>
<td>Alternating current</td>
</tr>
<tr>
<td></td>
<td>The unit is equipped with an earth (ground) terminal.</td>
</tr>
<tr>
<td></td>
<td>The unit is equipped with a protective conductor terminal.</td>
</tr>
<tr>
<td></td>
<td>The unit is equipped with a frame or chassis terminal.</td>
</tr>
<tr>
<td>N</td>
<td>Neutral conductor</td>
</tr>
<tr>
<td></td>
<td>On (Power)</td>
</tr>
<tr>
<td></td>
<td>Off (Power)</td>
</tr>
<tr>
<td></td>
<td>In position of a bistable push control</td>
</tr>
<tr>
<td></td>
<td>Out position of a bistable push control</td>
</tr>
<tr>
<td>OR</td>
<td>On/off (Power)</td>
</tr>
</tbody>
</table>
Laser Safety Information (Units with an OTDR)

Your instrument is in compliance with standards IEC 60825-1: 2007 and 2014.

**WARNING**

(IEC 60825-1: 2007) Viewing the laser output with certain optical instruments designed for use at a distance (for example, telescopes and binoculars) may pose an eye hazard.

**WARNING**

(IEC 60825-1: 2014) Viewing the laser output with telescopic optical instruments (for example, telescopes and binoculars) may pose an eye hazard and thus the user should not direct the beam into an area where such instruments are likely to be used.

Laser radiation may be encountered at the optical output port.
The following labels indicate that the product contains a Class 1M source:

![Laser Safety Labels](image)

<table>
<thead>
<tr>
<th>Wavelengths: / Longueur d’onde</th>
<th>Pulse width: / Largeur de l’impulsion</th>
<th>Max. peak power: / Puissance crête maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>800 nm - 1300 nm</td>
<td>≤ 1 µs</td>
<td>≤ 500 mW</td>
</tr>
<tr>
<td>1300 nm - 1400 nm</td>
<td>≤ 20 µs</td>
<td>≤ 260 mW</td>
</tr>
<tr>
<td>1400 nm - 1700 nm</td>
<td>≤ 20 µs</td>
<td>≤ 600 mW</td>
</tr>
</tbody>
</table>


**CAUTION**

Your unit contains a replaceable OTDR module. To avoid damaging your FG-750 Fiber Guardian, use only EXFO OTDR modules of the OTM-7xx Series with it.
Electrical Safety Information

This unit uses an international safety standard three-wire power cable. This cable serves as a ground when connected to an appropriate AC power outlet.

**WARNING**

- A readily accessible disconnect device must be installed on the mains (AC or DC circuits). The power cord of the AC/DC power adapter can be considered the disconnect device to the main power.

- If you intend to connect your FG-750 to AC power, use only the listed and certified AC/DC power adapter provided by EXFO with your unit. It provides reinforced insulation between primary and secondary, and is suitably rated for the country where the unit is sold.

- DO NOT connect the unit interfaces metallically to OSP (Outside Plant) wiring. The unit interfaces are designed for use as intra-building surfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE) and require isolation from the exposed OSP cabling. The addition of Primary Protectors is not sufficient protection in order to connect these interfaces metallically to OSP wiring.

- Use only the certified power cord that is suitably rated for the country where the unit is used.

- Replacing detachable MAINS supply cords by inadequately RATED cords may result in overheating of the cord and create a risk of fire.
WARNING

➤ Consideration should be given to the connection of the unit to the supply circuit, and the effect that overloading the circuits might have on over-current protection and supply wiring. Appropriate consideration of equipment nameplate ratings should be used when addressing this concern.

➤ Ensure that your power supply is properly grounded and that the power cable and power supply are compatible with the unit.

➤ The power supply in this product contains no user-serviceable parts. There is more than one supply in this product. Refer servicing only to qualified personnel.

➤ Do not attempt to modify or use the supplied AC power cord if it is not the exact type required. A product with more than one power supply will have a separate AC power cord for each supply.

Note: The AC power supply is not covered by the NEBS certification.
Safety Information

Electrical Safety Information

**WARNING**

➤ Use this unit indoors only.

➤ Do not remove unit covers during operation.

➤ Operation of any electrical instrument around flammable gases or fumes constitutes a major safety hazard.

➤ To avoid electrical shock, do not operate the unit if any part of the outer surface (covers, panels, etc.) is damaged.

➤ Make sure both disconnect devices are turned off before servicing the unit.

➤ Only authorized personnel should carry out adjustments, maintenance or repair of opened units under voltage. A person qualified in first aid must also be present. Do not replace any components while the disconnect devices are turned on.

➤ Unless otherwise specified, all interfaces are intended for connection to ES1 circuits only.

➤ Capacitors inside the unit may be charged even if the unit has been disconnected from its electrical supply.

**CAUTION**

Position the unit so that the air can circulate freely around it.
## Equipment Ratings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>➤ Node iOLM model: 0 °C to 40 °C (32 °F to 104 °F)</td>
</tr>
<tr>
<td></td>
<td>➤ Other models: –5 °C to 50 °C (23 °F to 122 °F)</td>
</tr>
<tr>
<td>Storage</td>
<td>➤ –40 °C to 70 °C (–40 °F to 158 °F)</td>
</tr>
<tr>
<td>Heat release</td>
<td>300 W/m²</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>≤ 95 % non-condensing</td>
</tr>
<tr>
<td>Maximum operation altitude</td>
<td>3000 m (9843 ft)</td>
</tr>
<tr>
<td>Pollution degree</td>
<td>2</td>
</tr>
<tr>
<td>Overvoltage category</td>
<td>II</td>
</tr>
<tr>
<td><strong>Input Power</strong></td>
<td></td>
</tr>
<tr>
<td>AC modela</td>
<td>➤ 100 - 240 V ~ ; 50/60 Hz; 2 A/1 A</td>
</tr>
<tr>
<td>DC modelb</td>
<td>➤ –48 V ＝＝＝；3 A</td>
</tr>
</tbody>
</table>

a. Not exceeding ± 10 % of the nominal voltage.
b. Range: –40 - –72 V

### CAUTION

➤ The use of voltages higher than those indicated on the label affixed to your unit may damage the unit.

➤ The operation and storage temperatures, as well as the altitude and relative humidity values of some modules may differ from those specified for your unit. In this case, always ensure that you comply with the most restrictive conditions (either module or unit).
3 Getting Started with Your Fiber Guardian

The installation process can be divided into the following main steps:

- Preparing for installation
- Installing the unit in a rack
- Connecting the devices
- Turning on the unit
- Connecting cables to the optical ports

**Warning**
To avoid personal injuries and damage to the unit, you must perform the procedures detailed in this section in the order they are presented.

Preventing Electrostatic Discharge Damage

Electrostatic discharge (ESD) damage can cause complete or intermittent equipment failures. Always use an ESD-preventive wrist or ankle strap and ensure that it makes good skin contact. Connect the equipment end of the connection cord into the ESD connector located on the front of your unit (see Available Models on page 4).

**Note:** All procedures for which the use of an antistatic strap is recommended will be identified as such throughout this documentation.
Preparing for Installation

**WARNING**

- The unit is designed to be installed in a limited access area, for example, central offices, telecommunication centers, computer rooms, wiring closets and similar type locations and in accordance with local codes.

- Only trained personnel can perform the unit installation and configuration tasks. These people have appropriate technical training and experience to be aware of the hazards to which a person can be exposed when performing these installation tasks.

**IMPORTANT**

The provided cellular antenna is not NEBS certified for connection outdoors.

Before installing your unit, you should take the following into consideration:

- The chosen location provides adequate clearance for maintenance procedures.

- The location is an environmentally-controlled area that meets the minimum operating parameters.

- The location is isolated from strong electromagnetic fields produced by electrical devices.

- The power cable and power supply are compatible with your power service.

- The power source is properly grounded and falls within the internal power supply rating.

- The location is in an ESD-safe work area.
Installing Your Unit in a Rack

- The rack (which is not included with the unit) should provide sufficient vertical clearance to insert the unit. The height of the unit is two rack units (2U) high, or about 3.5 inches.

- All electrical cabling can be connected only through the back panel.

**WARNING**

- The equipment rack must be anchored to an unmovable support to prevent it from falling over when one or more servers are extended in front of the rack on slides. You must also consider the weight of any other device installed in the rack. A crush hazard exists should the rack tilt forward, which could cause serious injury.

- Mounting of the unit in a rack or cabinet should be such that a hazardous condition is not achieved due to uneven mechanical loading. The fully-configured unit is heavy. Use caution when manipulating the unit. A lifting mechanism may be required for installation.

There are mounting brackets available in three formats:

- For 19-inch racks
- For 21-inch (ETSI) racks
- For 23-inch racks

**IMPORTANT**

Ensure that you use the type of mounting brackets that corresponds to the width of your rack.

The brackets have several rows of holes for more installation versatility. You can install the unit with its front panel flush with the front of the rack, install it forward, or even recess in the rack.
To install the mounting brackets on your unit:

1. If necessary, turn off the unit and disconnect all optical fibers and electrical cables.

2. Position the unit so that its bottom panel rests on a flat surface such as a table.

3. Align the holes of the first bracket with the holes of the unit casing at the position that best suits your installation needs. You can even invert position of the mounting bracket if necessary.
4. Fix the first bracket on the unit with the supplied screws (four screws per bracket).

5. Repeat steps 3 and 4 with the other bracket, ensuring that you place the bracket at the exact same position (orientation of the bracket, set of holes on the bracket and on the unit’s casing).

6. Place the unit in the rack at the desired height.

7. Fix the unit in place using four 10-32 x 1/2 in. screws (four M6 screws for the ETSI racks).

8. For NEBs installation, use thread-forming type unit-mounting screws that remove any paint or non-conductive coatings to establish a metal-to-metal contact.
Grounding Your Unit

To avoid the potential for an electrical shock hazard, you must reliably connect an earth grounding conductor to the unit (AC and DC models).

**Note:** The DC units are intended for installation with an isolated DC return (DC-I) and are to be installed in a Common Bonding Network (CBN) as per NEBS GR-1089.

**IMPORTANT**
Ensure to ground the unit using a grounding method that complies with your local regulations.
If you are not sure on how to proceed, consult a certified electrician.

**To ground your unit:**

1. Remove the two Phillips screws, and remove the grounding lug from the rear panel of the unit.

2. Prepare the ground wire (minimum 12 AWG), and attach one of its ends to the unit’s grounding lug using the appropriate crimping tool.

3. Use the two Phillips screws to attach the grounding lug and wire assembly to the rear panel of the unit.
4. Ground the other end of the wire as per your local regulation.

5. If a DC power supply is used, it needs to be grounded to the unit by using two green wires.

Your unit is now grounded properly.
Inserting or Removing Optical Switch Cassettes (FG-750EX Models Only)

If your unit features optical switch cassettes, you can change the configuration according to your test needs.

**CAUTION**

When removing a cassette, make sure to replace it with another one so that the front opening of the unit is always filled. Leaving empty spaces in the opening could allow dust and particles into the unit and compromise its optimal operation.

**To insert a cassette into the unit:**

1. If you are using a fiber management tray, remove the protective window. For more information, see *Working with the Fiber (Patchcord) Management Tray* on page 37.

2. Turn off the unit and disconnect it completely from the power sources.

3. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.
4. Loosen the retaining screws on each side of the unit.

5. Pull the unit out of its casing.

6. If you have not done so already, clean the optical fiber connector located at the back of the cassette. For more information, see Cleaning and Connecting Optical Fibers on page 91.

7. Insert the cassette through the top opening.

8. Connect the cassette to the unit using the optical connector at the back of the cassette and the corresponding optical fiber.
9. Align the connector at the bottom of the cassette with the one inside the unit, and push down. The cassette will snap into place.

10. Push the unit back into its casing and retighten the retaining screws.

11. If you are using a fiber management tray, put the protective window back into place. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.
To remove a cassette from the unit:

1. If you are using a fiber management tray, remove the protective window. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.

2. Turn off the unit and disconnect it completely from the power sources.

3. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.

4. If you have not done so already, disconnect any fiber from the front of the cassette. Loosen the retaining screws on each side of the unit.

5. Pull the unit out of its casing.

6. Disconnect the optical fiber from the cassette and put the fiber back on the holder at the back of the unit.
Getting Started with Your Fiber Guardian

Inserting or Removing Optical Switch Cassettes (FG-750EX Models Only)

7. Pull the module up using the tab located under the connector at the back of the cassette.

8. Pull the module out.

9. Push the unit back into its casing and retighten the retaining screws.

10. If you are using a fiber management tray, put the protective window back into place. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.
Working with the Fiber (Patchcord) Management Tray

You can install an optional fiber management tray on your unit.

**Note:** *The fiber tray is not covered by the NEBS certification.*

The tray comprises a fixed part that you screw in place on your unit, a mobile part (protective window), and fiber management clips. The protective window can be either folded down (to gain access to the fan block or filter) or removed completely (to insert or remove switch cassettes). As for the fiber management clips (into which you slide the fibers), there are five possible positions for more installation versatility.

**To install the fiber management tray:**

1. Carefully align the screws of the fiber management tray with the holes on the front of your unit.

2. Slide the tray toward the unit until it makes contact with the casing of the unit.
3. Using a Phillips screwdriver, turn the retaining screws clockwise until the tray is secured in place.
4. Position a plastic fiber clip as shown below, and snap it into the desired clip hole, depending on the configuration that you want to use.

5. Repeat the previous step with all the fiber management clips that you want to install (maximum of five clips in all).
6. Install the protective window as follows:

6a. Hold the protective window so that you see its flat side.

6b. Carefully align the pins of the protective window with the slots on the fixed part of the tray.

6c. Slide the pins of the protective window all the way down into the slots.
6d. Position the protective window vertically, and push it slightly so that the slot on each side of the window rests on the corresponding pin on the tray.

Your fiber management tray is now installed properly. You will simply need to slide the fibers into the fiber management clips when you are ready to use the tray.
To fold down the protective window:

1. Slightly pull the protective window upwards to release it from its seated position.

2. Once the protective window can move freely, fold it all the way down until it stops.

![Diagram showing the protective window and its components]

- Slot located on the side of the protective window
- Pin located on the fixed part of the tray
Getting Started with Your Fiber Guardian

Working with the Fiber (Patchcord) Management Tray

To remove the protective window:

1. Slightly pull the protective window upwards to release it from its seated position.
2. Once the protective window can move freely, position the window so that you can slide the pins of the protective window all the way out of their slots.
Connecting the Power and the Network Cables

Before starting to work with your unit, you must connect the power. You may also wish to connect the LAN/WAN network cable, especially if you intend to install your unit in a rack. You can also connect a network cable for local access to the unit (front port).

The Fiber Guardian is available with either AC or DC power supplies. The unit has redundant AC or redundant DC power modules. To benefit from this redundancy, be sure to connect both power supplies, each to a separate circuit.

As soon as you connect the unit to a power source, the baseboard management controller (BMC) starts its initialization. During this operation, the LEDs on the front panel will light up in the following sequence:

- All LEDs will turn to yellow for about 40 seconds.
- All LEDs will turn off for about 5 seconds.
- Finally, the power LED (��色 ) will turn to blinking green, indicating that the BMC is now ready (unit is in standby).

**Warning:**

- A certified over-current protecting device that is suitably rated must be installed at the source.
- All electrical installation and accessories must be done and selected as per local electrical code and regulations.

**Note:** Your unit has been designed to restart automatically when the power comes back after a power outage. However, in this case, the initialization sequence will differ from the usual initialization sequence explained above. For detailed information about the LEDs, see LED Indicators Description on page 312.
Getting Started with Your Fiber Guardian
Connecting the Power and the Network Cables

To connect the network cables:

1. To be able to operate the NQMS and REST commands via the LAN/WAN, connect one end of a network cable to the Ethernet port located at the back of your unit. Connect the other end of the cable to the network itself.

2. If you need a local access to the unit, connect one end of a network cable to the Ethernet port located at the front of your unit. Leave the other end of the cable free for future connections with a portable computer.

To connect the power to AC power supplies:

1. Connect the cords to the main power inlets located at the back of the unit.

2. Connect the other end of the cords to the power sources.

As soon as the initialization sequence is complete (power LED is blinking green), you are ready to turn on the unit (see Turning On or Off the Unit on page 48).
To connect the power to DC power supplies:

1. Ensure all power is off or disconnected at the source.

Note: A certified over-current protection of 5 A must be installed at the power secondary distribution.

2. Ensure that the unit is grounded properly. For more information, see Grounding Your Unit on page 30.

3. Crimp each power lead (minimum 14 AWG) with a UL-listed pressure terminal connector (ring type). The connector must be suitable for 14 AWG wires.

4. Pair the power leads with the appropriate power terminal (located at the back of the unit), respecting the polarity as indicated just below the terminal block.

5. Tighten the screws to attach the power leads to the unit.

6. Turn on the disconnect devices that are connected to the unit.

As soon as the initialization sequence is complete (power LED is blinking green), you are ready to turn on the unit (see Turning On or Off the Unit on page 48).
Turning On or Off the Unit

As soon as you connect the unit to a power source, the companion starts its initialization. Once the initialization is complete, you can turn on the host. Once the host is on, the operating system will be started automatically. Several components must be initialized before you can actually send commands or connect to the unit.

For detailed information about the LEDs, see LED Indicators Description on page 312.

**Note:** You can restart and turn off the host directly from the Host Web UI.

**Note:** Your unit has been designed to restart automatically when the power comes back after a power outage.

**To turn on the host:**

Press the power button until the power LED turns to green (non-blinking) and release it.
**IMPORTANT**

When the host is ready, the system LED turns to green (non-blinking).

When network cables are connected to the unit (front and rear ports), you must wait for the connection to be established before the system can be accessed.

- Front port (Static-APIPA): about 60 seconds after the network cable is connected.
- Rear port (DHCP): a few seconds after the operating system is loaded.

There is no visual or audible sign that the connection on the front port is established.

**To turn off the host “locally”:**

When the unit is on, press the power button for one second and release it. First, the system LED will turn to blinking green, and then turn off. Finally, the power LED will turn back to blinking green (standby mode), indicating that the host has been shut down properly.
To restart the host from the host web UI:
1. Connect to the host web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the main menu, select Actions > Restart Host.
3. When the application prompts you to confirm the action, click Yes.

To turn off the host from the host web UI:
1. Connect to the host web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the main menu, select Actions > Turn Off Host.
3. When the application prompts you to confirm the action, click Yes.

Note: Once the unit has been shut down, you will have to turn it on manually (by pressing the button on the front panel) to be able to use it.

Connecting a Monitoring Device to the Dry Contact Relays

Your unit is equipped with dry contact relays that enable you to connect your own monitoring device if you wish to do so.

There are three dry contact relays (65 V; 0.46 A) on the back panel of the unit:

- Power relay: Activated when all components related to the host are turned on (the power LED is green and does not blink).
- System relay: Activated when the software and hardware (power, fan speed, temperature) are working normally.
- User-defined relay: Used for NQMS Optical Route monitoring and is activated when a fault is detected on an optical route.
To connect a monitoring device to the dry contact relays:

See the diagram below to determine where you should connect the wires.

**Power relay**
- Pin 1 - NC = Normally Closed
- Pin 2 - C = Common
- Pin 3 - NO = Normally Open

**System alert relay**
- Pin 7 - NC = Normally Closed
- Pin 8 - C = Common
- Pin 9 - NO = Normally Open

**System relay**
- Pin 4 - NC = Normally Closed
- Pin 5 - C = Common
- Pin 6 - NO = Normally Open
Connecting an External Switch

When you need extra switch ports, you can purchase an external switch that you will connect to your FG-750 unit.

**WARNING**

To avoid serious injuries, always follow all the connection and safety instructions provided with your external switch.

If you are working with a Fiber Guardian remote OTAU, see *Safety Information* on page 15 and *Getting Started with Your Fiber Guardian* on page 25.

**CAUTION**

To avoid damaging your unit, use only external switches approved by EXFO.

For other models of external switches, if you need information on the connection procedures, the location of the various ports, or the configuration of the IP address, refer to the documentation that came with your switch.
To connect an external switch to your unit:

1. Connect one network cable to the rear Ethernet port of your unit, and one network cable to the LAN Ethernet port of the external switch.

Note: If you are not sure which port to use, refer to the documentation that came with your external switch for the exact location of the LAN Ethernet port.

2. Connect both network cables to the same network (LAN).
3. Connect one end of a jumper cable (or of a long feeder fiber) to the OTDR port (units without switch ports), or to any switch port of your choice on your Fiber Guardian unit.

4. Connect the other end of the jumper cable (or of the long feeder fiber) to the input port of the external switch.

**Note:** Depending on the external switch that you have, the input port may be labelled differently (master port, common port, etc.) or located at the back of the unit. Refer to the user documentation that came with your external switch for more information.

**Note:** Using a long feeder fiber will incur more attenuation, which will have to be taken into account when calculating the maximum OTDR reach.

**Note:** It is possible to cascade external switches. You would simply need to connect one port of an already connected switch to the input port of the external switch to add.
Retrieving the IP Address of the Rear Ethernet Port (Host and Companion)

Before starting to work with the Web user interfaces or the provided REST commands, you need to retrieve the IP address of the Ethernet port located on the back panel of the unit.

**IMPORTANT**

Keep the IP address of the rear Ethernet port to a safe location. You will need it later for most of the operations on your unit. While you retrieve the host IP address, it is a good idea to retrieve the address of the Companion as well to make sure that you have this information should you need to troubleshoot your system and temporarily lose access.

You will need to:

- Connect a portable computer to your unit via the Ethernet port located on its front panel.
- Enter the IP address of the front Ethernet port of the unit and provide it in the connection settings on the computer. The static IP address is `https://169.254.10.10`.

**Note:** Additional steps will be required because the SSL connection cannot be trusted. The specific steps are different from Chrome to Firefox and IE.

- Enter the appropriate user name when the Host Web UI prompts you.
  - The user name that you should enter is `Admin`.
  - The password is `Admin`.

The procedure below will guide you through the necessary steps.
To retrieve the IP address of the rear Ethernet port:

1. If necessary, turn on your unit. If the unit was not turned on yet, see *Turning On or Off the Unit* on page 48 for more information on the startup sequence and waiting time.

   **Note:** It may take a few minutes before your unit and the computer could “see” each other.

2. Connect your portable computer to the front Ethernet port of the unit.
   - If you have already connected a network cable to your unit, simply connect the free end of the cable to your computer.
   - Otherwise, connect a network cable between the unit (front port) and your computer. You will have to wait about 60 seconds that the detection of the port is complete once the operating system is started.

3. Turn on your computer.

   **Note:** When you start the computer, it may take a few minutes for the Keycloak system and dependencies to start up.
4. Connect to the Host Web UI as follows:
   
   **4a.** From your computer, open a Web browser.
   
   **4b.** Go to the welcome page of the console URL.
   
   **4c.** Enter your **Username or email** and **Password**.

5. In the Host Web UI, from the main menu, select **Configuration**, then under **System Information**, select **Host Information**.
6. Go to the **Rear Adaptor** column and write down the IP address of the rear port.

7. Select **Companion Information**, then go to the **Rear Adaptor** column and write down the IP address of the rear port.

8. Once it is done, close the Web browser.

9. Disconnect the network cable from your computer.
Preparing Your Unit for 3G/4G Access

Wireless interface is offered for enabling remote access to the equipment over a VPN (one VPN software is proposed and tested working for this capability), but primary for receiving text messages (SMS) when used in OTDR mode. If your unit is equipped with the optional 3G/4G feature, it can switch to the wireless network automatically when the wired network is down. Depending on which type of optional package you have purchased, it includes:

- an internal wireless communication module and a remote low-profile antenna with extension cable
- an internal wireless communication module, an SMA Connector saver/extender and a dipole swivel antenna

**Note:** *If the 3G/4G signal is not strong enough where your unit is installed, the low-profile antenna will provide you with a stronger coverage.*

By default, your unit is configured to connect automatically to the wireless network but you can deactivate this feature if you prefer. You can also specify a maximum number of minutes during which the unit can remain connected to the wireless network. EXFO uses a generic firmware working on most opened wireless networks, or in roaming mode. Available interfaces are LTE, HSPA+ and UMTS.

When you receive your unit, it contains no Subscriber Identity Module (SIM) card and the antenna is not connected. This means that you will need to do the following:

- Purchase a compatible and unlocked SIM card from a provider offering 3G/4G services. If you need more information on the 3G/4G coverage in your area, contact your regional EXFO sales representative.
- Have the card activated (you must subscribe to a package of mobile services).
- Connect the antenna to your unit.
Preparing Your Unit for 3G/4G Access

- Insert the SIM card in your unit.
- Configure the 3G/4G parameters via the Web UI.

To connect the remote low-profile antenna to your unit:
1. Gently screw the antenna’s connector to the 3G/4G port.
2. Position the antenna as needed for a maximum reception of the signal.

The antenna is ready to use.

To connect the dipole swivel antenna and SMA connector saver/extender to your unit:
1. Gently screw the SMA connector saver/extender to the antenna’s 3G/4G port. This will add clearance necessary for the antenna.
2. Firmly tighten the SMA connector saver/extender to the antenna’s 3G/4G port.

3. Carefully align the connector of the antenna with the 3G/4G port on your unit and push the antenna gently towards the unit until it stops.

4. Gently screw the antenna’s connector to the 3G/4G port.

5. Position the antenna as needed for a maximum reception of the signal. The antenna is ready to use.
**WARNING**
To avoid serious injuries as well as irreparable damage to your unit, always remove both power cords before opening or servicing the unit.

**CAUTION**
To avoid damaging your unit or its components, you should wear an antistatic band during this maintenance operation. For more information, see *Preventing Electrostatic Discharge Damage* on page 25.

**CAUTION**
If you are using a 3G/4G antenna with cable, depending on your setup, you may have to install a lightning protection system between your Fiber Guardian unit and the cable’s antenna. Failure to provide adequate lightning protection may lead to irreparable damage to your unit.

*To insert the SIM card in your unit:*

**IMPORTANT**
You MUST remove the power cord so that the hardware detects the SIM card. Rebooting the RTU (including the BMC) is *not* enough.
1. Turn off the unit and disconnect it completely from the power sources.

2. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.

3. Turn the fan compartment screws counterclockwise until the compartment is loose. Since the screws are captive screws, you cannot remove them completely.
Getting Started with Your Fiber Guardian

Preparing Your Unit for 3G/4G Access

**CAUTION**

To avoid dropping the fan compartment and damaging the unit, the fan, or the fan cord, hold the fan compartment firmly. Do not allow the fan compartment to hang over the edge of a rack or a table.

4. Using the screws as handles, gently pull away the fan compartment.

**CAUTION**

To prevent damage to your SIM card, avoid touching its gold area.
5. Hold the SIM card so that the gold area is facing down and that the beveled corner is on the right.

6. Slide the SIM card into the unit’s SIM card slot, and push it all the way to the back of the card slot.
7. Put the fan compartment back in its bay (it should be flush with the unit’s front panel).

8. Turn the fan compartment screws clockwise until the compartment is secured into place.

9. Remove your antistatic strap.

10. Reconnect the unit to its power sources (turn on both disconnected devices) and turn on your unit.

Note: Successfully restarting your unit ensures that the SIM card is properly detected. You MUST remove the power cord and wait a few minutes for the capacitors to discharge before restarting your unit to ensure that the SIM card is properly detected. You will then be ready to configure the 3G/4G parameters.

To configure the 3G/4G parameters:
Log on to the Web UI and configure the 3G/4G parameters. For more information on the configuration of these parameters, see Configuring the 3G/4G Settings on page 127.

Your unit is now ready to switch to the wireless network whenever the wired network is down.
Operating the RTU through SMS

The RTU can be operated by sending an SMS containing the appropriate commands. The mobile number from which these commands are sent should be a valid mobile number of an existing RTU user. If the command is not valid, then the RTU will send an SMS to the sender with the following text: <Command Text> is not a valid command. Messages are sent only to users in the system.

**SMS Command Format to Suspend or Resume an Optical Route (OR)**

The format to use when sending a command to the OR is as follows:

```
P[OR-Port Name]R[ROTAU-Port Number][C or X]
```

The table below shows examples of commands for suspending or resuming monitoring:

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To suspend OR - on port A,2</td>
<td>PA,2X</td>
</tr>
<tr>
<td>To resume OR - on port A,2</td>
<td>PA,2C</td>
</tr>
<tr>
<td>To suspend OR - on port A,2 R005</td>
<td>PA,2R5X</td>
</tr>
<tr>
<td>To resume OR - on port A,2 R005</td>
<td>PA,2R5C</td>
</tr>
<tr>
<td>To resume all ORs</td>
<td>C</td>
</tr>
<tr>
<td>To suspend all ORs</td>
<td>X</td>
</tr>
</tbody>
</table>
SMS Command Format to Run an On-Demand Test

The format to use when sending a command to the OR is as follows:

\[ \text{P[OR-Port Name]R[ROTAU-Port Number]T[Test Setup-Index if test setups are sorted in alphabetical order for an OR]} \]

The table below shows examples of commands for sending an on-demand test. In the examples, there are two test setups: monitoring and proactive maintenance on port \(-\text{A,}2\).

**Note:** The index of a test setup is its sequence number when all test setups of an optical route are sorted using the Testsetup Name criterion. Here, the index for monitoring would be 1 and the index for proactive maintenance would be 2.

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To start an OnDemand Test on a test setup Proactive maintenance</td>
<td>PA,2T2</td>
</tr>
<tr>
<td>To start an OnDemand Test on a test setup Proactive maintenance if it belongs to ROTAU port - A,2 R004</td>
<td>PA,2R4T2</td>
</tr>
</tbody>
</table>
Preparing to Access Your Unit via a WAN or the Internet

When your computer and your unit are connected to a same WAN or to the Internet, you can access your unit remotely with your computer. The connection is made possible through a Virtual Private Network (VPN). If you have purchased the 3G/4G option, the unit will also use a VPN to connect to the wireless network when the wired network is down.

Before being able to work with a VPN, you must:

- Install the LogMeIn Hamachi VPN client application on your computer.
- Create your own VPN on the Hamachi server.
- Install the LogMeIn Hamachi client on your unit.

The VPN that you will create will serve as a “connection” point between your computer and your unit. You will need to use the Hamachi VPN client application to connect to this new VPN.

Your unit must have access to the Internet to be able to configure it on the Hamachi server.

IMPORTANT

EXFO does not provide licenses for any VPN client or server applications. You can use any VPN application supporting data transfer over a 3G/4G wireless network.

The information hereafter is for guidance purposes only. The installation and use may differ for VPN applications other than LogMeIn Hamachi. If you are not sure how to proceed, contact your network administrator.

Contact Hamachi to ensure that you can use a free version of the LogMeIn Hamachi application or to purchase a license.
To **install the LogMeIn Hamachi VPN client on your computer:**


2. Download (save) the LogMeIn Hamachi VPN client application (installation file) to your computer.

3. Double-click the installation file that you have just downloaded to start the installation.

4. From the first window, select the desired language and click **Next**. Follow the on-screen instructions.

---

**IMPORTANT**

You cannot install the VPN client on the unit via a WAN or the Internet. You must either connect a portable computer (DHCP adapter) to the front port of the unit, or connect both the unit and a computer to a same LAN.
5. When the installation is complete, from the LogMeIn Hamachi window, click the **Power on** button to establish a connection with the Hamachi server.

6. Under **Client name**, enter a name that will enable you to easily identify your computer later.
7. Click Create to confirm the name and send a request for an address on the Hamachi server.

8. Since no VPN has been created yet, create one as follows:

8a. Click Create a new network.

8b. Enter a network ID and a password for your VPN.
8c. Click **Create** to complete the process.

8d. Once the VPN is created, click the **Power off** button and close the window.

**Note:** *Even though the VPN has been created from your computer, it is hosted on the Hamachi server, not on your computer directly.*
Getting Started with Your Fiber Guardian
Preparing to Access Your Unit via a WAN or the Internet

To install the LogMeIn Hamachi VPN client on your unit:

1. Transfer the installation file to your unit from your computer.

   **Note:** Once the transfer is complete, you can go to step 2.

   1a. Connect a USB key to your computer and copy the LogMeIn Hamachi installation file to your key.

   1b. From your computer, connect to your unit using the KVM remote console. For more information, see Connecting to Your Unit Using the KMV Remote Console on page 320.

   1c. In the Remote Console, from the main menu, select **Media > Virtual Media Wizard**.
1d. Under **Hard disk/USB Key Media 1**, select your USB key from the list. The drive letter associated with your USB key in this application should be exactly the same you could see under Windows if you open a file explorer on your computer.

1e. Click **Connect Hard disk/USB Key**.

1f. Click **Close**.
Preparing to Access Your Unit via a WAN or the Internet

1g. In the Remote Console, from **Computer**, double-click the USB key to view its content.

1h. Copy the LogMeIn Hamachi installation file and paste it to the desktop (or the folder of your choice) of your unit.

2. Double-click the installation file that you have just copied to start the installation.

3. From the first window, select the desired language and click **Next**. Follow the on-screen instructions.
4. When the installation is complete, from the LogMeIn Hamachi window, click the Power on button to establish a connection with the Hamachi server.

5. Under Client name, enter a name that will enable you to easily identify your unit later.

6. Click Create to confirm the name and send a request for an address on the Hamachi server.
7. Once the connection is established, from the LogMeIn Hamachi window, connect to the VPN that you have created earlier.

7a. Click the **Join an existing network** button.

![LogMeIn Hamachi window](image)

7b. Enter the ID of your VPN and the corresponding password.

7c. Confirm with **Join**.

---

**IMPORTANT**

Do not leave the VPN (network) and do not log off from the Hamachi server from your unit.

Do not close the LogMeIn Hamachi window with the **Power off** button. Otherwise, you will not be able to access your unit from a WAN or the Internet later.

7d. Close the window with the **X** button (not the **Power off** button).

You are now able to access your unit from your computer via a WAN or the Internet.
Connecting to the VPN

When your computer and unit are both connected to a WAN or the Internet, you need to join the VPN from your computer and to retrieve the LogMeIn address of your unit before being able to connect to the Host Web UI or the Line Configuration Web UI.

The VPN client must be installed on both your computer and your unit already. For more information on how to install the VPN client, see Preparing to Access Your Unit via a WAN or the Internet on page 69.

To connect to the VPN:
1. From your computer, start the LogMeIn Hamachi client application.
2. Click the Power on button to establish a connection with the Hamachi server.
3. Click the **Join an existing network** button.

![Image of LogMeIn Hamachi interface showing 'Join an existing network' button]

4. Enter the ID of your VPN and the corresponding password.

![Image of Join Network window with 'Join' button highlighted]

5. Confirm with **Join**.
6. Write down the Hamachi address (which begins with 5.x) that has been assigned to the unit.

You are now ready to connect to the desired application.
Connecting Your Unit to the Nova Fiber Solution

You can use your unit as an element of the Nova Fiber solution. All the elements that are part of the solution are managed by an Element Management System (EMS). The solution, that primarily relies on the DNS (Domain Name Service) infrastructure, is designed to automatically detect an instance of such an EMS.

This automatic discovery mechanism provides several features for remote test units management such as: possibility to fall back on a secondary EMS instance for disaster recovery purposes, automatic registration of the units when they are started for the first time, and IPv6 transition support. It also allows for faster centralized provisioning and is preferred for centrally-managed address broadcast. This feature requires a valid DNS address configured either through DHCP or directly in your remote test unit’s TCP/IP network configuration settings.

This means that if your network infrastructure supports DNS, you simply need to follow the configuration steps presented in the installation guide of Nova Fiber FMS. For you to benefit from all the features for remote test units management, EXFO recommends to use this type of installation.

However, your network infrastructure may require another type of configuration. In cases where infrastructure services such as DNS are not available, you will need to specify the address to use for the EMS by properly defining system environment variables.
Connecting Your Unit to the Nova Fiber Solution

**IMPORTANT**

In non-DNS environments:

- You must manually set the EMS address to use on every unit unable to access the DNS.
- You will not be able to benefit from the remote test units management features such as the possibility to fall back on another EMS instance in case of major problems and the automatic registration of your units when they are started for the first time.

**To manually configure your unit for a non-DNS environment:**

1. Ensure that the network zones of the firewall are properly configured on the FMS server, as explained in the *Network Configuration* section of the Nova Fiber FMS installation guide.

2. Ensure that the FMS server has a static IPv4 or IPv6 address.

3. If it is not already done, turn on your unit.

4. Connect to your unit using a user account having administrator rights with the Host Web UI (see the corresponding section in this user documentation).
5. Stop the *EXFO FMS RTU Client* and *EXFO FMS RTU Messenger* services as follows:

5a. From the Windows status bar, click the search icon, and then type *Services*.
5b. From the list of services, select **EXFO FMS RTU Client** and **EXFO FMS RTU Messenger**, and then click the button to stop them in turns.

![Image: Services window]

**Note:** Leave this window open as you will need to restart the services later.
6. Set the required environment variable as follows:

   6a. From File Explorer, right-click **This PC**, and then click **Properties**.

   6b. Click the **Advanced system settings** link.
6c. From the Advanced tab, click the Environment Variables button.

6d. Under System variables, if you cannot find a variable named FGMS_MB_ADDRESS, click New to create it.

**Note:** If the variable already exists, click the Edit button instead and go to step 6f.
Getting Started with Your Fiber Guardian

Connecting Your Unit to the Nova Fiber Solution

6e. In the **Variable name** box, type `FGMS_MB_ADDRESS`.

6f. In the **Variable value** box, type the server address to which you want to connect your unit. Enter the same address as the one used to access the interface of FMS (in the example below: `MyFms.MyCloud.com`).

6g. Confirm with **OK**.

7. Restart the **EXFO FMS RTU Client** and **EXFO FMS RTU Messenger** services as follows:

   7a. Go back to the **Services** window.

   7b. From the list of services, select **EXFO FMS RTU Client** and **EXFO FMS RTU Messenger**, and then click the **Start** button to start them.

   7c. Close the **Services** window.
8. Verify the registration of your unit to the server as follows:

8a. From the Windows status bar, click the search icon, and then type *Events*.

8b. From the tree view, select *Windows Logs > Applications*. 
8c. From the list of applications, click the most recent event having EXFO TestCoordinator as the source. If the registration was successful, from the General tab, you will see: 

*Successfully registered to server using message broker at tcp://<address provided on step 6f>:61616.*

Your unit is now configured properly.
Cleaning and Connecting Optical Fibers

**IMPORTANT**
To ensure maximum power and to avoid erroneous readings:

- Always inspect fiber ends and make sure that they are clean as explained below before inserting them into the port. EXFO is not responsible for damage or errors caused by bad fiber cleaning or handling.
- Ensure that your patchcord has appropriate connectors. Joining mismatched connectors will damage the ferrules.

**To connect the fiber-optic cable to the port:**

1. Inspect the fiber using a fiber inspection probe. If the fiber is clean, proceed to connecting it to the port. If the fiber is dirty, clean it as explained below.

2. Clean the fiber ends as follows:

   2a. Gently wipe the fiber end with a lint-free swab dipped in optical-grade liquid cleaner.

   2b. Use a dry swab to dry the connector completely.

   2c. Visually inspect the fiber end to ensure its cleanliness.
3. Carefully align the connector and port to prevent the fiber end from touching the outside of the port or rubbing against other surfaces.

   If your connector features a key, ensure that it is fully fitted into the port's corresponding notch.

4. Push the connector in so that the fiber-optic cable is firmly in place, thus ensuring adequate contact.

   If your connector features a screw sleeve, tighten the connector enough to firmly maintain the fiber in place. Do not overtighten, as this will damage the fiber and the port.

**Note:** *If your fiber-optic cable is not properly aligned and/or connected, you will notice heavy loss and reflection.*

EXFO uses good quality connectors in compliance with EIA-455-21A standards.

To keep connectors clean and in good condition, EXFO strongly recommends inspecting them with a fiber inspection probe before connecting them. Failure to do so will result in permanent damage to the connectors and degradation in measurements.
Working with the REST Commands (Certain Models Only)

You can build your own test applications with the provided REST commands. You can refer to the Using iOLM Measurement Services and Using FG-700 Series REST Services documentation for detailed information.

**IMPORTANT**

- The computer that you intend to use to send commands must be connected to the same network as the unit.
- You must know the IP address of the rear Ethernet port. If you do not know the IP address of the port, see *Retrieving the IP Address of the Rear Ethernet Port (Host and Companion)* on page 55.

You can test the link to the rear Ethernet port by trying to access the REST documentation on the unit.

**To access the REST documentation:**

1. Connect to the Host Web UI. For more information, see *Accessing and Exiting the Host Web UI* on page 121.
2. From the main menu, select *Actions > Applications*.
3. Click the link corresponding to the document that you want to view.
Installing the Notification Agent on Your Computer

The Notification Agent is an application that you can install on any computer that can “view” the RTUs, which usually means that the computer and RTUs are connected to the same network. It monitors one or several RTUs and warns you whenever faults are detected.

To install the Notification Agent on your computer:

1. Verify if you need to install the .NET Framework version 4.0 or higher on your computer as follows:
   1a. From your computer, go to the Control Panel.
   1b. Start Add/Remove Programs.
   1c. From the list of programs that are already installed on your computer, try to locate Microsoft .NET Framework 4.0 or higher.
      If this item is on the list, you do not need to install .NET Framework 4.0 or higher; otherwise, you will need to install it.

2. Start the RTU application (see Setting Up Your RTU on page 139).

3. Install the Notification Agent as follows:
   3a. From the main menu of the NqmsWebOtdr2 application, select About > Tools.
Getting Started with Your Fiber Guardian
Installing the Notification Agent on Your Computer

3b. Under EXFO Software, click the hyperlink to retrieve the necessary file.

![EXFO Software Interface](image)

3c. Save the file to a location of your choice on your computer.

3d. Double-click the `.msi` file to start the installation and follow the instructions on the screen.

You are now ready to use the Notification Agent. For more information, see Configuring the Notification Agent on page 211.
Getting Started with Your Fiber Guardian
Understanding Applications, User Accounts and Passwords

Understanding Applications, User Accounts and Passwords

There are several ways to interact with your Fiber Guardian unit.

The table below summarizes the information about the different applications as well as the corresponding user names and passwords.

<table>
<thead>
<tr>
<th>Application</th>
<th>Connection</th>
<th>User Name and Default Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>HostWebUI:</td>
<td>➢ Computer connected directly to the unit (front port):</td>
<td>➢ User name: Admin</td>
</tr>
<tr>
<td></td>
<td>From your computer, in a Web browser, type:</td>
<td>➢ Password: Admin</td>
</tr>
<tr>
<td></td>
<td>➢ LAN connection:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>From your computer, in a Web browser, type:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➢ WAN or Internet connection:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>From your computer (already connected to the VPN), in a Web browser, type:</td>
<td></td>
</tr>
</tbody>
</table>

- To configure the host and companion settings
- To monitor the system (event log)
### Getting Started with Your Fiber Guardian

#### Understanding Applications, User Accounts and Passwords

<table>
<thead>
<tr>
<th>Application</th>
<th>Connection</th>
<th>User Name and Default Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiber Guardian (OTDR mode)</td>
<td>➤ Computer connected directly to the unit (front port):</td>
<td>➤ User name: Admin</td>
</tr>
<tr>
<td></td>
<td>➤ From your computer, in a Web browser, type:</td>
<td>➤ Password: Admin</td>
</tr>
<tr>
<td></td>
<td>➤ https://Front_Port_IP_Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ LAN connection:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ From your computer, in a Web browser, type:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ https://Rear_Port_IP_Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ WAN or Internet connection:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ From your computer (already connected to the VPN), in a Web browser, type:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>➤ https://LogMeIn_Hamachi_Address</td>
<td></td>
</tr>
</tbody>
</table>

- User name: Admin
- Password: Admin
### Getting Started with Your Fiber Guardian

**Understanding Applications, User Accounts and Passwords**

<table>
<thead>
<tr>
<th>Application</th>
<th>Connection</th>
<th>User Name and Default Password</th>
</tr>
</thead>
</table>
| Optical lines test web UI: To link your lines and switch ports according to your tests (in iOLM mode) | In the Host web UI, from the main menu, select **Actions > Applications**. Click the link corresponding to the line configuration web UI. OR  
  - Computer connected directly to the unit (front port):  
    From your computer, in a Web browser, type: \(//Front\_Port\_IP\_Address/LineConfiguration\)  
  - LAN connection:  
    From your computer, in a Web browser, type: \(//Rear\_Port\_IP\_Address/LineConfiguration\)  
  - WAN or Internet connection:  
    From your computer (already connected to the VPN), in a Web browser, type: https://LogMeIn_Hamachi_Address/LineConfiguration | ➤ User name: Admin
➤ Password: Admin                                                                 |
| List of the REST commands                                                    | In the Host web UI, from the main menu, select **Actions > Applications**. Click the link corresponding to the list that you want to view. | ➤ User name: Admin
➤ Password: Admin                                                                 |
| REST documentation                                                           | In the Host web UI, from the main menu, select **About > Help**. Click the link corresponding to the document that you want to view.                  | ➤ User name: Admin
➤ Password: Admin                                                                 |
### Getting Started with Your Fiber Guardian

#### Understanding Applications, User Accounts and Passwords

<table>
<thead>
<tr>
<th>Application</th>
<th>Connection</th>
<th>User Name and Default Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your own application using the REST commands</td>
<td>The user name and password must be sent with each command as a “basic authentication” header.</td>
<td>➤ User name: WebServicesUser&lt;br&gt;➤ Password: WebServicesUser</td>
</tr>
<tr>
<td>Direct connection to the unit (in Windows) for troubleshooting and installation of VPN client application.</td>
<td>Via the KVM application (see Connecting to Your Unit Using the KVM Remote Console on page 320).</td>
<td>➤ User name: Administrator&lt;br&gt;➤ Password: RTUEXFO123</td>
</tr>
</tbody>
</table>

**Note:** If you do not know the IP address of the rear Ethernet port, see Retrieving the IP Address of the Rear Ethernet Port (Host and Companion) on page 55.

**Note:** If you do not know the LogMeIn Hamachi address of your unit, or how to connect to the VPN, see Preparing to Access Your Unit via a WAN or the Internet on page 69 and Connecting to the VPN on page 79. If you are using a VPN client application other than LogMeIn Hamachi, see with your network administrator for the specific connection procedure.
4 Managing Users

The Fiber console module is an open-source enterprise-class Identity and Access Management (IAM) solution which EXFO has customized and integrated to its Fiber Guardian/NQMSfiber products. It offers simple, secured, and extensive authentication and auditing functions.

As a user in a centrally managed installation, you are now authenticated through a single sign-on/out instance which can itself be connected to your existing Lightweight Directory Access Protocol (LDAP) service. For centrally managed solutions, it means one log-on to move from one application (for example, central) to another (for example, local).

**To log in to the administration console:**

1. Go to the welcome page of the console using the corresponding URL for your system and log in.
Managing Users

2. To access the console, use the **Users** menu item in the navigation bar.

**Note:** If you are curious about a certain feature, button, or field within the Admin Console, hover your mouse over the question mark (?) icon. This will pop up tooltip text to describe the area of the console you are interested in.
To create users:

1. From the Users page, click Add user.

2. Enter the mandatory fields highlighted with an asterisk.
3. Click **Save**. This will bring you to the management page for your new user.
The **Details** tab displays all the data relevant to the user, including the following:

- **User Type** is either regular user or customer (applies to NQMSfiber).

  *Regular user* is a person who uses the system to provide Quality of Service (QoS) data for the customer. They do not receive alerts according to the fault position, as they are not associated with the optical route sections. However, they receive alerts for each alarm defined in the alarm type.

  *Customer* is an individual, a partner, an association, a joint stock company, a trust, a corporation, or a governmental entity that subscribes to telecommunications services offered by the company operating the Fiber Guardian system. Customers are different from regular users because they cannot access the system (neither EMS nor RTU) through the administrative workstation (AW) but can receive alerts and automatically generated reports through e-mails. However, they are mostly interested in faults that occur on the sections of an optical route that belong to them. Thus, different customers can be defined for different sections of each optical route.

**Note:** *If you are not part of a region in which the RTU is located, you will not see the alarms coming from that RTU as well as the status and the results associated. You will not be able to access that RTU and change its configurations.*

- **Time Zone** is the preferred time zone used to display the date and time in the AW windows.

- **Mobile Number** is the number of the user’s mobile device.
Managing Users

- **Trap receiver address** is for the remote test unit (RTU) only. The default is the manager IP address / DNS name of the SNMP manager. You can change the value when you configure a user. For existing users, this value is configured under Configuration > Host > Northbound Settings > SNMP. Provide the HTTP post URL where the JavaScript Object Notation (JSON) object for an event will be posted if the HTTP post notification channel is configured.

- **HTTP post URL (applies to RTU-2):** Parameters in a post are either in the body (default) or directly in the string. You can also have parameters in the string like this:
  
  https://example.com/page?parameter=value&also=another.

  Include the names of the desired fields with a $ in front. For example,
  
  https://example.com/page?param1=$FaultGroupDate&param2=$Position. In this example, the values of FaultGroupDate and Position would go in param1 and param2.

  Available values are as follows (case insensitive):

  FaultIdOnRtu, FaultResultIdonRTU, FirstReferenceIdonRTU, LastLearningIdonRTU, FaultType, Confirmations, Position, MinPosition, MaxPosition, Loss, ThresholdType, ThresholdValue, AppliedThreshold, EventType, OpticalRoute, TestSetupId, TestSetupName, TestType, RTUName, RTUIP and OTDRSerialNumber.

- **User Interface Access** (applies to NQMSfiber) allows you to enable or disable access for the following:

  AW (administrative workstation) which is required to view the EMS web interface.

  RTU (remote test unit) for access from the EMS.

  MOBILE for mobile app access.

- **User Rights for RTU** (applies to NQMSfiber) is allowing you to grant viewing or editing rights for the RTU application.
To search for users:

From the Users page, enter a search item, then click \( \text{search} \). It can be a first name, last name or e-mail address. To view the complete list in the system, select View all users instead.

**Note:** This will search just the local user database and not the federated database (LDAP) because some LDAP does not have a way to page through users.

If you want the users from federated backend to be synced into the user database you need to either:

- Adjust your search criteria. That will sync just the backend users matching the criteria into the user database.

- Go to User Federation tab and click Sync all users or Sync changed users in the page with your federation provider. See Federating External User Databases on page 115 for more details.
Managing Credentials

The **Credentials** tab of the **Users** page regroups the pieces of data that are used to verify the identity of a user, such as passwords, digital certificates, or even fingerprints. This is where you can create, disable, and reset passwords.
To change a password:
From the Credentials tab, enter a new password in the corresponding box. A Reset Password button will appear for you to click, after you have confirmed the new password. If the Temporary switch is ON, this new password can only be used once and will need to be changed after login.

Alternatively, if an e-mail is set up in the Realm Settings, you can send an e-mail to the user that will ask them to reset their password. Choose Update Password from the Reset Actions list box and click Send email. The sent e-mail contains a link that will bring the user to the update-password screen.

As it is the case for passwords, you can send an e-mail to the user that asks them to reset their one-time password (OTP) generator. Choose Configure OTP in the Reset Actions list box and click the Send email button. The sent e-mail contains a link that will bring the user to the OTP setup screen.
## Assigning a Role Mapping to a User

Roles are configured at the realm level and identify a type or category of user. Admin, user, manager, and employee are all typical roles that may exist in an organization. For example, the Admin Console has specific roles which give users the permission to access parts of the Admin Console UI and perform certain actions. There is a global namespace for roles and each user also has its own dedicated namespace where roles can be defined.

User role mappings can be assigned individually to each user and defines a mapping between a role and a user. A user can be associated with zero or more roles. This role mapping information can be encapsulated into tokens and assertions so that applications can decide access permissions on various resources they manage.

The table below lists the different role mappings along with the associated permissions:

<table>
<thead>
<tr>
<th>Role Mapping</th>
<th>Role Bearer Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>fg-topology-master</td>
<td>Access and edit all items defined in the topology.</td>
</tr>
<tr>
<td>fg-topology-read</td>
<td>View all items defined in topology.</td>
</tr>
<tr>
<td>fg-alarm-master</td>
<td>Perform all actions on any alarm in the system.</td>
</tr>
<tr>
<td>fg-alarm-all</td>
<td>Assign and change severity on active and closed alarms.</td>
</tr>
<tr>
<td>fg-alarm-acting</td>
<td>Assign any unassigned active alarm to themselves.</td>
</tr>
<tr>
<td>fg-results-master</td>
<td>Access and edit test results.</td>
</tr>
<tr>
<td>fg-results-read</td>
<td>Read test results</td>
</tr>
<tr>
<td>fg-test-control-master</td>
<td>Apply configuration changes on RTUs.</td>
</tr>
</tbody>
</table>
To set the role mapping for a user:

1. From the Users page, select the Role Mappings tab.
2. Move the roles that are available in the list to the appropriate list depending on which you want to assign to this particular user.
Managing Users
Associating a User to a Group

Associating a User to a Group

Groups features specific attributes that you might want to associate your user with. You can map roles to a group as well. Users that become members of a group inherit the attributes and role mappings that group defines.

To associate a user to a group:

1. From the Users page, select the Groups tab.
2. Select a group from the Available Groups tree and click the Join button to add the user to a group. To remove the user, select a group from the Group Membership list and click Leave.

Note: If you go in the Groups page and consult the detail page for that group, you will see that the user list has been updated in the Members tab.
Viewing Sessions

Sessions are created when a user logs in. A session manages the login session and contains information like when the user logged in and what applications have participated within single-sign on during that session. Both admins and users can view session information.

To view the sessions:
From the Users page, select the Sessions tab.
Managing Groups

Groups allow you to manage a common set of attributes and role mappings for a set of users. Users can be members of zero or more groups. Users inherit the attributes and role mappings assigned to each group.

Groups are hierarchical. A group can have many subgroups, but a group can only have one parent. Subgroups inherit the attributes and role mappings from the parent. This applies to the user as well. So, if you have a parent group and a child group and a user that only belongs to the child group, the user inherits the attributes and role mappings of both the parent and child.

To create a group:

1. From the main window, select Groups.
2. If you want to add a parent group, click New
   OR
   If you want to add a child group, click on the parent you want to add a new child to and click New.
3. Enter a name for the group, then click Save.
Managing Users

Federating External User Databases

Any attributes and role mappings you define will be inherited by the groups and users that are members of this group. To add a user to a group you need to go back to the user detail page and click the Groups tab there. For more information, see page Associating a User to a Group on page 112.

Federating External User Databases

Users can federate existing external user databases with support for LDAP and Active Directory by using the User Storage SPI. Once you log in, the internal user store searches to find you. If you cannot be found, an iteration over every User Storage provider configured for the realm will be performed until a match is found.

Data from the external store is mapped into a common user model that is consumed by the runtime. This common user model can then be mapped to OIDC token claims and SAML assertion attributes.

To add a storage provider:

1. Click on User Federation in the left menu.

2. Click in the Add provider box and choose the desired provider. The configuration page of that provider will open.
Configuring an LDAP

The user management console comes with a built-in LDAP/AD provider. It is possible to federate multiple different LDAP servers in the same user realm where you can map LDAP user attributes into the common user model. By default, it maps user name, e-mail, first name, and last name, but you are free to configure additional mappings. The LDAP provider also supports password validation via LDAP/AD protocols and different storage, edit, and synchronization modes.

To configure the LDAP:

1. From the main window, select **User Federation** then select LDAP as the desired provider.

2. Enter the information as required:
   - **Console Display Name** is used when this provider is referenced in the admin console.
   - **Priority** denotes the priority of this provider when looking up users or for adding registrations.
   - **Edit Mode** allows users, through the User Account Service, and admins, through the Admin Console, to have the ability to modify user metadata. Depending on your setup you may or may not have LDAP update privileges. The Edit Mode configuration option defines the edit policy you have with User Documentation LDAP/AD Integration 314 in your LDAP store.

   **READ_ONLY** does not allow changes to username, email, first name, last name, and other mapped attributes. An error will be displayed anytime anybody tries to update these fields. Also, password updates will not be supported.

   **WRITABLE** allows for updates to username, email, first name, last name, other mapped attributes and passwords. All will be synchronized automatically with your LDAP store.
**Managing Users**

**Federating External User Databases**

**UNSYNCED** allows any changes to username, email, first name, last name, and passwords to be stored in the user local storage. It is up to you to figure out how to synchronize back to LDAP. This allows user deployments to support updates of user metadata on a read-only LDAP server. This option only applies when you are importing users from LDAP into the local user database.

**Sync Registrations** enables/disables your LDAP adding new users. Click **ON** if you want new users created in the admin console or the registration page to be added to LDAP.
Managing Users
Federating External User Databases

► **Allow Kerberos authentication** allows you to select ON/OFF for Kerberos/SPNEGO authentication in realm with users data provisioned from LDAP.

► **Sync Settings** allows you to sync all LDAP users into the user database, by configuring and enabling the following settings:

  **Batch Size** is the number of LDAP users to be imported from LDAP in a single transaction.

  **Periodic Full Sync** will synchronize all LDAP users when ON is selected. Those LDAP users, which already exist and were changed in LDAP directly will be updated.

  **Periodic Changed Users Sync** will update and/or import only those users that were created or updated after the last sync, when ON is selected.
Selecting a Storage Mode for LDAPs

By default, users from LDAP will be imported into the local user database. This copy of the user is either synchronized on demand, or through a periodic background task. The one exception to this is passwords. They are not imported and password validation is delegated to the LDAP server. The benefits to this approach is that all features will work, while any extra per-user data that is needed can be stored locally. This approach also reduces load on the LDAP server as uncached users are loaded from the user database the second time they are accessed. The only load your LDAP server will have is password validation. The downside is that when a user is first queried, this will require a user database insert. The import will also have to be synchronized with your LDAP server as needed.

Alternatively, you can choose not to import users into the user database. In this case, the common user model that the runtime uses is backed only by the LDAP server. This means that if LDAP doesn’t support a piece of data that a feature needs, that feature will not work. The benefit to this approach is that there is no overhead of importing and synchronizing a copy of the LDAP user into the user database.
Using the Host Web User Interface

You need to configure different settings from the Host Web UI before you can start working with your unit.

Accessing and Exiting the Host Web UI

The Host Web UI allows you to perform various operations on the host and companion of your unit.

For a complete list of supported Web browsers, see Supported Web Browsers on page 12.

The steps that you will need to follow to access the Web UI will depend on the type of connection that you have: computer connected locally to the unit, computer and unit connected to a same LAN, or computer and unit connected to a WAN or the Internet. In the latter case, you will need to connect your computer to the VPN and to retrieve the LogMeIn address of your unit before being able to connect to the Web UI.

To start the Host Web UI:

1. If you intend to connect to your unit via a WAN or the Internet, connect to the VPN (see Connecting to the VPN on page 79); otherwise, go directly to step 2.

2. From your computer, open a web browser.
3. In the address bar, type the appropriate information.
   - For a computer connected directly to the unit (front port), type https://169.254.10.10/HostWebUI
   - For LAN connection, type https://Rear_Port_IP_Address/HostWebUI
   - For WAN or Internet connection, type https://Unit_LogMeIn_Hamachi_Address/HostWebUI

**Note:** If you do not know the IP address of the rear Ethernet port, see Retrieving the IP Address of the Rear Ethernet Port (Host and Companion) on page 55.

**Note:** If you do not know the LogMeIn Hamachi address of your unit, see Connecting to the VPN on page 79.

4. When the application prompts you, enter Admin as the user name and Admin as the password, then click Log in to open the session.
**To exit the Host Web UI:**

Click **Log out** found under **admin** in the navigation bar.

---

**Viewing Host and Companion Information**

You can view the following information about your Fiber Guardian host and companion, from the Web UI:

<table>
<thead>
<tr>
<th>Unit</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>➤ Name and serial number of the host</td>
</tr>
<tr>
<td></td>
<td>➤ Address of the time server and the sync interval</td>
</tr>
<tr>
<td></td>
<td>➤ IPv4 and IPv6 configurations of the host network adapters</td>
</tr>
<tr>
<td>Companion</td>
<td>IPv4 and IPv6 configurations of the companion network adapters</td>
</tr>
</tbody>
</table>

**To view the host or companion information:**

1. Start the Host Web UI. For more information, see *Accessing and Exiting the Host Web UI* on page 121.

2. From the **Status** menu, select **System Information**.

3. Select either **Host Information** or **Companion Information**, depending on the type of information that you need to retrieve.
Configuring Network Settings

You can configure various network settings for the host and the companion. These settings include the host name, and the IP addresses of the rear adapter (IPv4 and IPv6). By default, the IP addresses of both the host and companion are assigned dynamically (automatically) by a DHCP server on your LAN. However, if you prefer, you can define your own static IP addresses.

**Note:** If you are not sure on how to proceed or need more information about the configuration, see with your network administrator.

**To configure the network settings:**

1. Start the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the Configuration menu, select Host.
3. Depending on the type of parameters that you wish to modify, under Host Settings or Companion Settings, select Network.

4. To modify the displayed information, click Edit.

5. Depending on your needs, go to the Rear adapter IPv4 configuration or Rear adapter IPv6 configuration section.
6. Configure the parameters as needed.

- If you want the system to automatically assign IP addresses for the rear adapter, ensure that the **DHCP enabled** and **Obtain DNS server automatically** check boxes are selected.

- If you prefer to define static IP addresses for the rear adapter, clear both the **DHCP enabled** and **Obtain DNS server automatically** check boxes, and set the extra parameters.

  **Note:** The **Obtain DNS server automatically** option and the related parameters are available for the host only.

7. Click **Apply** to confirm the changes.
Configuring the 3G/4G Settings

Once you have prepared your unit for wireless access, you are ready to configure the 3G/4G network settings via the Web UI. For more information on the preparation of your unit, see Preparing Your Unit for 3G/4G Access on page 59.

You can configure the unit to use a 3G/4G wireless network when the LAN is not available. To do so, you will need to specify an access point name (APN), a user name, and a password for the connection to the 3G/4G network.

**Note:** Not all service providers require a user name and a password to authorize the connection to the 3G/4G network.

By default, your unit is configured to connect automatically to the wireless network, but you can deactivate this feature if you prefer. You can also specify a maximum number of minutes during which the unit can remain connected to the wireless network.

You can also specify the type of security (authentication) that you want to use for the 3G/4G connection.

**Note:** If you need more information about the connection parameters or the configuration, see with your service provider.
To configure the 3G/4G settings:

1. Start the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Configuration menu, select Host.

3. Under Host Settings, select 3G/4G.

4. Click Edit.

5. Configure the parameters as needed.

6. Click Apply to confirm the changes.
Connecting as an NQMSfiber EMS Client (OTDR Mode Only)

TheEMS Serverconfiguration page is available from the Configuration > Host tab.

To configure theEMS Server:
1. ClickEMS Serverunder Northbound Settingsto open theEMS Serverpage.
   1a. Enter the IP address or host name for the server.
   1b. Enter the polling frequency number, measured in hours, from 0 to 720 (which is about a month). The default value is 24 hours.
   1c. Select a network topology value, either LAN (default) or Lowbandwidth.

2. ClickApplyto confirm your changes.
3. ClickTest Connectionto ping theHost Name. If successful, a confirmation popup appears.
4. Click **Start Synchronization** to call the EMS SOAP 'getRtuStatus'. If the EMS response is online and the RTU’s request for synchronization was sent, a confirmation popup appears.

Once a synchronization is done, a message displaying the date and time of the last successful synchronization is added. This text is updated with every successful synchronization and is removed when detaching from the EMS or changing the value of the Host Name.

5. Click **Recovery Configuration** to open a **Recovery** window. Type in the **Old Mac Address** and click **recover** to revert to the previous EMS parameters.

6. Click **Detach from EMS** to clear the RTU from all information about the EMS. All created users, EMS and LDAP configurations are deleted.

Error messages occur when the values for the host name or synchronization frequency are empty, or when trying to detach an RTU that was never synchronized to an EMS.
Configuring the E-Mail Server Settings

The e-mail configuration page is available from the Configuration > Host tab. Click E-Mail Server under Northbound Settings to open the following E-Mail Server page.

To configure the E-Mail Server settings:

1. Click Edit to set the following parameters:

   1a. **Server Address** is the IP or Host Name.
   1b. **Port** is the number value higher than 0.
   1c. **Server message type** is a fixed value of SMTP.
   1d. **Sender** is the e-mail address used to send messages.
Using the Host Web User Interface

Configuring SNMP

1e. If you enable the Authentication Required option, you can add the name of the user allowed to connect to the SMTP server and the corresponding password that you must confirm by entering a second time.

2. Click Apply to save changes once you are done.

Configuring SNMP

Simple Network Management Protocol (SNMP) is a set of protocols for managing complex networks. SNMP consists of the following:

- An SNMP manager
- An SNMP agent
- A database of management information
- Managed SNMP devices
- The network protocol

The SNMP manager provides an interface between a network manager and the management system. The SNMP agent provides an interface between the manager and the physical devices being managed. The agent sends a Trap when a specific event occurs.

You can use SNMP to run a test to check the health of a fiber. This test is called test on demand (TOD), as it can be run as per your requirement. TODs can be run on an RTU, using SNMP from a third-party SNMP manager or any third-party application.
To configure SNMP:

1. Click SNMP under Northbound Settings.

   OR

   In the case of a standalone unit, from the main menu, select Configuration > System Settings. Then, from the tree view, select Other Settings, then SNMP.

2. Click Edit.

3. Select the SNMP version.

4. For Version V3 (default), enter the following parameters:

   4a. User Name

   4b. SNMP Engine ID is read only.

   4c. Password
Using the Host Web User Interface

Configuring SNMP

4d. Authentication Algorithm for the password encryption type: MD5 or SHA.

4e. Encryption Password used for the data.

4f. Encryption Algorithm also used for the data: DES (default), AES, or 3DES.

5. For versions **V1** and **V2c**, enter the following parameters:

5a. The SNMP manager IP/Hostname can either be IPv4, IPv6, or the hostname of the SNMP listener. A port can also be set for the destination like this: 127.0.0.1:6001 or FG750777777:6002.

5b. The remote port is a numerical value only, over 0 and is by default 162.

6. Click **Apply** to save changes.
Configuring the Time Server Settings

You can configure time server settings of the host from the Host Web UI.

To configure the time server settings:

1. Start the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Configuration menu, click Host.

3. Click Time Server Settings.

4. To modify the displayed information, click Edit.

5. In the IP / Host address field, enter the IP address or the host address of the time server that you are using.

![Time server configuration](image)

**Note:** For your unit to be synchronized with a time server, ensure that you specify the address (or the name) of an NTP server that your unit can reach.

**Note:** A Fiber Guardian unit cannot be used as a time server.

6. From the Sync frequency list, select the time frame that the host should synchronize with the time server.

7. To confirm the changes, click Apply.
Forcing an RTU to Detach From the Link

You might need to detach an RTU from a link because there is a communication loss and you must detach it regardless.

**IMPORTANT**

If you detach the RTU from the link, you are also removing all configurations (optical routes, test setups, registration information, central authentication credentials) and results from the RTU-2. They will still be stored in FG-750 and you can apply them again, but new references will be acquired; use caution when detaching an RTU.

**IMPORTANT**

This feature is not available if the RTU is currently attaching.

**To force an RTU detach:**

1. Start the Host Web UI. For more information, see *Accessing and Exiting the Host Web UI* on page 121.

2. From the **Configuration** menu, click **Host**.
3. Under **Configure Host > Northbound Settings** select **Authority server**.

4. Enter the information for the address of the RTU you want to detach, then click **Force Detach From FMS**.
6 Setting Up Your RTU

Detecting the Fibers Connected to the Optical Ports

You must perform the detection of the optical ports in the following cases:

➤ when you install a new RTU.
➤ when you connect optical fibers to previously unused ports to activate testing (see Cleaning and Connecting Optical Fibers on page 91).

The RTU must first detect the fibers connected to the ports. It will automatically create the optical routes, test setups and test programs (for more information, see Managing Optical Routes on page 171).

Once the detection is completed, you can configure a remote switch (ROTAU) if you want. The RTU will only take into account (detect) ports to which fibers of at least 50 meters are connected.

Note: If there are issues with the configuration, the system will let you know and provide solutions to help you solve them.
Setting Up Your RTU
Detecting the Fibers Connected to the Optical Ports

To detect new ports:

1. From the main menu, select Configuration > Remote Test Unit.
2. Under OTAU, click Detect.

3. From the displayed dialog box, select a wavelength.

Note: The wavelength used to detect a series of ports will be used as the default monitoring test wavelength. You may therefore start monitoring on certain ports at a certain wavelength and on other ports with another wavelength.
4. Select the ports you want to use at this wavelength.

**Note:** *To quickly select or clear the check boxes, use respectively Select All and Unselect All.*

5. Click **Start** to start the automatic detection of the ports. The RTU will generate test setups for the new wavelengths.

6. Repeat the previous steps with other wavelengths and ports if necessary.

   The status of the ports (detected or not) is indicated in the **OTAU** section.

   You can now configure the remote switch, if you have one (see *Configuring a Remote Switch (ROTAU)* on page 146).

Once the manual detection of fiber ports is done there is a chance that ports remain undetected though the fiber is connected, these ports can be detected forcefully by selecting the force detection of fiber option.

**To force fiber detection:**

1. From the main menu, select **Configuration > Remote Test Unit**.

2. From the tree view, select the optical test head to which the optical routes are connected.

3. Under **OTAU**, click **Detect**.
4. From the displayed dialog box, select a wavelength.

5. Select the ports you want to use at this wavelength.

**Note:** To quickly select or clear the check boxes, use respectively Select All and Unselect All.

6. Check Force Detection and click Start to start the force detection of the ports.
7. The forcibly detected ports will be outlined in red.

8. You can configure the ROTAU with the force detected fibers.

9. As the force detection of fiber has been done because of the poor quality of the fiber, the end of fiber threshold may need to change manually to get test results.
Changing a Cassette

When a cassette change is detected in your RTU, you are automatically redirected to the **Optical Connections** assignment page. Here, a list of affected optical routes not linked to ports is displayed and must be reassigned to a *Not provisioned* port on the RTU, or deleted.

**Note:** *You cannot navigate elsewhere on the website (redirection) unless you take action on this page which is in edit mode.*

To assign a route to the new cassette:

1. From the new cassette layout, select a port by clicking on.

   1a. If the route's original port still exits on the new cassette layout, the same port is suggested under the **Action** column.

   1b. If the route's original port does not exist anymore, ![ ] is displayed, indicating that the route is unassigned and requires more information. All routes must be reassigned before you can resume monitoring. If some routes cannot be reassigned to a port, you must delete them.
2. When you click, a port selection window is displayed. Select a column and port number to assign the route.

3. Delete a route by clicking . All routes can be deleted at once by clicking the delete all button . This is useful if:
   ➤ You just want access again to the website to start over.
   ➤ There is a long list of routes to delete.
   ➤ You just want to keep some routes, for example delete all, then assign two or three routes.

4. Click Apply to confirm your selections.
Configuring a Remote Switch (ROTAU)

For more information on port configuration, see *Detecting the Fibers Connected to the Optical Ports* on page 139.

You can also remove a ROTAU if it is no longer used.

**To connect a ROTAU:**

1. Ensure that your ROTAU is connected as follows.

![Diagram of ROTAU connection](image)

2. From the main menu, select **Configuration > Remote Test Unit**.
To add a ROTAU:

1. Under **Controlled ROTAUs**, click the listed ROTAU to open the information page.
2. Click **Create Optical Routes** button to open a popup window.
3. Enter the ports for which you would like to create the routes.
To edit a ROTAU:

1. Under **Controlled ROTAUs**, click the listed ROTAU to open the information page.

2. Click the **Edit** button corresponding to the port to which the ROTAU is connected.
3. Set the parameters for the ROTAU.

The RTU will delete the optical route that was defined for the local port as well as its related test setups and test programs. It will also create optical routes and test setups (according to the system setting parameters) for each of the ROTAU’s ports.

If the ROTAU is not responding, an error message will appear. See Viewing the Event Log on page 261 for information about troubleshooting the error.

4. Click **Apply** to update the changes.

**Note:** There is no difference in ROTAU configuration with normal fiber detection and forced fiber detection.
Setting Up Your RTU
Configuring a Remote Switch (ROTAU)

To remove a ROTAU:

1. From the main menu, select Configuration > Remote Test Unit.

2. Under Controlled ROTAUs, click the Delete button corresponding to the port to which the ROTAU is connected.

3. When the application prompts you, click OK to confirm deletion.

Note: The RTU will delete the optical routes and test setups that were created for each of the ROTAU’s ports. It will create a single optical route (corresponding to the local port) and the related test setups (according to the system setting parameters).
Understanding ROTAU Statuses

The ROTAU status validation relies on two configuration items which are defined in system settings:

- ROTAU Polling time which periodically checks if each configured ROTAU is reachable. It is defined in seconds and its default value is 300 seconds.

- ROTAU Number of failed polls before alert is used as a threshold before sending an alarm. It is defined as a count and its default value is 3 successive failed polls.

Each ROTAU has one of the following states:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Details</th>
</tr>
</thead>
</table>
| ✔    | Operational | ➤ The configured IP Address is reachable.  
               | ➤ The linked OSC Port is provisioned.                                   |
| ❓    | Unreachable | ➤ The configured IP Address is unreachable.  
               | ➤ The ROTAU has just been created.                                    |
|      |           | ➤ The ROTAU IP Address has just been changed.                         |
| ❗    | Decoupled  | ➤ The linked OSC Port is not provisioned.  
               | ➤ The linked OSC Port is a virtual port.                               |

*Note:* When Decoupled, the port image is replaced by a red X.

A change in ROTAU status from Operational to Unreachable launches a system warning on the event when the number of failed polls, defined in the configuration, is reached. The minimum time an alert is launched is 15 minutes.
The status is displayed under **Controlled ROTAUs** for the selected ROTAU.

In the **Controlled ROTAUs** list, the status is also displayed.
Consolidated ROTAU Status

The Consolidated ROTAU status represents a global status of all configured ROTAUUs on the system. A ROTAU status is reported when at least 1 ROTAU status is changed. The consolidated status has one of the following states:

- **Normal**: all ROTAUUs are operational
- **Unreachable**: at least one ROTAU is unreachable
- **Decoupled**: at least one ROTAU is decoupled
- **Unreachable or Decoupled**: at least one ROTAU is decoupled and one is unreachable, or one ROTAU is decoupled and unreachable

**To view the Consolidated ROTAU Status:**

From the main menu, select **Status > System**.
Configuring Alert Notifications

Alerts are generated by e-mail when certain events occur and come in two formats:

- Short: a plain text message.
- Detailed: a detailed message in html format, including relevant OTDR traces as an attachment.

You can set which type of notification you want and which fault types will be included.

**To configure alert notifications:**
1. From the main menu select **Configuration > Alert Configuration**.
2. From the tree view, select desired e-mail type and click **Edit**.
3. Select the required options and click **Update** to apply the changes.

Managing Alert Types

The application can alert users when certain events, or combinations of events, occur. To generate the alerts, the application uses predefined templates called *alert types*.

The following alert types are created automatically at time of installation:

- Fiber fault
- System fault
- Fiber fault (for OSS/GIS system)
- Life signal

You can also create your own alert types. You can modify and delete any alert type, including those that were created at time of installation.

**Note:** You must be logged in as Admin user to be able to create, modify or delete alert types.
Managing Alert Types

Each of the alert types includes the following items:

- **Channel type**: format of the message that will be sent to the specified users when the application generates an alert. The channel type includes:
  - the short e-mail to send a brief message, in plain text.
  - the detailed e-mail to send complete information in html format with the OTDR trace in attachment.
  - the xml e-mail, like the detailed e-mail, is sent to the configured e-mail account of the user. The GIS system can use the physical route information from the xml mail present on the mail server to find the precise location of the fault. For more information, see *Managing Optical Routes* on page 171.
  - the SNMP to send alerts in the form of SNMP, trap.
  - the RTU can be set to send event data — change in the status of a fault, life signal of the RTU, errors, and warnings — to external applications as a JavaScript Object Notation (JSON) object through HTTP to the configured HTTP Post URL. The HTTP Post URL can be configured from the user page. For more information, see *Managing Users* on page 101.

- E-mail addresses of the people to whom the alert messages must be sent.

**IMPORTANT**

You must activate the alert types you intend to use. Otherwise, the application will not take them into account.
To view an alert type:

1. From the main menu, select Configuration > Alerting Types.
2. From the tree view, select the desired alert type.
To add alert types

1. From the main menu, select Configuration > Alerting Types.
2. From the tree view, click the icon that appears next to Alerting Types.

Note: If the SNMP channel type is selected, the machine address is displayed for the destination table.
3. Enter the parameters according to your needs.
4. Click Save to create the alert type.

**To modify alert types:**
1. From the main menu, select Configuration > Alerting Types.
2. From the tree view, select the alert type you want to modify.
3. Click Edit.
4. Modify the parameters according to your needs.
5. Click Apply to update changes.
To delete alert types:

1. From the main menu, select **Configuration > Alerting Types**.
2. From the tree view, select the alert type you want to delete.
3. Click **Delete**.
4. When the application prompts you, click **OK** to confirm deletion.
Managing System Setting Values

There are two types of default values: factory values (used when you need to revert to factory values) and current default values (used currently to operate the RTU).

The default values are grouped into categories:

➤ Optical route: to define the IOR (group index), RBS coefficient and helix factor that the RTU will use when it creates the optical routes. For more information on these parameters, see *Modifying Optical Routes* on page 173.

➤ Test setup: to define, for monitoring and proactive maintenance (two distinct sets of parameters), test settings such as resolution, acquisition type (automatic or manual), range, etc. and learning settings such as the targeted learning count, reset and expand parameters. For more information on these parameters, see *Managing Test Setups* on page 178).

➤ System: to define “global” parameters such as the number of test setups that will be created automatically, the way fiber breaks will be. You cannot modify factory default values.
To revert to factory default values for Default Settings:

1. From the main menu, select Configuration > System Settings.
2. From the tree view, select Default Settings.
3. Click Apply Factory Settings, then confirm your choice.
To revert to factory default values for Alert Configuration:

1. From the main menu, select Configuration > System Settings.
2. From the tree view, select Alert Configuration.
3. Click Apply Factory Alert Configuration, then confirm your choice.
Defining Default Helix Factor, IOR, and RBS Values

You can define the IOR (group index), RBS coefficient and helix factor that the RTU will use when it creates the optical routes.

- The *index of refraction* (IOR) value (also known as group index) is used to convert time-of-flight to distance. Having the proper IOR is crucial for all OTDR measurements associated with distance (event position, attenuation, section length, total length, etc.). IOR is provided by the cable or fiber manufacturer.

  The test application determines a default value for each wavelength. You can set the IOR value for each available wavelength.

- The *Rayleigh backscatter* (RBS) coefficient represents the amount of backscatter in a particular fiber. The RBS coefficient is used in the calculation of event loss and reflectance, and it can usually be obtained from the cable manufacturer.

  The test application determines a default value for each wavelength. You can set the RBS coefficient for each available wavelength.

- The *helix factor* takes into consideration the difference between the length of the cable and the length of the fiber inside the cable. Fibers within a cable are spiraling around the cable core. The helix factor describes the pitch of that spiral.

  By setting the helix factor, the length of the OTDR distance axis is always equivalent to the physical length of the cable (not the fiber).
To modify the current helix factor, IOR, or RBS values:

1. From the main menu, select Configuration > System Settings.

2. From the tree view,
   - For helix factor, select General.
     The parameters for helix factor are displayed.
   - For IOR and RBS, select IOR/RBS.
     The parameters for IOR and RBS are displayed.
Setting Up Your RTU
Managing System Setting Values

3. Click the **Edit** button appearing next to the parameter you want to modify.

4. Click **Apply** to update changes.

5. Repeat the previous steps with all the parameters you want to modify.

### Defining Default Values for Test Setups

You can define, for monitoring and proactive maintenance (two distinct sets of parameters), test settings such as resolution, acquisition type (automatic or manual), range, etc. and learning settings such as the targeted learning count, reset and expand parameters.

- **Resolution**: By selecting the high-resolution feature (“high”), you will obtain more data points per acquisition. This way, the data points will be closer to each other, which will result in a greater distance resolution for the trace.

- **Acquisition settings**: With automatic settings, the application will determine the most appropriate range, pulse width and duration for you. If you prefer to specify these values yourself when you define a test setup, you should select the manual settings.

- **Range**: Corresponds to the distance range of the fiber span to be tested, in kilometers.

- **Pulse width**: A longer pulse allows you to probe further along the fiber, but results in lower resolution. A shorter pulse width provides higher resolution, but less distance range.

- **Duration**: Corresponds to the acquisition duration (period during which results will be averaged). Generally, longer acquisition times generate cleaner traces (this is especially true with long-distance traces) because as the acquisition time increases, more of the noise is averaged out. This averaging increases the signal-to-noise ratio (SNR) and the OTDR’s ability to detect small events.
Setting Up Your RTU
Managing System Setting Values

➤ **Splice loss threshold**: Setting for detecting small non-reflective events during trace analysis and when establishing the test setup reference.

➤ **Reflectance threshold**: Setting for detecting small reflective events during trace analysis and when establishing the test setup reference.

➤ **End-of-fiber threshold**: Setting for detecting important event loss that could compromise signal transmission during trace analysis and when establishing the test setup reference.

➤ **Fault threshold settings**: The threshold set that will be used during tests. For more information, see *Managing Threshold Sets* on page 192.

To modify the default values for test setups:

1. From the main menu, select **Configuration > System Settings**.

2. From the tree view, select the set of settings you want to modify (Monitoring or Proactive Maintenance).

3. Click the **Edit** button appearing next to the parameter you want to modify.

4. Click **Apply** to update changes.

5. Repeat the previous steps with all the parameters you want to modify.
Defining Default Values for System Parameters

You can define “global” parameters such as the number of test setups that will be created automatically, the way fiber breaks will be managed, the maximum database size, etc.

► You can specify which data will be uploaded to the EMS server (not applicable when RTU is used in stand-alone mode).

The table below shows which information will be stored on RTU and uploaded to the server, in each case.

<table>
<thead>
<tr>
<th>Type of upload</th>
<th>Faults and data acquired during the first reference of the learning period</th>
<th>Data acquired with monitoring</th>
<th>Data acquired with Proactive maintenance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not attach trace file</td>
<td>Uploaded</td>
<td>Not stored</td>
<td>► Stored</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>► Uploaded</td>
</tr>
<tr>
<td>Attach trace file</td>
<td>Uploaded, along with .trc file</td>
<td>Not stored</td>
<td>► Stored</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>► Uploaded, along with .trc file</td>
</tr>
</tbody>
</table>

► Degraded fiber handling strategy, when enabled, skips an optical route if the fiber is degraded. The selection for this option is enabled, by default.

► The maximum number of fiber result entries is 5 000, by default. You can increase this number up to 100 000 entries. However, this maximum value will never be reached if the database size exceeds 80% of the maximum database size.
To modify the default values for system parameters:

1. From the main menu, select Configuration > System Settings.

2. From the tree view, select System.

3. Click the Edit button appearing next to the parameter you want to modify.

4. Click Apply to update changes.

5. Repeat the previous steps with all the parameters you want to modify.
Editing Test On Demand Default Parameters

The default input parameters for test on demand are listed on the Test On Demand screen.

To edit test on demand parameters:
1. From the main menu, select Configuration > System Settings.
2. From the tree view, select Default Settings > Test Setup.
3. Select Test On Demand.

The Test On Demand page lists the parameters with their Factory Setting values and Current Default values.

4. Click Edit corresponding to the parameter.
5. Enter the appropriate value.
6. Click Apply to update changes.
Operating Your RTU in OTDR Measuring Mode

Managing Optical Routes

By default, once the detection of the fibers (that are connected to the ports) is complete, the application creates the following items automatically:

▶ An optical route for each of the ports the RTU has detected, that is one per port to which a fiber is connected.

▶ Two default test setups for each route at the wavelengths selected during fiber detection. If you prefer, you can modify this behavior (see Managing System Setting Values on page 161).

▶ One test program for each of the test setup.

Each optical route can have one or more test setups and each test setup can have one or more test programs.

![Diagram of optical routes, test setups, and test programs]

- Optical routes created by the RTU
- Test setups associated with a specific route
- Test program associated with a specific test setup
Operating Your RTU in OTDR Measuring Mode

Managing Optical Routes

Even if the optical routes are created automatically by the RTU, you can view, modify, duplicate, and delete these routes.

From the optical routes window, you can:

- view, edit, copy, and delete routes (deleted routes can be re-created later by a new port detection).
- suspend or resume scheduled jobs on one or several routes.
- view, add, modify, and delete test setups (see Managing Test Setups on page 178).
- view, add, modify, and delete test programs (see Managing Test Programs on page 188).

Viewing Optical Routes

To view optical routes:
From the main menu, select Configuration > Remote Test Unit > Optical Routes.

The application lists all the optical routes that have been detected.

Status of the route:

Not configured: no jobs are scheduled
Active: at least one job is scheduled
Skipped (and the reason): even if jobs are scheduled, no test will be performed on this route
Modifying Optical Routes

The RTU creates the optical routes automatically with settings based on the defined default values. For more information on the parameters, see Managing System Setting Values on page 161.

➤ You can specify whether the link is made of dark or live fiber.
➤ You can modify the helix factor, the IOR, and RBS values.
➤ You can specify one or two additional IDs to your route (cable ID and tube, or fiber color) to complete the information about this route. It can also help documenting the start and finish sites of the route. This information is part of the xml e-mail that will be sent according to the alert rules that you have defined (see Managing Alert Types on page 155).
To modify optical routes:

1. From the main menu, select **Configuration > Remote Test Unit > Optical Routes**.

2. From **Optical Routes** tree view, select the optical route you want to modify.

3. Click **Edit**.

4. Set the parameters according to your needs.

5. Click **Apply** to update changes.
Deleting Optical Routes

You can “recover” deleted routes by performing a port detection (see Detecting the Fibers Connected to the Optical Ports on page 139).

To delete optical routes:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the Optical Routes tree view, select the optical route you want to delete.

3. Click Delete.

4. When the application prompts you, click OK to confirm deletion.
Managing Optical Routes

Copying Optical Routes

In the optical route view, you can duplicate the current optical route. The route copied will have exactly the same properties and test on the same port, but will not retain Test Setups and trace data. Also, the name generated will be the same name as the copied route but appended with - Copy.

To copy an optical route:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the Optical Routes tree view, select the optical route you want to copy.

3. Click Copy.

After copying, the optical route edit screen containing the copied route is listed in edit mode.
SUSPENDING OR RESUMING SCHEDULED JOBS ON OPTICAL ROUTES

To suspend or resume scheduled jobs:

1. From the main menu, select Configuration > Remote Test Unit. A list of Optical Routes is displayed.

2. Click Resume All or Suspend All depending on your needs.

OR

3. Select the specific optical routes for which you want to suspend or resume tests.

4. Click Suspend or Resume.

The route status will change accordingly.
Managing Test Setups

Test setups describe the method of analysis by defining wavelength, pulse settings, thresholds, reference data, etc. They contain one or more test programs.

Once the port detection is complete, the application creates three default test setups (that is, one per test type) for each of the detected optical routes:

- **Monitoring:** This type of test is ideal for a 24/7 surveillance of cable cuts or major degradation that affects QoS. In this case, reference, learning data, and optical fault trace results are stored in the EMS. Automatic test setup configuration for this type is 15 seconds as the target test time per port. It can be set at any other value. For this test setup, the test manager can select the fault detection threshold from three predefined alarming sensitivities: Coarse, Normal, or Sensitive.

- **Proactive Maintenance:** This type of test is ideal for running weekly or daily tests on a route to detect degradations that do not yet affect QoS. In case of proactive maintenance, all the results, including reference data, are stored into the EMS. This test detects faults and alerts when degradation level is above a specified set of fault detection thresholds. By default, the test time is 45 seconds and can be changed. Proactive maintenance is used for medium to long-term analysis of the network or to build historical trend results for the route automatically.

- **Test on Demand:** This type of test is conducted to check the health of fibers when required.
Managing Test Setups

You can view, add, modify, and delete test setups.

➢ There are three types of tests. If you select **Proactive maintenance**, the results of the tests will be saved.

➢ If you select **Monitoring**, the results will be saved only if they contain fault information.

➢ If you select **Test on Demand**, the **Server Data Upload** section and **Targeted count per cycle** field in the **Learning** section are disabled.

➢ You can select the high-resolution feature to obtain more data points per acquisition. This way, the data points will be closer to each other, which will result in a greater distance resolution for the trace.
You can either set the acquisition parameters (range, pulse, duration) yourself or let the application determine the most appropriate values. In the latter case, the application will automatically evaluate the best settings according to the fiber link currently connected to the unit.

To optimize event detection, you can set the following analysis detection thresholds:

- **Splice loss threshold (dB)**: To detect small non-reflective events during trace analysis.
- **Reflectance threshold (dB)**: To detect small reflective events during trace analysis.
- **End-of-Fiber threshold (dB)**: To detect important event loss that could compromise signal transmission during trace analysis.

If you select the **Extended mode (peak monitoring)** option, the application will search the “noisy” portion of the OTDR trace to detect strong reflective events (such as those caused by UPC connectors) and set the monitoring range up to this point. The reflective peak level will be used as an indicator for link loss between end of fiber (RBS) and this point.

**Note:** The application will take the option into account only if there is a significant reflective event located after the end of analysis.

You can set the fault detection thresholds. The application uses these thresholds when comparing the current measurement with reference trace to determine if there is a fault or not.
You can either select one of the predefined threshold sets (default or your own) or set the parameters manually. For information on how to create your own threshold sets, see *Managing Threshold Sets* on page 192.

If, after performing tests, you find that the fault detection is too sensitive, you can do one of the following:

- Select a less sensitive threshold set.
- Create a threshold set with custom values, and select it in the test setup. In this case, you will also need to perform a new reference.

You can specify which data will be uploaded to the EMS server (not applicable when RTU is used in stand-alone mode). For more information, see *Defining Default Values for System Parameters* on page 168.

*Normal* is selected by default, but you can set the application to use another option by default (see *Managing System Setting Values* on page 161).

- You can define parameters for the learning process.

A learning phase is a key provisioning function in NQMSfiber. This function provides information about the fiber under test. It creates a series of statistics on the stability of the link loss and every event of the fiber reference trace. Stable events or sections can then be monitored more closely. The less stable events, such as the very far end portion of the trace, are obtained from the system with the best possible fault detection thresholds. The learning process consists of at least one cycle during which the application will perform the specified number of acquisitions to establish the fault detection parameters (limits, mean value). These parameters take into account the environmental variations occurring on the fiber during the learning process. The first reference is created when you apply the changes from the RTU configuration window (gear icon).
Managing Test Setups

If a first reference has been created already, you can also create a new first reference using the renew feature. If you modify the acquisition or analysis parameters, the application will prompt you to perform a new reference. For more information, see Creating the Reference Traces on page 187.

During the tests, each result will be compared to those of the reference trace. You can specify the number of acquisitions that will be performed during a learning cycle.

You can also set the application to start new learning cycles when desired. The application can start the new cycle on a specific date or periodically (for example, every 2 weeks).

**Note:** *The application will only be able to start a new learning cycle if the previous one has at least started.*

You can even set the application to perform extra acquisitions when the learning cycle is complete (extend). The application can start the new acquisitions on a specific date or periodically until a certain number of acquisitions is reached. This maximum value corresponds to the number of acquisitions defined for a cycle plus the number of extra acquisitions.

The learning process will be performed only if at least one test program has been activated (enabled).
Operating Your RTU in OTDR Measuring Mode
Managing Test Sets

**To view test setups:**

1. From the main menu, select **Configuration > Remote Test Unit**.
2. From the tree view, select the **Optical Route** for which you want to view the test setups.

   **Status of test setup:**
   - **Ready for reference**: setup is complete, but reference has not been performed yet (see *Creating the Reference Traces* on page 187)
   - **Reference complete**: reference performed and waiting for the learning cycle to begin
   - **Learning**: learning cycle is underway
   - **Testing**: learning cycle is complete and tests are performed
   - **Invalid parameters**: wavelength or pulse is invalid for the test setup
   - **Configuration change**: reference should be renewed by the user. If the optical route is resumed, all test setups which have a configuration change status will be set back to their previous state (Learning, Testing, Referenced).

3. From the tree view, select **Test Sets**.

   The application lists all the existing test setups.
To add test setups:

1. From the main menu, select Configuration > Remote Test Unit.

2. From the tree view, select an Optical Route and click the icon that appears next to Test Setups.

3. Enter the parameters according to your needs.

4. Click Save to create the test setup.

The application creates a Test Programs branch under the new test setup automatically. You can add test programs from this branch.
To modify test setups:

1. From the main menu, select **Configuration** > **Remote Test Unit** > **Optical Routes**.

2. From the **Optical Routes** tree view, select the optical route you want to modify.

3. Select **Test Setups** and the test.

4. Click **Edit**.

5. Modify the parameters according to your needs. For more information on the various parameters, see *Managing Test Setups* on page 178.

6. Click **Apply** to update changes.
To delete test setups:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the Optical Routes tree view, select the optical route containing the test setup you want to delete.

3. Click Delete.

4. When the application prompts you, click OK to confirm deletion.

IMPORTANT

Except for default test setups that can be re-created by performing a new port detection, deleted test setups cannot be recovered. The associated test programs and results will be deleted as well.
Creating the Reference Traces

Before starting the learning process, the application must create the reference traces. They are created automatically just after a fiber detection, after a renew, and when a test setup is added or updated.

If you modify the acquisition or analysis parameters, the application will prompt you to perform a new reference. This reference will be independent from the previous one and a new learning process, based on this new reference, will also be scheduled. It is also possible to re-create a reference trace afterwards, if you have made a repair, for instance.

To re-create the reference trace for a specific test setup (acquisition and analysis settings unchanged):

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.
2. From the tree view, select the route containing the test setup for which you want to create a new reference.
3. Select Test Setsups and the test setup for which you want to create a new reference.
4. Click Renew.
Managing Test Programs

Test programs are part of test setups. They describe the start and end dates and periodicity of jobs, and this, either for continuous or scheduled monitoring, or periodic data acquisition (in proactive maintenance).

Once the port detection is complete, the application creates default test setups and test programs.

You can view, add, modify, and delete test programs. (Disabled when synchronized with an EMS.)

To view test programs:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the tree view, select the route containing the test setup for which you want to view the test programs.

3. Select Test Setups.

4. Then select the test for which you want to view the test programs, and select Test Programs.

The application lists all the existing test programs for the selected test setup.
To add test programs:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.
2. From the tree view, select the route containing the test setup for which you want to add test programs.
3. Select Test Sets.
4. Then select the test for which you want to add Test Programs.
5. Click the icon that appears next to Test Programs.
6. Enter the parameters according to your needs.
7. Click Save to create the test program.
Managing Test Programs

To modify test programs:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the tree view, select the route containing the test setup for which you want to modify test programs.

3. Expand the Test Setups branch and select the test setup for which you want to modify test programs.

4. Under Test Programs, select the item to modify.

5. Click Edit.

6. Modify the parameters according to your needs.

7. Click Apply to update changes.
Operating Your RTU in OTDR Measuring Mode

Managing Test Programs

To delete test programs:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the tree view, select the route containing the test setup for which you want to delete test programs.

3. Expand the Test Setups branch and select the test setup for which you want to delete test programs.

4. Under Test Programs, select the item to delete.

5. Click Delete.

6. When the application prompts you, click OK to confirm deletion.
Managing Threshold Sets

The RTU application comes with default threshold sets that you can use to define test setups. You can also create your own threshold sets, modify and delete them.

**Note:** You cannot modify or delete the default threshold sets.

**Note:** You must be logged in as Admin username to be able to create threshold sets.

If, after performing tests, you find that the fault detection is too sensitive, you can do one of the following:

- Select a less sensitive threshold set.
- Create a threshold set with custom values, and select it in the test setup. In this case, you will also need to perform a new reference.

**To view the threshold sets:**

1. From the main menu, select Configuration > Threshold Sets.
2. From tree view, select the threshold set you want to view.

**Note:** You can only add, modify and delete software packages when the RTU is used in stand-alone mode.
### Operating Your RTU in OTDR Measuring Mode

#### Managing Threshold Sets

**To add threshold sets:**

1. From the main menu, select **Configuration > Threshold Sets**.
2. From the tree view, click the icon that appears next to **Threshold Settings**.

   ![Threshold Set Name Interface](image)

   **Threshold set name (mandatory)**

3. Enter the parameters according to your needs.
4. Click **Save** to create the test setup.
Managing Threshold Sets

To modify threshold sets:

1. From the main menu, select Configuration > Threshold Sets.
2. From the tree view, select the threshold set you want to modify.
3. Click Edit.
4. Modify the parameters according to your needs.
5. Click Apply to update changes.
To delete threshold sets:

1. From the main menu, select **Configuration** > **Threshold Sets**.
2. From the tree view, select the threshold set you want to delete.
3. Click **Delete**.
4. When the application prompts you, click **OK** to confirm deletion.
Performing an Ad Hoc Test

An ad hoc test is a manual test where you select the test parameters. The ad hoc test is useful when you want to perform a standard OTDR test on a specific port that is not detected. Such a test is also useful when you install a new RTU to ensure acquisitions are performed normally. The test is performed immediately after you start it.

When the RTU is used within a system, ad hoc test results are stored in the database, but not transferred to the EMS server.

The ad hoc test acquisition settings can be automated, where the pulse and range are automatically calculated, or manually set, where you enter your own values.

You can select the high-resolution feature to obtain more data points per acquisition. This way, the data points will be closer to each other, which will result in a greater distance resolution for the trace.

**IMPORTANT**

EXFO does not recommend to test in high resolution if the acquisition time is less than 15 seconds. It may be impossible to obtain acceptable performance with this combination of settings.
To perform an ad hoc test:

1. From the main menu, select Manual Tests > Ad Hoc.
Operating Your RTU in OTDR Measuring Mode

Performing an Ad Hoc Test

2. Select an optical route in the **Select from existing routes** list. This option is available only if fiber detection has already been performed.

OR

Click **Define a route manually** and select a port from corresponding list.

---

Configuration | Status | Reporting | Manual Test | About | Logout
---|---|---|---|---|---
OTH | | | | | |
OTH: S/N:493240

**Optical Route**
- Select from existing routes
- OTH: P001
- Define a route manually

**Acquisition Settings**
- Automatic settings
- Wavelength: 1550.0 nm (B)
- Resolution: Normal
- Duration: 15 s
- Manual settings

**Optical Route Settings**
- IOR: 1.4553
- RDS: -31.87 dB/km
- Average hikz factor: 0.00 %

**Analysis Settings**
- Splice loss threshold: 0.02 dB
- Reflectance threshold: -72 dB
- End-of-fiber threshold: 4 dB

**Actions**
- Default
- Start
- Stop
3. Select the acquisition type. Depending on what you have selected, fill out the required values.
4. Select the optical route settings required for your test.
5. Enter the threshold values for your analysis.
Operating Your RTU in OTDR Measuring Mode

Performing an Ad Hoc Test

6. Click **Start Test**.

The application displays the results as soon as the test is complete.

To revert the test options to their default values:

1. On the **Manual Tests** menu, select **Ad Hoc**.

2. Click **Default**.
Performing a Test

You can perform a test for optical routes that the RTU has created. This type of test is performed on a specific test setup. It is similar to a test program, except that it is not “scheduled” at a later time.

Only the test setups for which a reference has been created can be used to perform a test. For information on references, see Creating the Reference Traces on page 187.

You can also start a test from the current fault list window (see Viewing the Current Fault List on page 227).
To perform a test:

1. From the main menu, select Configuration > Remote Test Unit > Optical Routes.

2. From the tree view, select the route containing the test setup you want to use for your test.

3. Select Test Setups and the test setup you want to use for your test.

4. Click Start Test.

The test is sent to the test queue, waiting to be performed.

Note: If there was a fault before you started the test, this fault will be cleared and re-created (fault status will be set as New) if it is still present.
Managing Degraded Fibers

The degraded fiber handling strategy feature allows you to capture unstable fiber conditions which were not captured on existing learning processes, such as a fast reflectance change, or a mechanical stress that can make loss to change on a minute or so time frame. If degradation (fluctuating link) is observed continuously in a test setup of an optical route, the link is skipped and no further tests are performed on it. This process reduces the number of fault sync requests and improves performance.

**Note:** The degraded fiber handling strategy can be disabled to capture fast transient conditions. It is recommended to enable it for higher performance and elimination of spurious faults (RTU) and alarms (EMS). The degraded fiber handling strategy applies to test setup of monitoring type only.

**To enable/disable degraded fiber handling strategy:**

1. From the main menu, select **Configuration > System Settings > Default Settings**.

2. From the tree view, select **System**.

3. Click **Edit** to enable or disable the degraded fiber handling strategy.
Enabling or disabling degraded fiber handling strategy from the EMS updates the factory settings on the RTU and not the individual current default for each RTU.

If the degraded fiber handling strategy is enabled on the RTU and a fault is in any of the following states on EMS: New, Still There, or Changed, then the optical routes are skipped and the alarm remains open on the EMS side.

If the fault is manually cleared from the RTU, the alarm will be resolved.

If the alarm is resolved from the EMS and the fault is still present, a new alarm is opened in the next planned synch.

**Note:** *The degraded fiber handling strategy settings should be changed on each RTU application.*

4. Click **Apply** to update the changes.
The fiber is classified as degraded under the following criteria:

**Criterion 1**: Three jobs are observed. The link is disabled if any of the following conditions are satisfied:

- There are two new jobs and one cleared job.

- Three consecutive jobs bear the changed state.
Criterion 2: If Criterion 1 is not satisfied, then ten jobs are observed. The link is disabled if any of the following conditions are satisfied:

- There are three or more new jobs over ten jobs.
- The state of more than three job has changed.
Operating Your RTU in OTDR Measuring Mode

Managing Degraded Fibers

If any of the above criterion is satisfied, the status of the optical route is changed to Skipped due to degraded fiber on the Configuration > Optical Routes page and no tests are performed.
Viewing Current and Scheduled Jobs

The test queue allows you to view the test that is underway, the scheduled jobs, the references, and the tests on demand that are waiting to be performed. You can view all of the jobs or only those associated with a specific test setup.

To view current and scheduled jobs:
1. From the main menu, select Status > Test Queue.
2. If you want to narrow down your search, from the tree view, select the desired test setup.
3. Click the tab corresponding to the type of jobs for which you want to see the status.
Configuring the Notification Agent

The Notification Agent is an application that you can install on any computer that can “view” the RTUs, which usually means that the computer and RTUs are connected to the same network. It monitors one or several RTUs and warns you whenever faults are detected.

From the Notification Agent, you can switch directly to the RTU login window to access the RTU Web application. Once you are connected to the RTU application, the list of recent faults is automatically displayed, allowing you to retrieve some more information about the detected faults.

You can specify the frequency (in seconds) at which the Notification Agent communicates with the monitored RTUs to retrieve the number of faults. You can also specify for how long the notification messages should be displayed.

**IMPORTANT**

By exiting the application (from the File menu or with the [x]), the Notification Agent will stop monitoring the listed RTUs.

Before proceeding with the Notification Agent, ensure that it has been installed on your computer. For more information on the installation, see *Installing the Notification Agent on Your Computer* on page 94.
To add an RTU to the list of monitored units:

1. If necessary, from the computer’s desktop, double-click the icon to open the Notification Agent.

2. In the RTU IP address box, enter the IP address of the RTU to be monitored.

3. Click Add. The application will verify the connection with the RTU.

4. When the application displays a message indicating that the diagnostic was completed successfully, click OK.

The RTU will now be monitored automatically.
To remove an RTU from the list of monitored units:

1. Right-click the row corresponding to the RTU to be removed.

2. Click Delete.

IMPORTANT

Once you click Delete, the RTU is removed from the list without any further confirmation or warning.
To switch to the RTU application for more information about the detected faults:

1. Double-click the row corresponding to the RTU for which faults have been detected.

![Icon in the title bar and in the Windows status bar turns to red to indicate that faults have been detected](image)

**Note:** You can also double-click any notification message while it is displayed to open the RTU logon window.

2. When the RTU logon window is displayed, enter your user name and password.
To adjust the monitoring and notification parameters:

1. From the **File** menu, select **Settings**.

2. Use the sliders to adjust the monitoring and notification parameters to your needs.

3. Click **OK** to confirm the changes.
Managing Cable Templates

The cable templates feature is particularly useful if you want to test many fibers that are all part of a same cable, using the same parameters. Instead of having to define test setups and test programs on each of the optical routes with the desired parameters, you can simply define one template per wavelength.

The application will schedule the tests automatically according to the parameters that you have set.

You can retrieve all the results acquired with a cable template at the same time and export them if desired.

Once you have modified the acquisition or analysis parameters, the application will prompt you to perform a new reference. This reference measurement will be performed on each of the selected ports with the defined parameters. As long as the reference has not been performed, the template will not be used.

You can view, add, copy, modify and delete templates.
Viewing Cable Templates

You can view all the cable templates that have already been defined.

To view cable templates

From the main menu, select Configuration > Cable Templates.

The application lists all the cable templates that have been defined.
Adding Cable Templates

For each template, you have to specify the following items:

➢ Tolerance between events, in meters (for fibers to be considered as identical).

➢ Optical routes on which the tests will be performed.

➢ Parameters related to the test setup (see Managing Test Setups on page 178).
  ➢ You can specify only one wavelength per template.
  ➢ The provided values correspond to the default values associated with the proactive maintenance test setup (see Defining Default Values for Test Setups on page 166).

➢ Parameters related to the test program (see Managing Test Programs on page 188).

If you modify the acquisition or analysis parameters, the application will prompt you to perform a reference. For more information, see Creating the Reference Traces on page 187.
To add cable templates:

1. From the main menu, select **Configuration > Cable Templates**.

2. From the tree view, click the + icon that appears next to **Cable Templates**.

3. Enter the general parameters according to your needs.

4. Specify the optical routes that you want to include in the cable template.
5. Define the test setup parameters as follows:

5a. Select the Test Setup tab.

5b. Enter the parameters according to your needs.

**IMPORTANT**

EXFO does not recommend to test in high resolution if the acquisition time is less than 15 seconds. It may be impossible to obtain acceptable performance with this combination of settings.
6. Define the test program parameters as follows:

   6a. Select the **Test Program** tab.

   6b. Enter the parameters according to your needs.

7. Click **Apply** to create the cable template.
Modifying Cable Templates

You can enable or disable a specific template, modify the target learning count value and the parameters related to the test program (time and frequency at which the test will be performed). For any other parameter (wavelength, optical route, etc.), you will have to build a new template.

To modify cable templates:
1. From the main menu, select Configuration > Cable Templates.
2. From the tree view, select the cable template that you want to modify.
3. Click Edit.
4. Modify the parameters according to your needs.
5. Click Apply to apply changes.
Copying Cable Templates

To speed up the creation of cable templates, you can duplicate existing templates and only have to modify a few parameters.

If you modify the acquisition or analysis parameters, the application will prompt you to perform a reference. For more information, see *Creating the Reference Traces* on page 187.

**To copy cable templates:**

1. From the main menu, select **Configuration > Cable Templates**.

2. From the tree view, select the cable template that you want to duplicate.

3. Click **Clone**.

4. Modify the parameters according to your needs.

5. Click **Save** to apply changes.
Deleting Cable Templates

You can delete cable templates at any time.

To delete cable templates:

1. From the main menu, select Configuration > Cable Templates.
2. From the tree view, select the template you want to delete.
3. Click Delete.
4. When the application prompts you, click OK to confirm deletion.
Exporting Cable Template Results

You can either view the cable template results in Microsoft Excel or save them in a .csv format. This could be useful if you prefer to work with raw data and build your own reports.

By default, the start date corresponds to the date on which the first measurement has been performed. Similarly, the end date corresponds to the date on which the last measurement has been performed.

To export cable templates results:

1. From the main menu, select Configuration > Cable Templates.
2. From the tree view, select the template for which you want to export the results.
3. Click Export.

4. If you wish to limit the results to a specific period of time, from the displayed dialog box, specify the start and end dates using the buttons.

5. When the application prompts you, you can either open the results directly in Microsoft Excel or save them.
8 Analyzing Results

The RTU application is a Web interface for accessing each RTU directly using a Web browser. The RTU application can provide access to each RTU locally via a LAN, or remotely via a dialup connection.

Viewing the Current Fault List

By default, the current fault list is displayed when you start the RTU application.

You can export the list of faults, clear faults and start a test (test on demand) from the current fault list window (see Viewing, Exporting and Clearing Faults on page 228).

For each of the faults, you can view the corresponding OTDR trace and characterization table for advanced analysis (see Analyzing the OTDR Trace and Characterization Table on page 229).
Viewing, Exporting and Clearing Faults

You can export the list of faults to a .csv (comma separated values) file and clear faults from the current fault list window.

**To view the current fault list:**

From the main menu, select **Status > Current Faults**.

A summary of the current faults is displayed.

To export the list of *all* recent faults to a .csv file

To clear (remove) the selected faults

To start tests using the test setups for which the selected faults occurred (equivalent to performing a test on demand on the route whose test setup created the event)
Analyzing the OTDR Trace and Characterization Table

If you are an experienced user, you will find the Trace Viewer particularly useful. With this utility, you can make a complementary analysis of the optical fiber link. By comparing the current OTDR measurement to the four other results provided (reference, minimum, maximum, and average), you may be able to give a more complete evaluation of the optical link’s state than what the application achieves by itself.

➤ The reference corresponds to the OTDR measurement that was made the very first time the test setup was run. The analysis of this first OTDR measurement determined the structure of the event characterization table that is associated to the test setup.

➤ During the learning period, many measurements are made on the test setup. At each distance position of the OTDR measurement, the application keeps the minimum value measured. The $Min$ trace corresponds to a “reconstruction” of an OTDR measurement, using the minimum value measured at each distance position.

➤ In a very similar way, the $Max$ trace displays a “reconstruction” of an OTDR measurement, using the maximum value measured at each distance position.

➤ Finally, during the learning period, at each distance position of the OTDR measurement, the application keeps the average value. The $Avg$ trace corresponds to a “reconstruction” of an OTDR measurement, using the average value calculated at each distance position.
Analyzing Results

Viewing the Current Fault List

You can zoom in on a specific portion of the graph. You can also quickly return to the complete graph view.

You can save (export) the OTDR trace in native .trc format. You will be able to open the trace with applications that support this format of file, such as EXFO’s FastReporter.

You can also either view the characterization table in Microsoft Excel or save it in a .csv format. This could be useful if you prefer to work with raw data and build your own reports.

**To view the OTDR trace and the characterization table:**

1. From the main menu, select **Status > Current Faults**.

2. On the row corresponding to the fault for which you want to view the OTDR graph and event table, click the graph icon.

The application displays the OTDR graph and the characterization table.
Analyzing Results

Viewing the Current Fault List

To export the characterization table:

Click the Export Characterization Table button. When the application prompts you, you can either open the table directly in Microsoft Excel or save it.
To export the OTDR trace:

1. From the list of trace types, select the desired trace.

2. Click the Export Trace button.

The File Download dialog box is displayed.
Analyzing Results

Viewing the Current Fault List

3. Click Find to search for an appropriate program online to open the .trc file.

   OR

   Click Open to open the .trc file.

   OR

   Click Save to save the .trc file.

   To zoom in on a specific area of the trace:
   1. In the Start and End boxes, enter the desired values, in kilometers.
   2. Click the Zoom button.

   To revert to the complete graph view:
   Click the 1:1 button.
Searching and Displaying OTDR Results

The result browser allows you to search the OTDR results, then view them directly or save them for future reference.

You can search among all the available results or narrow down your search to a specific test setup. You can also filter the results by type (ad hoc tests, references, etc.) and by date.

You can save (export) the OTDR trace in native .trc format. You will be able to open the trace with applications that support this format of file, such as EXFO’s FastReporter.

You can also save both the results table and the data points of the OTDR trace (x and y coordinates) in a .csv format. This is useful if you prefer to work with raw data and build your own reports.
To search OTDR results:

1. From the main menu, select **Reporting > Result Browser**.

2. If you want to narrow down your search to a specific test setup, from the tree view, select the desired test setup. If you do not select any, the search will be performed on all of them.
3. Select which type of results you want to include in your search by selecting the corresponding options.

4. If you wish to limit the search to specific dates and time, use the From and To boxes. The date in the From and To boxes is in MM/DD/YYYY format (you can also select a date using the calendar button) and the time format is HH:MM in 24-hour format.

5. Click Search.

6. Once your search is completed, locate the result you wish to view and click on it.
7. If you wish to export the trace or the characterization table at this point, click the corresponding button.

8. Select whether you want to view directly the file, or save it. If you select the latter, indicate the location where you want to save the file.
Search Results for Test On Demand

The search results for Test on demand are displayed:

- When you are using a physical RTU.
- When test type is selected as Test on demand.

Note: For the search results of Test on demand, RTU may or may not be in sync with EMS.

To view the search result:

1. From the main menu, select Reporting > Result Browser.
2. In the Search Options section, select the Test on demand check box.
   OR
   Select the Search by dates check box.
3. If you select the Search by dates check box, enter the date and time range in the Start date, Start time, End date, and End time fields.
4. Click Search.

5. The search results display the following details: **Date/Time, Optical Route/Test Setup, Type, Ports, Test Information, Learning, and Fault Status.**

6. Click the Details icon. The Trace and Event list screen displays the Test Properties, Result Properties, and Fault Properties sections.

**Note:** During search results, if any fault is detected, it is listed under **Fault Properties.** If no fault is detected, then the results are displayed under **Test Properties and Result Properties.**
Analyzing Results

Search Results for Test On Demand

- Trace and Event list with **Test Properties** and **Result Properties** sections.

![Trace and Event List]

<table>
<thead>
<tr>
<th>Event Characterization Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Distance (km)</td>
</tr>
<tr>
<td>Length (km)</td>
</tr>
<tr>
<td>Loss (dB)</td>
</tr>
<tr>
<td>Attenuation (dB/km)</td>
</tr>
<tr>
<td>Reflection (dB)</td>
</tr>
<tr>
<td>Reflective Peak (dB)</td>
</tr>
<tr>
<td>Cumulative Loss (dB)</td>
</tr>
<tr>
<td>Curve Level (dB)</td>
</tr>
<tr>
<td>Loss (dB)</td>
</tr>
<tr>
<td>Attenuation (dB/km)</td>
</tr>
<tr>
<td>Reflection (dB)</td>
</tr>
<tr>
<td>Reflective Peak (dB)</td>
</tr>
<tr>
<td>Cumulative Loss (dB)</td>
</tr>
</tbody>
</table>

![Test Properties and Result Properties]

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength (μm)</td>
<td>1500</td>
<td>Actual range (km)</td>
<td>1.0</td>
</tr>
<tr>
<td>Auto settings</td>
<td>No</td>
<td>Actual pulse (ns)</td>
<td>2.5</td>
</tr>
<tr>
<td>Range (km)</td>
<td>100.9</td>
<td>Actual duration (μs)</td>
<td>15</td>
</tr>
<tr>
<td>Pulse (μs)</td>
<td>2.5</td>
<td>Extended range (km)</td>
<td>84.999</td>
</tr>
<tr>
<td>Duration (μs)</td>
<td>15</td>
<td>RMS range (μm)</td>
<td>84.999</td>
</tr>
<tr>
<td>Resolution</td>
<td>Normal</td>
<td>Resolution (μm)</td>
<td>5.1044145</td>
</tr>
<tr>
<td>Fiber code</td>
<td>B</td>
<td>Expected injection (dB)</td>
<td>27.737</td>
</tr>
<tr>
<td>Average fiber factor (%)</td>
<td>0</td>
<td>Minimum injection (dB)</td>
<td>33.737</td>
</tr>
<tr>
<td>LOC</td>
<td>1400</td>
<td>Maximum injection (dB)</td>
<td>70.737</td>
</tr>
<tr>
<td>SBS (dB/μs)</td>
<td>-01.87</td>
<td>Learning cycle</td>
<td>1</td>
</tr>
<tr>
<td>Splice loss threshold (dB)</td>
<td>0.02</td>
<td>Reference learning cycle</td>
<td>1</td>
</tr>
<tr>
<td>Reflection threshold (dB)</td>
<td>-72</td>
<td>Learning count</td>
<td>29</td>
</tr>
<tr>
<td>End of fiber threshold (dB)</td>
<td>4</td>
<td>Reference learning count</td>
<td>1</td>
</tr>
<tr>
<td>Targeted learning count</td>
<td>30</td>
<td>Type</td>
<td>Monitoring</td>
</tr>
</tbody>
</table>

240 FG-750
Analyzing Results

Search Results for Test On Demand

- Trace and Event list with **Test Properties**, **Result Properties**, and **Fault Properties** sections.
9 Using the Line Configuration Web User Interface

The Line Configuration Web UI is a tool used to create test lines (network logic with name or ID) corresponding to a test port number based on the unit optical switching configuration and number of ports available. It also allows continuity checks between the OTDR and switch ports, ensuring both communication and optical connections are present and working. The Web interface automatically detects if you have an OTDR, OTAUs, allows you to add remote OTAUs, and enables you to name the connections (lines) accordingly. The Line Configuration UI is available only in iOLM/Link-Aware™ mode.

The date and time in the header of the application are updated every minute. The format used is yyyy-MM-dd hh:mm (UTC +- hh:mm).

Accessing the Line Configuration Web UI

You can access the application directly from the Actions > Applications menu of the Host Web UI.

Note: If you access the Line Configuration directly from the Host Web UI, you do not need to reenter your login credentials.

You can also access the application directly from a Web browser and swap the enabled software with Host Web UI.
To connect directly using a Web Browser:

1. From your computer, open a Web browser.

2. In the address bar, type the appropriate information.
   - Computer connected directly to the unit (front port), type //169.254.10.10/LineConfiguration
   - For LAN connection, type https://Rear_Prot_IP_Address/LineConfiguration
   - For WAN or Internet connection, type https://Unit_LogMeIn_Hamachi_Address/LineConfiguration

Note: If you do not know the IP address of the rear Ethernet port, see Retrieving the IP Address of the Rear Ethernet Port (Host and Companion) on page 55.

Note: If you do not know the LogMeIn Hamachi address of your unit, see Preparing to Access Your Unit via a WAN or the Internet on page 69.

For information about the supported browsers for your application, see Supported Web Browsers on page 12.
Using the Line Configuration Web User Interface

Accessing the Line Configuration Web UI

3. Once you have accessed the application, use your Host Web UI credentials to log in.

For more information about login credentials for your applications, see Understanding Applications, User Accounts and Passwords on page 96.

**To log out:**

Click the **Logout** button on the top right corner of the window.
Using the Line Configuration Web User Interface

Accessing the Line Configuration Web UI

The main configuration window is where you can manage lines and hardware components for your system (OTDR, OTAUs and remote OTAUs). The application automatically detects if you have an OTDR and internal switches (OTAU), and retrieves the relevant information on-screen. Remote OTAUs are added and managed by the user, and the related settings are saved in the configuration file.

To access the main window:
Select the Configuration menu, then Ports and Line Management. In the tree view, you can see the items below:

- **FG-750 Hardware** is used to manage OTAUs and Remote OTAUs.
- **Line Management** is to manage ports and lines. This is also where you can view the injection loss test results for your lines.
Managing Remote OTAUs

Remote OTAUs are external switches that you connect to your system to add ports.

To add a Remote OTAU:

1. From the FG-750 Hardware section, under Remote OTAUs, click + Add.
Managing Remote OTAU

2. Enter the information for your new Remote OTAU.

The OTAU ID is limited to 30 characters and is case-sensitive.

The Add button will become active when you have added a valid IP address. However, the reachability of the address is not tested until you run an injection loss test. See Performing an Injection Loss Test on page 256 for more information.
The input signal selections include the available switches in the network.

The input port is limited to 20 alphanumerical characters.

**Note:** If the switch is an FG-750, the port name is usually the slot the switch module is in, and the port, separated by a comma. For example if your switch is in slot C, and you are using the second port, then the port name will be C,2. If the switch is an external model (576-port and 720-port Node OTAUs, identified as “Sumitomo”), then the port will be only the corresponding number.

Two switch models are supported: FG-750EX and Node OTAU (Sumitomo).

The communication port is a numeric value ranging from 1 to 65535.

3. Click **Add** to add the Remote OTAU.
To edit an existing Remote OTAU entry:

1. From the FG-750 Hardware section, click the pencil button next to the Remote OTAU that you want to modify.

2. Change the information as needed. Only the OTAU ID, IP address and Communication port information can be changed at this point.

3. Click Update once your changes are complete.
To delete a Remote OTAU from the list:

1. From the **FG-750 Hardware** section, select the Remote OTAU or OTAU(s) that you want to delete.

**IMPORTANT**
Deleting the selected remote OTAU(s) will also delete all associated lines and cascaded remote OTAU(s).

2. Click the **Delete** button.

3. Confirm your choice.
Managing Ports and Lines

You can simply add, edit or delete lines from the Line Management window. By default, the list is empty (no line “pre-configured”).

To add a line:

1. From the tree view, select Line Management, then click .
2. Enter the identification information for the new line, and associated port.

- The Line ID will be checked for uniqueness and is case sensitive. The maximum length is 50 characters. An automatically generated name is proposed, with an incrementation to avoid overwrites.

- If the line is to be matched to a switch port, select the switch in the list of available choices. If no switches are available, you can only select the OTDR. In the case of cascading switches, select the last switch in the link to match the line and port.

- Once the switch is selected, you can select the port you want to associate to the line. The maximum length is 50 characters, and the name is case sensitive. If you only have an OTDR in your system, this field is disabled.

**Note:** If the switch is an FG-750, the port name is usually the slot the switch module is in, and the port, separated by a comma. For example if your switch is in slot C, and you are using the second port, then the port name will be C,2. If the switch is an external model (Node OTAU, identified as “Sumitomo”), then the port will be only the corresponding number.

3. Click **Add** to add the line.
To edit a line:
1. From the tree view, select **Line Management**, then click the ![pencil](image) button next to the line that you want to modify.

2. Change the information as needed.

**Note:** The switch ID item is not available in edit mode.

3. Click **Update** to confirm your changes.
To delete a line:

1. From the tree view, select **Line Management**, then select the line or lines that you want to delete.

2. Click the **Delete** button.

3. Confirm your choice.
Performing an Injection Loss Test

The injection loss test is used to confirm that your switches are properly connected. The test can be performed on one or several ports at a same time.

IMPORTANT
The injection lost test results are not persistent. They will be erased if you exit the application, or refresh your window.

To perform an injection loss test:
1. From the **Line Management** section, select which lines you want to test. To quickly select or deselect all entries, use the check box in the list header.

2. Click **Test Selected Ports**.
3. Once the test is complete, you can view individual, detailed results by clicking **Show Result** in the line that you want to view. If there was a problem with the line, the **Diagnostic** section provides details to help with the troubleshooting.

4. Once you are done viewing the details, click **Close Window**.
Managing Configurations

Configuration files can be particularly useful when you want to reuse information and have uniform testing over your units. The file is in XML format and can be modified or updated even if you are not directly on the unit.

Manually saving your configuration files is strongly recommended to ensure the safekeeping of your setups in case of problems.

To export, or save, a configuration:

1. From the main window, select the Configuration menu, then Export Configuration.

2. Select Save, then select the location for the file.

3. The default name for the file is Line_Configuration_ddMMMyy.xml. Change the name if required.

   Note: In the file name, dd stands for day, MMM for month, and yy for year. For example, a file name could be Line_Configuration_10Dec12.xml.

4. Click Save to complete the export.
To import, or load, a configuration file:

1. From the main window, select the **Configuration** menu, then **Import Configuration**.

2. Locate the XML file that you want to use as the configuration.

3. Click **Open**.

The page is refreshed automatically to reflect this new configuration file. If the XML provided by the configuration file is not compliant with a supported configuration format, you will be notified.
10 Working With the Event Log

From the Host Web UI, you can:

- View a log of all the events that occur on the host or companion, including measurement entries.
- Customize your view of the logs.
- Apply filters to refine the log view.
- Export logs to an XML file.

Viewing the Event Log

You can view a log of the events that occur on the host or companion, such as the OTDR measurements, software updates, problems, etc.

To view the event log:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Reports menu, click Event Log.

3. Click the calendar icons and the time drop-down menus in the From and To boxes to select the time period for which you want to view the log of events.

4. Click Refresh.

The application displays a list of all the events from the selected time period. The Total Logs value indicates the number of entries found to a maximum of 2000 at a time.
Customizing the Log View

The Event Log page also displays the following columns:

► Event Source is the Fibre Guardian Host/App.

► Description displays detailed information about the event.

► Event Type can be log entries displaying information, warnings, or errors.

► Date and Time allows you to select a time period for the event logs.

You can customize the Host Web UI to display or hide these columns.

To customize the log view:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Reports menu, click Event Log.

3. Click any of the column names to display a drop-down menu.

4. From the drop-down menu, go to Columns.

5. From the Columns menu, clear the check boxes corresponding to the columns that you want to hide.

   Select the check boxes of the columns that you want to display.
Applying and Clearing Filters

You can further customize the log view by applying the filters on the **Event Log** page. Selecting the corresponding check box enables a filter and clearing the check box disables that particular filter. Multiple filters can be enabled at the same time. Filter data is displayed in the **Description** and **Event Type** columns. Available filters are as follow:

- **Information** displays a list of all the information log entries for the selected time period.
- **Warnings** display a list of all the warning log entries for the selected time period.
- **Errors** display a list of all the error log entries for the selected time period.
- **Communication errors with the server** display log entries only for the OTDR measurements.

In addition to choosing which columns to display, the following 2 columns also display the following filters:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Available Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Source</td>
<td>Fiber Guardian App</td>
<td>Displays log entries only from the companion.</td>
</tr>
<tr>
<td></td>
<td>Fiber Guardian Host</td>
<td>Displays log entries only from the host.</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Before</td>
<td>Displays a list log entries (if any) for a time period before the selected date.</td>
</tr>
<tr>
<td></td>
<td>After</td>
<td>Displays a list log entries (if any) for a time period after the selected date.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Displays a list log entries (if any) for the time period selected.</td>
</tr>
</tbody>
</table>
To apply filters to the Event Source or Date and Time columns:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Reports menu, click Event Log.

3. If you want to apply filters on the type of source:
   
   3a. Click the Event Source column.
   
   3b. From the Event Source drop-down menu, click Filters.
   
   3c. From the Filters menu, select the desired criteria.

4. If you want to apply filters on the time period of the event:
   
   4a. Click the Date and Time column.
   
   4b. From the Date and Time drop-down menu, click Filters.
   
   4c. From the Filters menu, select the desired criteria.

5. Click Refresh.

To clear all the currently applied filters:

1. Go to Reports > Event Log.

2. Click Clear Filters.
Exporting Log Reports

If you wish, you can export a log report to an XML file.

To export a log report:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Reports menu, click Event Log.

3. Select the time period and the appropriate filter to view the log that you want to export.

4. Click Export XML to export the displayed log to an XML file.
11 Maintenance

To help ensure long, trouble-free operation:

➤ Always inspect fiber-optic connectors before using them and clean them if necessary.

➤ Keep the unit free of dust.

➤ Clean the unit casing and front panel with a cloth slightly dampened with water.

➤ Store unit at room temperature in a clean and dry area. Keep the unit out of direct sunlight.

➤ Avoid high humidity or significant temperature fluctuations.

➤ Avoid unnecessary shocks and vibrations.

➤ If any liquids are spilled on or into the unit, turn off the power immediately, disconnect from any external power source, remove the batteries and let the unit dry completely.

WARNING

The use of controls, adjustments and procedures, namely for operation and maintenance, other than those specified herein may result in hazardous radiation exposure or impair the protection provided by this unit.
Cleaning Switchable Connectors

Regular cleaning of switchable connectors will help maintain optimum performance. There is no need to disassemble the unit.

**IMPORTANT**
If any damage occurs to internal connectors, the module casing will have to be opened and a new calibration will be required.

**WARNING**
Before cleaning the connectors, you should suspend the tests on all optical routes to avoid hazardous radiation exposure. Refer to the procedure below for instructions.

**To suspend the tests on all optical routes:**

1. Log in on the RTU application if you have not already done so.
2. From the main menu, select **Configuration > Optical Routes**.
3. Click **Suspend All**. The route status will change to **Skipped**.
To clean switchable connectors:

1. Use a small Phillips screwdriver to remove the two screws on the connector and expose the connector baseplate and ferrule.

2. Moisten a 2.5 mm cleaning tip with *one drop* of optical-grade liquid cleaner.
3. Slowly insert the cleaning tip into the adapter until it comes out on the other side (a slow clockwise rotating movement may help).

4. Gently turn the cleaning tip one full turn, then continue to turn as you withdraw it.

5. Repeat steps 3 to 4 with a dry cleaning tip.

**Note:** Make sure you do not touch the soft end of the cleaning tip.

6. Clean the ferrule in the connector port as follows:

   6a. Deposit *one drop* of optical-grade liquid cleaner on a lint-free wiping cloth.

   **IMPORTANT**

   Avoid contact between the tip of the bottle and the wiping cloth, and dry the surface quickly.

   6b. Gently wipe the connector and ferrule.
6c. With a dry lint-free wiping cloth, gently wipe the same surfaces to ensure that the connector and ferrule are perfectly dry.

6d. Verify connector surface with a fiber inspection probe (for example, EXFO’s FIP).

**WARNING**

Verifying the surface of the connector WHILE THE UNIT IS ACTIVE WILL result in permanent eye damage.

7. Fix the connector back onto the connector baseplate with the two screws.

8. Throw out cleaning tips and wiping cloths after one use.
Cleaning EUI Connectors

Regular cleaning of connectors will help maintain optimum performance. There is no need to disassemble the unit.

**IMPORTANT**

If any damage occurs to internal connectors, the module casing will have to be opened and a new calibration will be required.

**WARNING**

Looking into the optical connector while the light source is active WILL result in permanent eye damage. EXFO strongly recommends to TURN OFF the unit before proceeding with the cleaning procedure.

To clean EUI connectors:

1. Remove the EUI from the instrument to expose the connector baseplate and ferrule.

2. Moisten a 2.5 mm cleaning tip with one drop of optical-grade liquid cleaner.
3. Slowly insert the cleaning tip into the EUI adapter until it comes out on the other side (a slow clockwise rotating movement may help).

4. Gently turn the cleaning tip one full turn, then continue to turn as you withdraw it.

5. Repeat steps 3 to 4 with a dry cleaning tip.

**Note:** Make sure you don’t touch the soft end of the cleaning tip.

6. Clean the ferrule in the connector port as follows:

   6a. Deposit *one drop* of optical-grade liquid cleaner on a lint-free wiping cloth.

   6b. Gently wipe the connector and ferrule.

   6c. With a dry lint-free wiping cloth, gently wipe the same surfaces to ensure that the connector and ferrule are perfectly dry.

   6d. Verify connector surface with a fiber inspection probe (for example, EXFO’s FIP).

7. Put the EUI back onto the instrument (push and turn clockwise).

8. Throw out cleaning tips and wiping cloths after one use.

**IMPORTANT**
Avoid contact between the tip of the bottle and the wiping cloth, and dry the surface quickly.
Cleaning Other Types of Connectors

Connectors that do not fall under the EUI or switchable connector categories can be cleaned using a mechanical cleaner. Depending on the type of connector, you will use a different cleaner.

To clean a connector using a mechanical cleaner:

1. Insert the mechanical into the optical adapter, and push the outer shell into the cleaner.

   **Note:** The cleaner makes a clicking sound that indicates that the cleaning is done.

2. Verify connector surface with a portable fiber-optic microscope (for example, EXFO’s FOMS) or fiber inspection probe (for example, EXFO’s FIP).

   When you have finished cleaning the connectors and have reconnected the optical fibers, you can resume all optical route testing.

---

**WARNING**

Verifying the surface of the connector with a fiber-optic microscope WHILE THE UNIT IS ACTIVE WILL result in permanent eye damage.
Replacing the Air Filter

There is one 62 x 62 mm filter located at the front of the unit. This type of filter cannot be cleaned. You must replace it with a new one, typically every 90 days (or after about 2000 hours) of operation. This interval may vary, depending on the environment into which the unit is operated. Dirty air filters can cause the unit's internal temperature to rise.

**WARNING**

To avoid serious injuries as well as irreparable damage to your unit, always remove both power cords before opening or servicing the unit.

**CAUTION**

To avoid damaging your unit or its components, you should wear an antistatic band during this maintenance operation. For more information, see *Preventing Electrostatic Discharge Damage* on page 25.

**CAUTION**

Use only air filters designed for your unit and approved by EXFO. You can purchase new filters from EXFO.

**IMPORTANT**

Replacing the air filter at the recommended intervals may prolong the life of the fan.
**To replace the air filter:**

1. If you are using a fiber management tray, fold down the protective window. For more information, see *Working with the Fiber (Patchcord) Management Tray* on page 37.

2. Turn off the unit and disconnect it completely from the power sources.

3. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.

4. Turn the fan compartment screws counterclockwise until the compartment is loose. Since the screws are captive screws, you cannot remove them completely.
5. Using the screws as handles, gently pull away the fan compartment.

6. Position the fan compartment vertically so that you see the top of the filter.

7. Lift the filter with two fingers to remove it.

8. Slide a new filter back into place.

CAUTION
To avoid dropping the fan compartment and damaging the unit, the fan, or the fan cord, hold the fan compartment firmly. Do not allow the fan compartment to hang over the edge of a rack or a table.
9. Put the fan compartment back in its bay (it should be flush with the unit’s front panel).

10. Turn the fan compartment screws clockwise until the compartment is secured into place.

11. Remove your antistatic strap.

12. Reconnect the unit to its power sources (turn on both disconnected devices) and turn on your unit.

13. If you are using a fiber management tray, put the protective window back into place. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.
Replacing the Fan

Your unit is equipped with one fan located at the front of the unit’s casing. If you ever need to replace the fan, you must purchase a new one from EXFO.

**WARNING**
To avoid serious injuries as well as irreparable damage to your unit, always remove both power cords before opening or servicing the unit.

**CAUTION**
To avoid damaging your unit or its components, you should wear an antistatic band during this maintenance operation. For more information, see *Preventing Electrostatic Discharge Damage* on page 25.

**CAUTION**
Use only fans designed for your unit and approved by EXFO.

**IMPORTANT**
Replacing the air filter at the recommended intervals may prolong the life of the fan.
To replace the fan:

1. If you are using a fiber management tray, fold down the protective window. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.

2. Turn off the unit and disconnect it completely from the power sources.

3. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.

4. Turn the fan compartment screws counterclockwise until the compartment is loose. Since the screws are captive screws, you cannot remove them completely.
5. Using the screws as handles, gently pull away the fan compartment.

**CAUTION**

To avoid dropping the fan compartment and damaging the unit, the fan, or the fan cord, hold the fan compartment firmly. Do not allow the fan compartment to hang over the edge of a rack or a table.

**CAUTION**

Do not disconnect the cord linking the fan to the motherboard when you want to disconnect the power from the fan. Disconnect the fan using the connector located on the fan compartment instead.
6. Position the fan block so that you see its connector.
7. Disconnect the power to the fan as follows:

7a. Push the retaining tab against the connector linking the fan to the unit and hold it firmly.

CAUTION
To avoid damaging the connector linking the fan to the unit, never pull on the unit’s connector without pushing the retaining tab first.
7b. Pull the connector away to remove the old fan completely.

8. Position the new fan block so that you see its connector.
9. Connect the power to the fan as follows:

9a. Ensure that the fan connector and the connector linking the fan to the unit are well aligned. The retaining tab on the unit’s connector should be on the same side as the small lock on the fan connector.

9b. Connect the unit’s connector to the fan.

Note: You may find useful to hold the bottom of the fan connector while you push in the unit’s connector.
10. Put the fan compartment back in its bay (it should be flush with the unit’s front panel).

11. Turn the fan compartment screws clockwise until the compartment is secured into place.

12. Remove your antistatic strap.

13. Reconnect the unit to its power sources (turn on both disconnected devices) and turn on your unit.

**Note:** If you are using a fiber management tray, put the protective window back into place. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.
Replacing the Power Supply Modules

Your unit is powered by two replaceable power supply modules (either AC or DC). Your unit needs only one power supply module to work, but it can house two of them. The second power supply provides redundancy.

The power supply modules are hot-swappable, which means that you do not have to turn off your system to replace one of them. There is no need to disassemble the unit to replace such a power supply.

Ensure that you replace the defective power supply with a new one of the same type (AC or DC).

**WARNING**

To avoid serious injuries, ALWAYS TURN OFF THE DISCONNECT DEVICE THAT IS CONNECTED TO THE DEFECTIVE POWER SUPPLY before replacing the power supply.

**To replace an AC power supply:**

1. Position the unit so that its back panel is facing you.
2. Locate the defective power supply (its LED will be off).
3. Disconnect the power cord from the defective power supply.
4. While pushing the release latch of the defective power supply to the left, gently pull the module toward you with the handle.

**Note:** As soon as the module can slide freely in its bay, there is no need to keep holding the release latch.

5. Pull the power supply module completely out of its bay.

**CAUTION**

To avoid damaging the new power supply module, do not touch the gold connector located at the back and be careful not to hit it either.

6. Position the new power supply so that its release latch is at the right of the handle.

7. Slide the new power supply into the empty bay until it stops (the module will not be flush with the edge of the bay).

8. While pushing the release latch to the left, gently push the module in its bay until it clicks into place.

9. Connect the power cord to the new power supply.
To replace a DC power supply:

1. Position the unit so that its back panel is facing you.

2. Locate the defective power supply (its LED will be off).

3. Turn off the disconnect device that is connected to the defective power supply.

4. Loosen the screws from the power terminals to disconnect the power leads from the defective power supply module.

5. Unplug the earth strap wires from the defective power supply module.
6. While pushing the release latch of the defective power supply to the left, gently pull the module toward you with the handle.

Note: As soon as the module can slide freely in its bay, there is no need to keep holding the release latch.

7. Pull the power supply module completely out of its bay.

CAUTION
To avoid damaging the new power supply module, do not touch the gold connector located at the back and be careful not to hit it.

8. Connect the earth strap wires to the new power supply if you do not have spare earth strap wires with new power supply.

9. Position the new power supply so that its release latch is at the right of the handle.

10. Slide the new power supply into the empty bay until it stops (the module will not be flush with the edge of the bay).

11. While pushing the release latch to the left, gently push the module in its bay until it clicks into place.
12. Pair the power leads with the appropriate power terminal (located at the back of the unit), respecting the polarity.

13. Tighten the screws to attach the power leads to the unit.

14. Turn on the disconnect device that is connected to the new power supply module.

Replacing the OTDR

You may need to replace the OTDR for maintenance purposes.

**WARNING**

To avoid serious injuries as well as irreparable damage to your unit, always remove both power cords before opening or servicing the unit.

**CAUTION**

To avoid damaging your unit or its components, you should wear an antistatic band during this maintenance operation. For more information, see *Preventing Electrostatic Discharge Damage* on page 25.
To replace the OTDR:

1. If you are using a fiber management tray, remove the protective window. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.

2. Turn off the unit and disconnect it completely from the power sources.

3. Put on an antistatic strap and connect it to the connector provided for that purpose on the front panel of the unit.

4. Turn the unit’s main compartment screws counterclockwise until the compartment is loose. Since the screws are captive screws, you cannot remove them completely.

5. Using the screws as handles, gently pull the compartment towards you to open the unit.
6. Turn the screw of the OTDR’s retaining tab counterclockwise until the tab is loose. Since the screw is a captive screw, you cannot remove it completely.

7. Remove the retaining tab to access the OTDR.

**CAUTION**

To avoid damaging the fiber or the module, proceed with caution when connecting or disconnecting the fiber from the OTDR’s port.

8. Unscrew the optical fiber’s connector to disconnect the fiber from the OTDR’s port.

9. Using the two handles on the module, pull up the module to remove it from the unit’s casing.

10. Clean the port of the new OTDR.

11. Clean the optical fiber connector (see *Cleaning and Connecting Optical Fibers* on page 91).

12. Carefully align the module with the anchoring pins at the bottom of the unit’s casing.
13. Insert the new module, ensuring that it lays flat on the bottom of the unit’s casing.

14. Connect the optical fiber to the module (see Cleaning and Connecting Optical Fibers on page 91).

15. Place the retaining tab back into place, over the OTDR.

16. Turn the screw of the retaining tab clockwise until the tab is secured in place.

17. Using the screws as handles, gently push the unit’s main compartment to close it.

18. Turn the unit’s main compartment screws clockwise until the compartment is secured in place.

19. Remove your antistatic strap.

20. Reconnect the unit to its power sources (turn on both disconnected devices) and turn on your unit.

21. If you are using a fiber management tray, put the protective window back into place. For more information, see Working with the Fiber (Patchcord) Management Tray on page 37.

Your new OTDR is ready to be used.
Replacing an RTU or Changing the SSD (managed by EMS)

To replace an RTU:
1. Start the HostWebUI application.
   1a. Select Host from the Configuration menu.
   1b. Under Northbound Settings, select EMS Server.
2. Note the MAC address of the old RTU from the EMS.
   2a. Select **Network** from the **Configuration** menu.
   2b. Note the MAC address displayed under the **Rear adapter** section.

3. Turn ON RTU. (Do not detect any port.)
4. Test the RTU connection with EMS.
   4a. Select **EMS Server** from the HostWebUI > **Configuration** > **Host** menu.
   4b. Click the **Edit** button.
   4c. Enter the **EMS IP address/host name** in the **EMS Server** configuration section.
   4d. Click the **Apply** button.

5. Click the **Test Connection** button. The application will ask you if you want to synchronize the configuration now. Click **No** to this.
6. Perform **Recovery Configuration**:

   6a. Click the **Recovery Configuration** button.

   6b. Enter the **Old MAC Address** (previously noted in step 2) in the **Recovery** text box and click the **recover** button.

7. On EMS web UI, select the RTU and then clear the **Offline** check box.

8. After completion of successful recovery, check the RTU status on EMS; it should be in **Not connected** and **Synchronized** state.
Backing Up the Database

When you are using the + RTU in stand-alone mode, you must perform backups of the database for additional security in case of a major system failure.

**Note:** *When the RTU is used with the EMS server, there is no need for manual backups, because the system configuration is copied on the EMS server.*

Depending on the database size, the backup process can take from a few seconds to about 10 minutes.

The backup file includes *all* the database entries, such as:

- Optical routes, test setups, test programs
- Custom thresholds
- Default values
- Results

The application names the backup files as follows:

```
YYYYMMDDHHMM.NqmsOtdr.BAK
```

You can find the backup file in the `C:\DatabaseBackup` folder, on your RTU.

**Note:** *Only the two most recent backups are kept.*

If you ever need to recover the database, contact EXFO (see *Contacting the Technical Support Group* on page 347).
To back up the database:
1. From the main menu, select Configuration > Remote Test Unit.
2. Click Backup Database.
Viewing the Installed Applications

You can view a list of all the applications installed on the host as well as their versions. If you need to retrieve the firmware (system) version of the companion, see Viewing the Firmware Version of the Companion on page 302.

**To view a list of the installed applications:**

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the Configuration menu, click Software Packages.

The Web UI displays a list of all the installed applications.
Viewing the Firmware Version of the Companion

You can retrieve the firmware (system) version of the companion from the Host Web UI.

To view the firmware version of the companion:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the main menu, select Configuration > Host.


![Image of Host Manager interface showing network settings with BMC version highlighted]

The version number is displayed under BMC.
Managing Applications (Software Packages)

You can add, modify, or delete software packages from the host directly in Host Web UI or from the EMS if the RTU is linked to one.

You can modify the settings (name, transfer and installation dates, etc.) for a specific package that has already been added, or even delete a package that you no longer need. Deleting a software package removes the application from the host. However, the edition and deletion are not allowed for all the software packages.

The edition and deletion operations can be performed according to the following table.

<table>
<thead>
<tr>
<th>Possible States for Software Packages</th>
<th>Allowed Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Edit, delete</td>
</tr>
<tr>
<td>Downloaded</td>
<td>Edit, delete</td>
</tr>
<tr>
<td>Download failed</td>
<td>Edit, delete, retry</td>
</tr>
<tr>
<td>Activated</td>
<td>Delete</td>
</tr>
<tr>
<td>Activation failed</td>
<td>Delete, retry</td>
</tr>
<tr>
<td>Cancel failed</td>
<td>Delete, retry</td>
</tr>
<tr>
<td>History (was replaced by a more recent one)</td>
<td>Delete</td>
</tr>
</tbody>
</table>
To add a software package:

1. If you intend to connect to your unit via a WAN or the Internet, connect to the VPN (see Connecting to the VPN on page 79); otherwise, go directly to the next step.

2. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

3. From the Configuration menu, click Software Packages.

4. Click Add.

5. Upload the package:

   5a. Select the Local option, then click Upload.
5b. Locate the desired software package in the browser window, then click **Open**.

Once the operation is complete, the file name, and transfer and activation dates will be provided automatically. You can modify the transfer and activation dates if they do not suit your needs.

**Note:** The upload operation can take several minutes.

**Note:** If you enter a past date or time, the transfer or activation will start right away.

6. Click **Save**.
To edit a software package:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the Configuration menu, click Software Packages.
3. From the list of the installed software packages, click the package that you want to edit.
4. Click Edit.
5. Modify the information as needed.
6. Click Save.

To delete a software package:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the Configuration menu, click Software Packages.
3. From the list of the installed software packages, click the package that you want to delete.
4. Click Delete, then confirm your choice.
Recalibrating the Unit

EXFO manufacturing and service center calibrations are based on the ISO/IEC 17025 standard (General Requirements for the Competence of Testing and Calibration Laboratories). This standard states that calibration documents must not contain a calibration interval and that the user is responsible for determining the re-calibration date according to the actual use of the instrument.

The validity of specifications depends on operating conditions. For example, the calibration validity period can be longer or shorter depending on the intensity of use, environmental conditions and unit maintenance, as well as the specific requirements for your application. All of these elements must be taken into consideration when determining the appropriate calibration interval of this particular EXFO unit.

Under normal use, the recommended interval for your FG-750 Fiber Guardian is: three years.

For newly delivered units, EXFO has determined that the storage of this product for up to six months between calibration and shipment does not affect its performance.
To help you with calibration follow-up, EXFO provides a special calibration label that complies with the ISO/IEC 17025 standard and indicates the unit calibration date and provides space to indicate the due date. Unless you have already established a specific calibration interval based on your own empirical data and requirements, EXFO would recommend that the next calibration date be established according to the following equation:

**Next calibration date = Shipping date + Recommended calibration period (three years)**

To ensure that your unit conforms to the published specifications, calibration may be carried out at an EXFO service center or, depending on the product, at one of EXFO’s certified service centers. Calibrations at EXFO are performed using standards traceable to national metrology institutes.

**Recycling and Disposal**

This symbol on the product means that you should recycle or dispose of your product (including electric and electronic accessories) properly, in accordance with local regulations. Do not dispose of it in ordinary garbage receptacles.

For complete recycling/disposal information, visit the EXFO Web site at www.exfo.com/recycle.
# 12 Troubleshooting

## Solving Common Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The unit has restarted unexpectedly. | ➤ There was a problem with the host while you were working or at startup of the unit.  
➤ There was a problem with the companion.  
➤ There has been a power failure. | Any problem that could have occurred should be solved once the unit has restarted.  
If the problem persists, contact EXFO. |
| You have waited 10 minutes after starting the installation of the Platform package, but you are still unable to connect to the Host Web UI. | There was a problem during the installation process. | Try restarting the unit through the KVM console, or manually (by pressing the button on the front panel); ensure that the Host Web UI is accessible, and that the right version has been installed properly.  
If the new version has not been installed, try reinstalling the Platform package.  
If you are not able to reconnect to the Host Web UI or if the new package cannot be installed, contact EXFO. |
## Troubleshooting

### Solving Common Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Host Web UI stops responding in the “Loading” state.</td>
<td>The IP address or the host name of the host machine has changed.</td>
<td>Check the IP address of the host, and correct if necessary.</td>
</tr>
<tr>
<td></td>
<td>The host machine is restarting.</td>
<td>Wait for the host machine to start.</td>
</tr>
<tr>
<td></td>
<td>The host machine is not reachable.</td>
<td>Contact your network administrator for network-related troubleshooting.</td>
</tr>
<tr>
<td></td>
<td>The Web browser that is used is not supported.</td>
<td>Use one of the supported browsers see Supported Web Browsers on page 12.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If none of the solutions mentioned above solves the problem, contact EXFO.</td>
</tr>
<tr>
<td>Network settings are not properly applied on the host machine.</td>
<td>Wrong IP address, subnet mask, or gateway.</td>
<td>Check if the IP address, subnet mask and gateway that you have specified for the host are valid.</td>
</tr>
<tr>
<td>The Web interface is not loaded or not rendered properly in the Web browser.</td>
<td>Browser-specific issue. The browser might not support HTML5.</td>
<td>Refresh the Web page. If the interface still does not load properly, check the version of your browser. The Web browser must support HTML5. For the complete list of supported Web browsers, see Supported Web Browsers on page 12.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Web browser is not prompting the user for login credentials.</td>
<td>Login credentials are saved in the Web browser cache.</td>
<td>If you have enabled the browser to save passwords, disable the setting and clear the browser cache.</td>
</tr>
<tr>
<td>Impossible to connect to the KVM remote console.</td>
<td>Java may not be installed on your computer.</td>
<td>Ensure that Java 6 or later is installed on the computer that you intend to use to connect to remote console.</td>
</tr>
<tr>
<td></td>
<td>The Web browser that is used is not supported.</td>
<td>Use one of the supported browsers see Supported Web Browsers on page 12. If none of the solutions mentioned above solves the problem, contact EXFO.</td>
</tr>
<tr>
<td>The unit is not responding.</td>
<td>---</td>
<td>Try restarting the host through the KVM console, or manually by pressing and holding down the power button for 5 seconds. If this does not solve the problem, try restarting both the host and the companion, by pressing and holding down the power button for 10 seconds. If the problem persists, contact EXFO.</td>
</tr>
</tbody>
</table>
LED Indicators Description

The LEDs on your unit help you determine its current status. They are located on the front panel.

For the power and system LEDs, if more than one error is detected at the same time, the color of the LED will be set according to the most severe error (red as the most severe, followed by yellow).

The table below presents the possible statuses once the initial startup sequence is complete.

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Meaning and Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Green</td>
<td>The unit is on and there are no voltage problems.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Non-critical voltage error detected. You can look in the Host Web UI for more information (see Viewing System Status on page 316). One of the power supply module could be missing or defective. Ensure that both power supply modules are present and functioning properly. If necessary, replace the defective power supply (see Replacing the Power Supply Modules on page 287). If the problem persists, contact EXFO.</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>Critical voltage error detected. Contact EXFO.</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>The unit has been disconnected from all its power sources.</td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting

### LED Indicators Description

<table>
<thead>
<tr>
<th>LED Status</th>
<th>Meaning and Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="System Green" /></td>
<td><strong>System</strong> Green The unit is working properly. There are no software or hardware problems.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Non-critical hardware error detected. You can look in the Host Web UI for more information (see <em>Viewing System Status</em> on page 316).</td>
</tr>
<tr>
<td><img src="image" alt="The air filter could be dirty. Inspect and replace the air filter if necessary" /></td>
<td>► The air filter could be dirty. Inspect and replace the air filter if necessary (see <em>Replacing the Air Filter</em> on page 275).</td>
</tr>
<tr>
<td><img src="image" alt="The temperature of the room where the unit is located, could be slightly too low or too high. Ensure that the temperature falls within the specified operating temperature range" /></td>
<td>► The temperature of the room where the unit is located, could be slightly too low or too high. Ensure that the temperature falls within the specified operating temperature range (see <em>Electrical Safety Information</em> on page 20). Once the problem is solved, refresh the LEDs status (see <em>Refreshing the Status of the LEDs</em> on page 318).</td>
</tr>
<tr>
<td>Yellow, blinking</td>
<td>Non-critical software error detected.</td>
</tr>
<tr>
<td><img src="image" alt="Consult the Event log to find the cause of the problem and try to solve it" /></td>
<td>► Consult the Event log to find the cause of the problem and try to solve it (see <em>Viewing the Event Log</em> on page 261).</td>
</tr>
<tr>
<td><img src="image" alt="Once the problem is solved, refresh the LEDs status" /></td>
<td>► Once the problem is solved, refresh the LEDs status (see <em>Refreshing the Status of the LEDs</em> on page 318).</td>
</tr>
</tbody>
</table>

If the problem persists, contact EXFO.
### LED Indicators Description

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Meaning and Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="System icon" /> (continued)</td>
<td>Red</td>
<td>Critical hardware error detected. You can look in the Host Web UI for more information (see Viewing System Status on page 316).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The fan could be defective. Replace the fan (see Replacing the Fan on page 279).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The temperature of the room where the unit is located, is critically too low or too high. Ensure that the temperature falls within the specified operating temperature range (see Electrical Safety Information on page 20).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Once the problem is solved, refresh the LEDs status (see Refreshing the Status of the LEDs on page 318).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact EXFO.</td>
</tr>
<tr>
<td></td>
<td>Red, blinking</td>
<td>Critical software error detected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Consult the Event log to find the cause of the problem and try to solve it (see Viewing the Event Log on page 261).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Once the problem is solved, refresh the LEDs status (see Refreshing the Status of the LEDs on page 318).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact EXFO.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>The host is off.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## LED Indicators Description

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Meaning and Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Cloud" /></td>
<td>Green</td>
<td>The LAN is up (on the rear Ethernet port).</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Cloud" /></td>
<td>Green, blinking</td>
<td>The LAN is down, but the unit has automatically switched to 3G.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Cloud" /></td>
<td>Yellow</td>
<td><img src="https://via.placeholder.com/20" alt="Checkmark" />  The LAN is down and the 3G network is down, or there is a problem with the configuration of the 3G settings (ex.: wrong APN). <img src="https://via.placeholder.com/20" alt="Checkmark" />  The unit is not equipped with the 3G option.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement in progress</td>
<td>Green</td>
<td>An OTDR acquisition is underway.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement in progress</td>
<td>Off</td>
<td>No acquisition is underway.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement status</td>
<td>Green</td>
<td>At least one optical route is detected.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement status</td>
<td>Green, blinking</td>
<td>At least one route is in the skipped status. No fault is present.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement status</td>
<td>Yellow</td>
<td>A fiber fault with degradation type is present.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/20" alt="Exclamation" /> Measurement status</td>
<td>Red</td>
<td>At least a fiber fault with break type is present.</td>
</tr>
</tbody>
</table>
Viewing System Status

You can view the current status on your system under three views: host, companion and system. The status information includes the host name and serial number, the address of the time server and synchronization interval, the IPv4 and IPv6 configuration for the rear adapters for both the host and companion, as well as information such as the LED and relay statuses, processor usage and system temperature.

To view system status:
1. Connect to the Host Web UI.
2. From the Status menu, click System Information.
   The interface displays the Host Information window.
3. If you want to view the companion status, click Companion Information.
4. If you want to view the system status, click System Status.

Testing the Status of the Relays

You can test the status of the power, system, and user-defined relays directly from the Host Web UI.

To test the status of the relays:
1. Start the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the Status menu, click System Information.
3. Click **System Status**.

![System Status Table]

4. Under **Relay status**, click the **Test** button corresponding to the relay that you want to test.

The relay status changes from its current status to the other (from “Active” to “InActive”, or from “InActive” to “Active”); and then comes back to its initial status.
Refresh the Status of the LEDs

When power or system errors occur, the corresponding LED switches from green to another color, depending on the type of problem that has been detected (see LED Indicators Description on page 312). For troubleshooting purposes, the status of the LEDs is kept until you refresh it.

You can refresh the status of the power or system LEDs using one of the following methods:

- Send a request to refresh the status, via the Fiber Guardian Web user interface, or by using the LedStateChangeRequest REST command. This method is particularly useful when you do not need to turn off the unit (for example, after you corrected software errors). For more information on the REST commands, see Working with the REST Commands (Certain Models Only) on page 93.

- Shut down and restart the unit. For more information, see Turning On or Off the Unit on page 48.

Normally, you will only need to refresh the status of the LEDs in the case of software errors. For hardware errors that require a replacement of material (power supply, fan, filter), the status will be refreshed automatically after you restart your unit.
Troubleshooting

Refreshing the Status of the LEDs

To refresh the status of the LEDs via the Host Web UI:

1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the main menu, select Status > System Information.

3. From the tree view, select System Status.

4. Under Refreshing LED and relay status, click the Refresh button.

The LEDs will blink three times, indicating that the refresh operation is underway. After that, the status of the LEDs will have been updated.
Connecting to Your Unit Using the KMV Remote Console

Most of the configuration and monitoring tasks on your FG-750 unit can be performed via the Host Web UI. However, you may need to access your unit directly in certain cases such as advanced troubleshooting or when you need to install a VPN client.

**IMPORTANT**

You cannot access the KVM remote console via a WAN or the Internet. You must either use a portable computer (DHCP adapter) connected to the front port of the unit, or a computer connected to a same LAN as the unit. This is due to a limitation of the Internet, not of your system and applications.

For a complete list of supported Web browsers, see *Supported Web Browsers* on page 12.

**To connect to your unit using the KVM remote console:**

1. Ensure that your computer is equipped with Java 6 or later. If it is not the case, install it on your computer (www.java.com) first.

2. Connect to the Host Web UI. For more information, see *Accessing and Exiting the Host Web UI* on page 121.

3. From the main menu, select **Status** > **System Information**.
4. From the tree view, select **Companion Information**.

5. Go to the **Rear Adapter** column and write down the IP address of the rear port.
6. From your computer, open a Web browser, and then type https://Companion_Rear_Port_IP_Address, where the Companion_Rear_Port_IP_Address corresponds to the address that you have retrieved at step 5.

7. When the application prompts you, enter Administrator as the username and RTUEXFO123 as the password.

8. Click the Login button.
Troubleshooting
Connecting to Your Unit Using the KMV Remote Console

9. From the **Dashboard** tab, click the **Launch** button.

10. When the application prompts you to confirm that you want to start the KVM remote console, select the **I accept the risk and want to run this application** check box.

11. Click **Run**.

**Note:** *If you never be prompted again for such applications, select the **Always trust content from this publisher** check box.*
12. If necessary, log on to Windows using Administrator as the user account and RTUEXFO123 as the password.

The KVM remote console displays the host's desktop.

**Resetting Configuration (Parameters)**

You can reset the Fiber Guardian host configuration to its factory default values. The following procedure describes how to reset host its default settings.

*To reset the configuration of the host:*

1. Connect to the Host Web UI. For more information, see *Accessing and Exiting the Host Web UI* on page 121.

2. From the Actions menu, click Reset Configuration.

3. When the application prompts you to confirm the operation, click Yes.
Restoring Your Unit to Normal Operation (Windows 8)

Your FG-750 unit comes with integrated emergency system tools with which you can:

- verify the integrity of the storage device
- revert your unit to its initial state (as it was when you purchased it) or restore it with a specific Windows image (WIM) that could have been provided to you by EXFO customer service, for example.

**IMPORTANT**

Restoring the system partition replaces what is currently installed on your unit with the image you choose. You can stop the process at any time, but you will still need to perform the recovery operation. Otherwise, your unit will not function properly.

If you have installed new software, product packs and updates, you must reinstall them; otherwise, they will no longer be available.
To restore the system partition:

1. Connect to the KVM remote console, but do not log in to Windows. For more information, see Connecting to Your Unit Using the KVM Remote Console on page 320.

2. From the remote console, go to the bottom-right corner of the screen with your mouse to make the Windows charm bar appear.

3. Select Settings, then, Change PC settings.
4. Select **General**.

![PC settings](image)

**Time**
- 9:25 AM, Thursday, February 18, 2010
- (UTC-08:00) Pacific Time (US & Canada)

- Adjust for daylight saving time automatically: **On**

**App switching**
- Allow switching between recent apps: **On**
- When I swipe in from the left edge, switch directly to my most recent app: **On**

**Spelling**
- Autocorrect misspelled words: **On**
- Highlight misspelled words: **On**

**Language**
- Add or change input methods, keyboard layouts, and languages.
Troubleshooting
Restoring Your Unit to Normal Operation (Windows 8)

5. Finally, click the Get started button for one of the two last options, either Refresh your PC without affecting your files or Remove everything and reinstall Windows. The second option reboots the computer and restores the original Windows.

Refresh your PC without affecting your files

If your PC isn’t running well, you can refresh it without losing your photos, music, videos, and other personal files.

Get started

Remove everything and reinstall Windows

If you want to recycle your PC or start over completely, you can reset it to its factory settings.

Get started
Restoring Your Unit to Normal Operation (Windows 10)

Your FG-750 unit comes with integrated emergency system tools with which you can:

- verify the integrity of the storage device
- revert your unit to its initial state (as it was when you purchased it) or restore it with a specific Windows image (WIM) that could have been provided to you by EXFO customer service, for example.

**IMPORTANT**

Restoring the system partition replaces what is currently installed on your unit with the image you choose. You can stop the process at any time, but you will still need to perform the recovery operation. Otherwise, your unit will not function properly.

If you have installed new software, product packs and updates, you must reinstall them; otherwise, they will no longer be available.

You can create your own WIM files directly from your unit and store them on a USB key for future use.

**IMPORTANT**

The WIM files that you create are based on the serial number of your unit. This means that the WIM files created on one unit are only valid to restore this particular unit.
Troubleshooting

Restoring Your Unit to Normal Operation (Windows 10)

**IMPORTANT**

The creation of a WIM file implies a compression of the files that are currently installed on your unit. The size of the files after compression cannot be estimated beforehand.

For this reason, the application WILL NOT PROMPT YOU AT THE BEGINNING of the operation if the storage capacity (or the file system) of your USB key is not appropriate.

**CAUTION**

➢ DO NOT TURN OFF your unit while the recovery operation is underway. Doing so may severely damage your unit. Damaged units will need to be sent back to EXFO for repair.

When you want to restore your unit, there are several options. The table below gives an overview of the possibilities.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>➢ The unit will be reverted to the state in which it was when the WIM file was created.</td>
</tr>
<tr>
<td></td>
<td>➢ All data files will be lost once the operation is complete.</td>
</tr>
<tr>
<td></td>
<td>➢ If you have installed products and updates since the WIM file was created, you will have to reinstall them.</td>
</tr>
<tr>
<td>Reset to factory settings</td>
<td>➢ The unit will be reverted to its initial state.</td>
</tr>
<tr>
<td></td>
<td>➢ All data files will be lost once the operation is complete.</td>
</tr>
<tr>
<td></td>
<td>➢ If you have installed products and updates since you purchased your unit, you will have to reinstall them.</td>
</tr>
</tbody>
</table>
Restoring Your Unit to Normal Operation (Windows 10)

**IMPORTANT**
To avoid problems, always use the wizard provided by EXFO to revert your unit to a previous state, not the recovery tools provided by Microsoft.

**IMPORTANT**
The size of the WIM will depend on the disk space that is currently used on your unit.

To avoid problems, always use a USB key with an NTFS file system, and a minimum of 16 GB of free disk space.

**To create a WIM file for your unit:**
1. From the task bar, click the Start button ( ), and then Settings ( ).
2. Click Update & security.
Restoring Your Unit to Normal Operation (Windows 10)

3. Select **Recovery**.

4. Under **Advanced Startup**, click **Restart now**.
5. Under **Choose an option**, click **Troubleshoot**.

6. Click **Platform Imaging Utility** to display the corresponding application.

7. Connect a USB key to your unit.
8. From the Platform Servicing and Imaging Utility wizard, select **Create a WIM file**, and then click **Next**.

9. Click **Browse**.
10. Locate the USB key, and then double-click its identifier to access the contents.

11. Select the desired folder.

12. Enter a file name, and then click **Save**.

13. Click **Start**.

![Platform Servicing and Imaging Utility](image)

**Note:** *The time required to create the image varies with the configuration of your unit.*

14. When the operation is complete and the application prompts you, click **OK**.

15. Disconnect the USB key.

16. Click **Cancel** to return to the Welcome window of the utility.
17. Click **Restart**.

The WIM file is ready for future use.
Troubleshooting

Restoring Your Unit to Normal Operation (Windows 10)

To revert your unit to a previous state with a WIM file:

1. If desired, back up your data.
2. From the task bar, click the Start button ( ], and then Settings ( ]).
3. Click Update & security.
Troubleshooting
Restoring Your Unit to Normal Operation (Windows 10)

4. Select Recovery.

5. Under Advanced Startup, click Restart now.
6. Under **Choose an option**, click **Troubleshoot**.

7. Click **Platform Imaging Utility** to display the corresponding application.

8. Connect the USB key with the desired WIM file to your unit.
9. From the Platform Servicing and Imaging Utility wizard, select **Restore unit from a WIM file**, and then click **Next**.

10. Click **Browse**.
Troubleshooting
Restoring Your Unit to Normal Operation (Windows 10)

11. Locate the USB key, and then double-click its identifier to access the contents.

12. Select the desired WIM file.

13. Click Next.

14. Read the warning, and then click Start to restore the unit with the selected image.

15. When the operation is complete and the application prompts you, disconnect the USB key, and then click OK.

The unit will restart.

To reset your unit to its factory settings:
1. If desired, back up your data.

2. From the task bar, click the Start button ( ), and then Settings ( ).
Troubleshooting
Restoring Your Unit to Normal Operation (Windows 10)

3. Click Update & security.
4. Select **Recovery**.

5. Under **Advanced Startup**, click **Restart now**.
6. Under **Choose an option**, click **Troubleshoot**.

7. Click **Platform Imaging Utility** to display the corresponding application.
8. From the Platform Servicing and Imaging Utility wizard, select **Reset this unit to factory settings**, and then click **Next**.

![Platform Servicing and Imaging Utility](image)

9. Read the warning, and then click **Start** to restore the unit with the selected image.

10. When the operation is complete and the application prompts you, click **OK**.
    
The unit will restart.

11. Configure the regional parameters, and accept the license agreements as you did when you first received your unit.
Viewing Online Documentation

An online version of the Fiber Guardian user guide is available at all times from the Host Web UI.

To view the online documents

1. Start the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.

2. From the About menu, click Help.

3. Click the user guide that you want to view.
Contacting the Technical Support Group

To obtain after-sales service or technical support for this product, contact EXFO at one of the following numbers. The Technical Support Group is available to take your calls from Monday to Friday, 8:00 a.m. to 7:00 p.m. (Eastern Time in North America).

Technical Support Group
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA
1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com

For detailed information about technical support, and for a list of other worldwide locations, visit the EXFO Web site at www.exfo.com.

If you have comments or suggestions about this user documentation, you can send them to customer.feedback.manual@exfo.com.

To accelerate the process, please have information such as the name and the serial number (see the product identification label), as well as a description of your problem, close at hand.

IMPORTANT
If you require quick assistance specific to your fiber monitoring solution, use support.nqmsfiber@exfo.com instead.
Viewing Product Information

If you need any assistance regarding your Fiber Guardian, you can contact EXFO.

To view EXFO contact information:
1. Connect to the Host Web UI. For more information, see Accessing and Exiting the Host Web UI on page 121.
2. From the About menu, click Contact EXFO.

Transportation

Maintain a temperature range within specifications when transporting the unit. Transportation damage can occur from improper handling. The following steps are recommended to minimize the possibility of damage:

- Pack the unit in its original packing material when shipping.
- Avoid high humidity or large temperature fluctuations.
- Keep the unit out of direct sunlight.
- Avoid unnecessary shocks and vibrations.
13 Warranty

General Information

EXFO Inc. (EXFO) warrants this equipment against defects in material and workmanship for a period of one year from the date of original shipment. EXFO also warrants that this equipment will meet applicable specifications under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace, or issue credit for any defective product, as well as verify and adjust the product free of charge should the equipment need to be repaired or if the original calibration is erroneous. If the equipment is sent back for verification of calibration during the warranty period and found to meet all published specifications, EXFO will charge standard calibration fees.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

Liability

EXFO shall not be liable for damages resulting from the use of the product, nor shall be responsible for any failure in the performance of other items to which the product is connected or the operation of any system of which the product may be a part.

EXFO shall not be liable for damages resulting from improper usage or unauthorized modification of the product, its accompanying accessories and software.
Exclusions

EXFO reserves the right to make changes in the design or construction of any of its products at any time without incurring obligation to make any changes whatsoever on units purchased. Accessories, including but not limited to fuses, pilot lamps, batteries and universal interfaces (EUI) used with EXFO products are not covered by this warranty.

This warranty excludes failure resulting from: improper use or installation, normal wear and tear, accident, abuse, neglect, fire, water, lightning or other acts of nature, causes external to the product or other factors beyond the control of EXFO.

Certification

EXFO certifies that this equipment met its published specifications at the time of shipment from the factory.
Service and Repairs

EXFO commits to providing product service and repair for five years following the date of purchase.

**To send any equipment for service or repair:**

1. Call one of EXFO’s authorized service centers (see *EXFO Service Centers Worldwide* on page 352). Support personnel will determine if the equipment requires service, repair, or calibration.

2. If equipment must be returned to EXFO or an authorized service center, support personnel will issue a Return Merchandise Authorization (RMA) number and provide an address for return.

3. If possible, back up your data before sending the unit for repair.

4. Pack the equipment in its original shipping material. Be sure to include a statement or report fully detailing the defect and the conditions under which it was observed.

5. Return the equipment, prepaid, to the address given to you by support personnel. Be sure to write the RMA number on the shipping slip. *EXFO will refuse and return any package that does not bear an RMA number.*

**Note:** *A test setup fee will apply to any returned unit that, after test, is found to meet the applicable specifications.*

After repair, the equipment will be returned with a repair report. If the equipment is not under warranty, you will be invoiced for the cost appearing on this report. EXFO will pay return-to-customer shipping costs for equipment under warranty. Shipping insurance is at your expense.

Routine recalibration is not included in any of the warranty plans. Since calibrations/verifications are not covered by the basic or extended warranties, you may elect to purchase FlexCare Calibration/Verification Packages for a definite period of time. Contact an authorized service center (see *EXFO Service Centers Worldwide* on page 352).
EXFO Service Centers Worldwide

If your product requires servicing, contact your nearest authorized service center.

EXFO Headquarters Service Center
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com

EXFO Europe Service Center
Winchester House, School Lane
Chandlers Ford, Hampshire S053 4DG
ENGLAND

Tel.: +44 2380 246800
Fax: +44 2380 246801
support.europe@exfo.com

EXFO Telecom Equipment (Shenzhen) Ltd.
3rd Floor, Building C,
FuNing Hi-Tech Industrial Park, No. 71-3,
Xintian Avenue,
Fuhai, Bao’An District,
Shenzhen, China, 518103

Tel: +86 (755) 2955 3100
Fax: +86 (755) 2955 3101
support.asia@exfo.com

To view EXFO's network of partner-operated Certified Service Centers nearest you, please consult EXFO's corporate website for the complete list of service partners:
Fault Geolocalization Using a KML File

This chapter describes finding a fault’s geographical position using a KML/KMZ file. These files are custom and need a specific standard. For information on file formatting, contact EXFO (see Contacting the Technical Support Group on page 347).

See Accessing and Exiting the Host Web UI on page 121 to login to the Host Wed UI. Configure the SMTP settings to send e-mails (see Configuring the E-Mail Server Settings on page 131) and setup an Alerting Type (see Managing Alert Types on page 155) to send an e-mail when faults occur.

To upload a KML file:

1. Enter https://RTU_IP/api/topology/importkml.html. This opens the following web page:

   ![Topology KML Import](https://10.28.224.23/api/topology/importkml.html)

   - **Import** button
   - **Browse** button
   - **Import Object Id**, **Name**, **Type**, **Action**, **Timestamp**, **Status**

2. Click on the **Browse** button and select your KML/KMZ file.

   **Note:** The .kml/.kmz file must have the same name as the Optical Route created on the FG-750 (in the NqmsWebOtdr2 web page).
3. Click on the **Import** button.

After a couple of seconds, the following summary of Imported Object IDs is displayed:

### Topology KML Import

![Image of KML import interface]

**KML Import Status:**

File uploaded ...

<table>
<thead>
<tr>
<th>ImportedObjectId</th>
<th>Name</th>
<th>Type</th>
<th>Action</th>
<th>TimeStamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>4911</td>
<td>QC QCCT01-000S01-ENTOURAGE</td>
<td>site</td>
<td>CREATED</td>
<td>2018-05-15 19:51:17.404+0000</td>
</tr>
<tr>
<td>4945</td>
<td>QC QCCT03-Bar-Orsainville</td>
<td>site</td>
<td>CREATED</td>
<td>2018-05-15 19:51:17.294+0000</td>
</tr>
<tr>
<td>4978</td>
<td>Hack</td>
<td>opticalRoute</td>
<td>CREATED</td>
<td>2018-05-15 19:51:17.681+0000</td>
</tr>
</tbody>
</table>
To view the geolocalization of a fault:

Under Configuration/Remote Test Unit, select the Name of the optical route with the same name as the KML file:
When a fault occurs, an e-mail is sent listing 3 new values: **Latitude**, **Longitude**, and **Google map** hyperlink which represent the geolocalization of the fault.

All message formats including HTTP Post contain these 3 new values for a **Fiber Fault** except for SNMP (Simple Network Management Protocol) and SMS. see **Channel type page** 156 to select the desired alert message format.
Index

3G/4G access ................................................. 59

A

AC
adapter .................................................... 20
power .................................................. 12, 30, 45
requirements ........................................... 23
access, permissions .................................. 110
accessing unit directly .................................. 320
acquisition
distance ................................................ 166
duration ................................................. 166
range ..................................................... 166
setting analysis detection thresholds ... 180
setting pulse ........................................... 166
activation time, changing ......................... 306
ad hoc test
default values ........................................ 202
performing ............................................ 196
adding
lines .................................................... 252
remote OTAU ......................................... 247
ROTAU .................................................. 147
tray ....................................................... 37
address of time server ............................ 135
administration console
creating users ..................................... 103
login ..................................................... 101
searching for users ................................. 107
after-sales service ..................................... 347
air filter, replacing ................................... 275
alerts
configuring notifications ....................... 154
types ..................................................... 155
allowed operations on packages ............... 303
antenna, connecting ..................... 60, 304

applications
add ...................................................... 304
delete ................................................... 306
edit packages ........................................ 306
Fiber Guardian ....................................... 121
KVM remote console .............................. 320
Line Configuration .................................. 243
manage ............................................... 303
view ..................................................... 301
applying filters ....................................... 264
automatic
connection to network ................................... 59
IP address ............................................ 124
available models ..................................... 4

B
backup connection ...................................... 59
battery, clock .......................................... 12
blinking LED .......................................... 312
browsers, supported ................................. 12
building applications .................................. 93

C
cabinet installation .................................... 27
capacitors .............................................. 22
cassette
changing ............................................... 144
insertion and removal ............................. 32
types .................................................. 9
caution
of personal hazard .................................. 14
of product hazard .................................... 14
changing
AC power supply ..................................... 287
cassette ................................................ 144
DC power supply ................................... 289
OTDR module ........................................ 291
power supply ......................................... 287
Index

characterization table ........................................ 230
checking storage device integrity .......................... 325, 329
child group ..................................................... 114
cleaning
  fiber ends .................................................... 91
  front panel ................................................. 267
  other connectors .......................................... 274
  switchable connectors ..................................... 268
clearing log filters ........................................... 264
clock battery .................................................. 12
closing application
  Fiber Guardian ........................................... 121
  Line Configuration ....................................... 243
common problems ........................................... 309, 312
communication LED .......................................... 315
companion
  configure network ......................................... 124
  status ....................................................... 316
  version ..................................................... 302
  view information ......................................... 123
computer
  installing VPN client ..................................... 70
  modifying name ........................................... 124
configuring
  3G/4G ....................................................... 127
  alert notifications ........................................ 154
  e-mail server ............................................. 131
  LDAP ....................................................... 116
  network ..................................................... 124
  SNMP ....................................................... 132
  time server ................................................. 135
connecting
  a switch .................................................... 52
  antenna ...................................................... 60
  as NQMSFiber EMS client .................................. 129
  power and network ....................................... 45
  ROTAU ....................................................... 146
  to applications ............................................ 12
  to unit ...................................................... 320
  to VPN ....................................................... 79
  unit to the Nova solution ................................ 82
  via WAN or Internet ...................................... 69
connectors, cleaning ......................................... 268
consolidated ROTAU status .................................. 153
conventions, safety .......................................... 14
covers, unit .................................................. 22
creating
  groups ....................................................... 114
  reports ..................................................... 265
  users ....................................................... 103
  credentials, managing .................................... 108
current, electrical ........................................... 23
customer service ............................................ 351

data, sorting ................................................... 263
database, external for users ................................ 115
DC power ..................................................... 12, 30, 45
default values for ad hoc test ............................. 202
defective fan .................................................. 279
deleting
  faults ....................................................... 227
  filters ....................................................... 264
  lines ....................................................... 255
  remote OTAU .............................................. 251
  ROTAU ....................................................... 150
detecting
  fibers ....................................................... 141
  fibers connected to optical ports ...................... 139
  DHCP ....................................................... 124
disabling password .......................................... 108
disconnecting unit ........................................... 20
displaying
  log columns ............................................... 262
  log entries ............................................... 263
distance range .............................................. 166
DNS server ................................................... 124
documentation, REST ........................................ 93
dry contact relays .......................................... 50
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E</strong></td>
</tr>
<tr>
<td>editing lines</td>
</tr>
<tr>
<td>remote OTAU</td>
</tr>
<tr>
<td>ROTAU</td>
</tr>
<tr>
<td>software packages</td>
</tr>
<tr>
<td>test on demand</td>
</tr>
<tr>
<td>electrostatic discharge damage. see ESD</td>
</tr>
<tr>
<td>e-mail alerts</td>
</tr>
<tr>
<td>configuring server</td>
</tr>
<tr>
<td>emergency connection</td>
</tr>
<tr>
<td>system tools</td>
</tr>
<tr>
<td>EMS client, connection</td>
</tr>
<tr>
<td>equipment returns</td>
</tr>
<tr>
<td>errors</td>
</tr>
<tr>
<td>ESD, preventing</td>
</tr>
<tr>
<td>Ethernet ports, address</td>
</tr>
<tr>
<td>ETSI racks</td>
</tr>
<tr>
<td>event log customize</td>
</tr>
<tr>
<td>export</td>
</tr>
<tr>
<td>filters</td>
</tr>
<tr>
<td>view</td>
</tr>
<tr>
<td>Event Source column</td>
</tr>
<tr>
<td>Event Type column</td>
</tr>
<tr>
<td>events, exporting</td>
</tr>
<tr>
<td>exiting application</td>
</tr>
<tr>
<td>Fiber Guardian</td>
</tr>
<tr>
<td>Line Configuration</td>
</tr>
<tr>
<td>exporting event log</td>
</tr>
<tr>
<td>fault list</td>
</tr>
<tr>
<td>line configuration</td>
</tr>
<tr>
<td>external power supply</td>
</tr>
<tr>
<td>storage for data</td>
</tr>
<tr>
<td>switches</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>F</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>fan filter</td>
</tr>
<tr>
<td>replacing</td>
</tr>
<tr>
<td>FC connector cleaner</td>
</tr>
<tr>
<td>federating user databases</td>
</tr>
<tr>
<td>fiber detecting optical port connection</td>
</tr>
<tr>
<td>forcing detection</td>
</tr>
<tr>
<td>management tray</td>
</tr>
<tr>
<td>fiber ends, cleaning</td>
</tr>
<tr>
<td>Fiber Guardian services</td>
</tr>
<tr>
<td>starting</td>
</tr>
<tr>
<td>filter, replacing</td>
</tr>
<tr>
<td>firmware version</td>
</tr>
<tr>
<td>forcing fiber detection</td>
</tr>
<tr>
<td>front and fiber back panels</td>
</tr>
<tr>
<td>front panel, cleaning</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>G</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>gateway, defining</td>
</tr>
<tr>
<td>generating reports</td>
</tr>
<tr>
<td>groups associating users</td>
</tr>
<tr>
<td>creating</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>H</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>helix factor admissible values</td>
</tr>
<tr>
<td>setting</td>
</tr>
<tr>
<td>hiding log columns</td>
</tr>
<tr>
<td>log entries</td>
</tr>
<tr>
<td>host configure 3G/4G</td>
</tr>
<tr>
<td>configure network</td>
</tr>
<tr>
<td>modifying name</td>
</tr>
<tr>
<td>reset defaults</td>
</tr>
<tr>
<td>restarting</td>
</tr>
</tbody>
</table>
status .................................................... 316
turning off/restarting .......................... 48
view information .............................. 123

I
IAM solution ........................................... 101
identification label ............................. 347
importing line configuration ................ 259
indoor use ............................................. 22
information, system ......................... 316
injection loss test .............................. 256
inlets ................................................... 20
input current ....................................... 23
inserting
cassette ........................................... 32
SIM card ............................................. 62
installing
unit in rack ........................................ 27
unit, requirements ............................ 22
VPN client .......................................... 69
VPN client on computer .................... 70
VPN client on unit .............................. 74
iOLM commands ................................. 93
IOR
obtaining .......................................... 164
setting .............................................. 161, 164

J
java version ....................................... 12

L
label, identification ............................. 347
launching application ......................... 121, 243
LC connector cleaner .......................... 274
LDAP
configuring ........................................ 116
federating user databases ................... 115
service .............................................. 101
storage mode ...................................... 119
LED
communication ................................... 315
description ....................................... 312
measurement in progress ................... 315
measurement status ......................... 315
power .............................................. 312
resetting the status .......................... 318
system ............................................. 313
Line Configuration application ............ 243
line configurations
exporting .......................................... 258
importing .......................................... 259
lines
adding ............................................. 252
deleting ........................................... 255
editing ............................................. 254
managing .......................................... 252
log view, customizing ......................... 262
login, administration console .............. 101
logs, users ........................................ 113
loss test ............................................ 256

M
main features ...................................... 3
maintenance
front panel ........................................ 267
general information ......................... 267
switchable connectors ..................... 268
management protocol ......................... 132
managing
credentials ..................................... 108
fibers ................................................. 37
line configurations ............................ 258
lines ................................................. 252
remote OTAUs .................................. 247
switches .......................................... 247
maximum input current ..................... 23
measurement in progress LED .......... 315
measurement status LED .................. 315
mechanical connector cleaning .......... 274
models offered .................................. 4
Index

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>modifying package settings</td>
<td>306</td>
</tr>
<tr>
<td>module</td>
<td></td>
</tr>
<tr>
<td>OTDR</td>
<td>291</td>
</tr>
<tr>
<td>power supply</td>
<td>12</td>
</tr>
<tr>
<td>switch</td>
<td>9</td>
</tr>
<tr>
<td>monitoring</td>
<td></td>
</tr>
<tr>
<td>device</td>
<td>50</td>
</tr>
<tr>
<td>test setup</td>
<td>178</td>
</tr>
<tr>
<td>mounting brackets</td>
<td>27</td>
</tr>
<tr>
<td>MTP/MTO connector cleaner</td>
<td>274</td>
</tr>
<tr>
<td>multifiber cleaner</td>
<td>274</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>network cables, connecting</td>
<td>45</td>
</tr>
<tr>
<td>new power supply</td>
<td>287</td>
</tr>
<tr>
<td>notification agent</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td>211</td>
</tr>
<tr>
<td>installation</td>
<td>94</td>
</tr>
<tr>
<td>notifications for alerts</td>
<td>154</td>
</tr>
<tr>
<td>Nova solution, working with</td>
<td>82</td>
</tr>
<tr>
<td>number of ports</td>
<td>9</td>
</tr>
<tr>
<td>O</td>
<td></td>
</tr>
<tr>
<td>opening protective window</td>
<td>42</td>
</tr>
<tr>
<td>optical port, detecting connected fibers</td>
<td>139</td>
</tr>
<tr>
<td>optical route, assigning to a cassette</td>
<td>144</td>
</tr>
<tr>
<td>OTDR</td>
<td></td>
</tr>
<tr>
<td>laser class</td>
<td>18</td>
</tr>
<tr>
<td>replacing</td>
<td>291</td>
</tr>
<tr>
<td>OTDR mode, connecting as EMS client</td>
<td>129</td>
</tr>
<tr>
<td>overview of applications</td>
<td>96</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>packages, software</td>
<td>303</td>
</tr>
<tr>
<td>panels, front and back</td>
<td>5</td>
</tr>
<tr>
<td>parameters</td>
<td></td>
</tr>
<tr>
<td>fiber, setting default values</td>
<td>164</td>
</tr>
<tr>
<td>helix factor</td>
<td>161, 164</td>
</tr>
<tr>
<td>IOR</td>
<td>161, 164</td>
</tr>
<tr>
<td>Rayleigh backscatter coefficient</td>
<td>161, 164</td>
</tr>
<tr>
<td>resetting</td>
<td>324</td>
</tr>
<tr>
<td>parent group</td>
<td>114</td>
</tr>
<tr>
<td>password, changing</td>
<td>108</td>
</tr>
<tr>
<td>passwords of all applications</td>
<td>96</td>
</tr>
<tr>
<td>patchcord management tray</td>
<td>37</td>
</tr>
<tr>
<td>pinout of the relays</td>
<td>50</td>
</tr>
<tr>
<td>plugging unit</td>
<td>45</td>
</tr>
<tr>
<td>ports, switch</td>
<td>9</td>
</tr>
<tr>
<td>power</td>
<td></td>
</tr>
<tr>
<td>cable</td>
<td>20</td>
</tr>
<tr>
<td>connecting</td>
<td>45</td>
</tr>
<tr>
<td>LED</td>
<td>312</td>
</tr>
<tr>
<td>plug</td>
<td>20</td>
</tr>
<tr>
<td>relay</td>
<td>50</td>
</tr>
<tr>
<td>sources</td>
<td>12, 23</td>
</tr>
<tr>
<td>supply</td>
<td>20</td>
</tr>
<tr>
<td>power supply module</td>
<td></td>
</tr>
<tr>
<td>AC</td>
<td>287</td>
</tr>
<tr>
<td>DC</td>
<td>289</td>
</tr>
<tr>
<td>defective</td>
<td>287</td>
</tr>
<tr>
<td>general information</td>
<td>287</td>
</tr>
<tr>
<td>preventing ESD</td>
<td>25</td>
</tr>
<tr>
<td>proactive maintenance test setup</td>
<td>178</td>
</tr>
<tr>
<td>problems, solving</td>
<td>309</td>
</tr>
<tr>
<td>product</td>
<td></td>
</tr>
<tr>
<td>identification label</td>
<td>347</td>
</tr>
<tr>
<td>specifications</td>
<td>13</td>
</tr>
<tr>
<td>programming guide</td>
<td>93</td>
</tr>
<tr>
<td>protective window</td>
<td>37</td>
</tr>
<tr>
<td>folding down</td>
<td>42</td>
</tr>
<tr>
<td>removing</td>
<td>43</td>
</tr>
<tr>
<td>pulse width</td>
<td>166</td>
</tr>
<tr>
<td>rack dimensions</td>
<td>27</td>
</tr>
<tr>
<td>RBS (Rayleigh backscatter)</td>
<td></td>
</tr>
<tr>
<td>obtaining</td>
<td>164</td>
</tr>
<tr>
<td>setting</td>
<td>161, 164</td>
</tr>
<tr>
<td>rear port address</td>
<td>55</td>
</tr>
<tr>
<td>rebooting host</td>
<td>48</td>
</tr>
</tbody>
</table>

Fiber Guardian
Index

recovery mode ........................................ 325, 329
red LED .................................................. 312
regulatory information .................................. xiv, xv
relays
  dry contact ......................................... 50
  viewing status ..................................... 316
remote
  console ................................................ 320
  switch, configuring ................................ 146
remote OTAUs ......................................... 247
  adding ............................................... 247
  deleting .......................................... 251
  editing ............................................. 250
  managing ......................................... 247
removing
  column filters ..................................... 264
  protective window ................................ 43
  ROTAU ............................................... 150
  switch cassette .................................... 32
repairing unit ........................................ 22
replacing
  AC power supply ................................... 287
  air filter .......................................... 275
  DC power supply ................................... 287, 289
  fan .................................................. 279
  OTDR .................................................. 291
report, generating .................................... 265
requirements for installation ......................... 26
resetting
  configuration ....................................... 324
  password ........................................... 108
  status of LEDs ..................................... 318
REST commands ........................................ 93
restarting host ....................................... 48, 50
restoring unit ....................................... 325, 329
result browser ....................................... 235
retrieving rear port address ......................... 55
return merchandise authorization (RMA) ............. 351
roles .................................................... 110
ROTAU
  adding ............................................... 147
  configuring ....................................... 146
  connecting ......................................... 146
consolidated status ................................... 153
editing ............................................... 148
removing ............................................ 150
status .................................................. 151
route, assigning to a cassette ...................... 144
RTU, controlling with an SMS ....................... 67

S
safety
  caution ............................................... 14
  conventions ........................................ 14
  general info ....................................... 15
  grounding unit .................................... 30
  laser ............................................... 18
  power cable ...................................... 20
  warning ............................................ 14
SC connector cleaner ................................ 274
search results test on demand ....................... 238
searching for users .................................. 107
selecting log columns ................................ 262
service and repairs .................................. 351
service centers ...................................... 352
sessions, viewing .................................... 113
setting e-mail server ................................ 131
shipping to EXFO .................................... 351
showing log columns ................................ 262
SIM card ............................................. 62
single-fiber cleaner .................................. 274
SMS to operate an RTU ................................ 67
SNMP, configuring ................................... 132
software packages
  general information ................................ 303
  operations ......................................... 303
solving problems ..................................... 309, 312
sorting data .......................................... 263
specifications, product ................................ 13
starting application
  Fiber Guardian ..................................... 121
  Line Configuration ................................ 243
states, software packages ......................... 303
Index

static IP address ................................. 124
status
  ROTAU ........................................ 151
  ROTAU, consolidated ..................... 153
  system ........................................ 316
storage device integrity ................. 325, 329
storage mode for LDAP ................... 119
storage requirements .................... 267
supported browsers ........................... 12
switch
  cassettes ...................................... 32
  configurations ................................ 9
  remote, configuring ....................... 146
switchable connectors, cleaning ...... 268
switching to wireless network .......... 268
symbols, safety ............................... 14
synchronization frequency ............. 135
system
  emergency tools ........................... 325, 329
  LED ........................................... 313
  relay ........................................ 50
  status ........................................ 316
  version ..................................... 302

T
technical specifications ................... 13
technical support ............................. 347
temperature for storage .................. 267
test on demand
  editing ...................................... 170
  search results ............................ 238
  test setup ................................ 178
test setup
  monitoring .................................. 178
  proactive maintenance .................... 178
  test on demand ............................ 178
testing relays ................................ 316
tests
  ad hoc ...................................... 196
  injection loss ................................ 256
  starting .................................... 227
text messages, controlling RTU ........... 67
  threshold
    analysis detection ....................... 180
    end-of-fiber detection ................. 167, 180
    reflectance detection .................. 167, 180
    splice loss detection ................. 167, 180
time server .................................. 135
tools system, emergency .................. 325, 329
transportation requirements ............ 267, 348
tray installation ........................... 37
turning off unit ............................ 48, 50
turning on unit .............................. 48
types
  alerts ....................................... 155
  cassettes ................................... 9

U
unit
  covers ....................................... 22
  disconnecting ................................ 20
  features .................................... 3
  grounding .................................. 30
  installing ....... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ... ......
Index

V
ventilation ................................................... 22
verify disk integrity............................ 325, 329
version, firmware ...................................... 302
viewing
  relay status ........................................ 316
  results ............................................. 235
  sessions ........................................... 113
VPN
  client installation ................................... 69
  connection ........................................ 79

W
WAN connection ......................................... 69
warranty
  certification ........................................ 350
  exclusions ........................................ 350
  general ........................................... 349
  liability .......................................... 349
Web
  browsers ........................................... 12
  connection ........................................ 69
  user interface .................................... 121
wim file ................................................. 325, 329
wireless network .................................... 59

X
xml file ..................................................... 265

Y
yellow LED ................................................. 312
### CHINESE REGULATION ON RESTRICTION OF HAZARDOUS SUBSTANCES (RoHS)

中国关于危害物质限制的规定

### NAMES AND CONTENTS OF THE TOXIC OR HAZARDOUS SUBSTANCES OR ELEMENTS CONTAINED IN THIS EXFO PRODUCT

包含在本EXFO产品中的有毒有害物质或元素的名称及含量

<table>
<thead>
<tr>
<th>Part Name 部件名称</th>
<th>Lead 铅 (Pb)</th>
<th>Mercury 汞 (Hg)</th>
<th>Cadmium 镉 (Cd)</th>
<th>Hexavalent Chromium 六价铬 (Cr(VI))</th>
<th>Polybrominated biphenyls 多溴联苯 (PBB)</th>
<th>Polybrominated diphenyl ethers 多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enclosure 外壳</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Electronic and electrical sub-assembly 电子和电器组件</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Optical sub-assembly 光学组件 a</td>
<td>X</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Mechanical sub-assembly 机械组件 a</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

**Note:**

This table is prepared in accordance with the provisions of SJ/T 11364.

本表依据SJ/T 11364的规定编制。

O: Indicates that said hazardous substance contained in all of the homogeneous materials for this part is below the limit requirement of GB/T 26572.

O: 表示该有害物质在该部件所有均质材料中的含量均在GB/T 26572标准规定的限量要求以下。

X: indicates that said hazardous substance contained in at least one of the homogeneous materials used for this part is above the limit requirement of GB/T 26572. Due to the limitations in current technologies, parts with the “X” mark cannot eliminate hazardous substances.

X: 表示该有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572标准规定的限量要求。

标记“X”的部件，皆因全球技术发展水平限制而无法实现有害物质的替代。

a. If applicable.

如果适用。
## MARKING REQUIREMENTS

### 标注要求

<table>
<thead>
<tr>
<th>Product</th>
<th>Environmental protection use period (years)</th>
<th>Logo</th>
</tr>
</thead>
<tbody>
<tr>
<td>This EXFO product</td>
<td>10</td>
<td><img src="image" alt="10" /></td>
</tr>
<tr>
<td>Battery(^a)</td>
<td>5</td>
<td><img src="image" alt="5" /></td>
</tr>
</tbody>
</table>

\(^a\) If applicable.

如果适用。